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Launching Compass for Simple Western

Compass for Simple Western Overview
Compass for Simple Western has three main screens: 

• Assay - You’ll create and review your assay.

• Run Summary - Check out the status of your run.

• Analysis - Take a look at the data from your experiment.

Changing the Screen View

To move between the Assay, Run Summary and Analysis screens, just click the button in the screen tab 
located in the upper right corner of the main window. 

Assay Screen

The Assay screen is used to create, view, and edit assays. You can assign well locations for assay plate 
reagents, modify assay protocol steps, enter assay notes and add annotations for individual wells on the 
assay plate. 

To open Compass for Simple Western, double-click the icon on the computer 
desktop.
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Run Summary Screen

The Run Summary screen is used to monitor status of a run in progress, watch movies of the separation in 
the capillaries, and view current and voltage plots for each run.
Compass for Simple Western User Guide



Compass for Simple Western Overview page 5
Analysis Screen

The Analysis screen is used to view data from your assay, including the graph view (electropherograms), lane 
view (shown below), capillary images, and a table with your results. You can also analyze your data here after 
the run is finished. 

Screen Panes 

Assay, Run Summary and Analysis screens all have multiple screen panes that let you view the individual 
components of a run, assay or data file. Each pane has a labeled tab and a unique icon. We'll describe panes 
specific to each screen later in the individual screen sections. 

The active pane in a screen is blue. To view a pane, click in the pane or on its tab. The example below shows 
panes in the Analysis screen, and the Lane pane is active:
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Title Bar

In the title bar you will see the run file name and the icons that allow the main Compass for Simple Western 
window to be minimized, maximized or closed.

Main Menu

Access to various software, instrument and screen operations is available through the main menu. More 
details on menu commands can be found in “Software Menus” on page 7.

Instrument Status Bar

The instrument status bar is used to start runs and cleaning protocols, relay system status and show run 
progress. More details on instrument control and status can be found in Chapter 8, “Controlling Jess, Wes, Sally 
Sue and Peggy Sue“.

NOTE: You will only see the instrument status bar when Compass for Simple Western is connected to an 
instrument. There is no status bar on computer workstations that you're only using for data analysis.

Screen Tab

The screen tab lets you move between Assay, Run Summary or Analysis screens and is located in the upper 
right corner of the main window. Just click a button to view a screen.
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View Bar

The view bar is only displayed in the Analysis screen as part of the main menu bar and allows you to switch 
between displaying sample chemiluminescent, fluorescent or protein normalization data, fluorescent stan-
dards or capillary registration information, data for a single capillary or all capillaries in the run, or grouped 
capillary data. View bar options are detailed in “Switching Between Sample, Standards and Registration Data 
Views” on page 202 for size assays or page 349 for charge assays, and “Using Groups” on page 239 for size 
assays or page 375 for charge assays. 

Compass Status Bar 

The status bar is located in the lower right corner of the main window. It displays active software processes 
and their progress. 

Software Menus
A brief description of the software menus in the main menu are described in this section. Not all menus are 
available in every screen, and menu commands change depending on what screen is active. The menus and 
commands available for each screen will be detailed in the individual screen sections.
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File Menu

The File menu contains basic file commands.

Edit Menu

The Edit menu contains basic editing commands, analysis and preferences options. Specific details on pref-
erences are described in Chapter 11, “Setting Your Preferences“. 

View Menu

The View menu can only be seen in the Analysis screen, and allows you to change how your data is dis-
played.
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Instrument Menu

The Instrument menu is only available when Compass for Simple Western is connected to directly to your 
instrument. Instrument control options are explained in Chapter 8, “Controlling Jess, Wes, Sally Sue and Peggy 
Sue“. 

Window Menu

The Window menu allows you to switch between Blot, Assay, Run Summary or Analysis screens, and restore 
screens to the Compass for Simple Western default layout. 

• Blot - Displays the Blot screen where you can view and enhance acquired blotting membrane 
images. 

• Assay - Displays the Assay screen where you can create, view, and edit assays. 

• Run Summary - Displays the Run Summary screen which tells you the status of a run in progress. 

• Analysis - Displays the Analysis screen which is used to view sample electropherograms, lane data 
and results.

• Default Layout - Restores the individual panes in the current screen back to their default size and 
location. 
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Help Menu

The Help menu provides access to Help, software updates, release notes and other software information. 

• Compass for SW Help - Displays the Compass for Simple Western User Guide. 

• User Guide - Displays a menu of Simple Western instrument User Guides. 

• Check for Updates - Automatically checks to see if a new version of Compass for Simple Western is 
available. 

• Release Notes - Displays Compass for Simple Western release notes for the current and prior ver-
sions.

• Export Logs - In the event a technical support issue arises, the Export Logs option lets you gather 
instrument-specific logs into a .zip file and send it directly to ProteinSimple Technical Support. If you 
don’t have an internet connection, you can also save the .zip file to the desktop.

• Send Run File - Lets you send a run file to ProteinSimple Technical Support directly from Compass for 
Simple Western.

• About Compass for SW - Displays the Compass for Simple Western software version and build infor-
mation.

Changing the Compass for Simple Western Main Window Layout
You can easily resize the Compass for Simple Western main window and the individual panes in each screen. 
Screen panes can also be moved outside of the main window. 

Resizing the Main Compass for Simple Western Window

To resize the main window, roll the mouse over a corner or border until the sizing arrow appears. Then just 
click and drag to resize. 
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Resizing the Screen Tab

The screen tab can be sized to show all or just some of the screen buttons. To resize, roll the mouse over the 
left edge of the tab until the sizing arrow appears, then click and drag to resize. If a screen button is hidden, 
a double arrow will display in the tab. Click to display and select the hidden screen.

Resizing Screen Panes 

• To resize a pane - Roll the mouse over the pane border until the sizing arrow appears. Then just click 
and drag to resize. 
Compass for Simple Western User Guide



page 12 Chapter 1: Let’s Get Started
• To maximize a pane - Click the maximize button in the upper right corner or double-click the tab. 
The other panes in the screen will automatically minimize to pane bars in the task area along the win-
dow border.

• To restore all minimized panes - Click Restore on the minimized pane bar.

• To restore only one minimized pane - Click the pane icon on the minimized pane bar.
Compass for Simple Western User Guide



Changing the Compass for Simple Western Main Window Layout page 13
• To restore a maximized pane to its original size - Double-click the tab or right click the tab and 
click Restore.

• To restore all panes to their original sizes - Select Window in the main menu and click Default 
Layout.

Changing the Location of Screen Panes

Panes can be moved to different locations within a screen. 

• To move a pane - Click on its tab and drag it to the new location. As the pane is moved, area guides 
will display to assist you in choosing a drop location.

Area guides with a black arrow let you know that if the pane is dropped at that location, it will 
be resized and relocated as an individual pane in that area of the screen. 

Area guides with a folder let you know that if the pane is dropped at that location, it will be 
added as a new tab in an area with one or more pane tabs. 

Area guides with a window let you know that if the pane is dropped at that location, it will 
become a separate window outside the Compass for Simple Western main window.
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The following figure shows the Analysis screen after moving the Graph pane. 

• To detach a pane from the main window - Click on its tab and drag it outside the main Compass for 
Simple Western window or right click the tab and click Detached.

• To move a detached pane back inside the main window - Right click the tab and deselect 
Detached.

• To restore all panes to their original locations - Select Window in the main menu and click 
Default Layout.
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Restoring the Main Window to the Default Layout

To restore screen pane sizes and locations to the original Compass for Simple Western layout, select Win-
dow from the main menu and click Default Layout.

Software Help
Select Help and click Compass for SW Help to view the Compass for Simple Western User Guide. If the 
computer you’re using has an internet connection, the latest online version of the User Guide PDF will dis-
play. When an internet connection isn’t available, the User Guide PDF shipped with the original installer for 
the software will open instead.

Viewing Instrument User Guides
Select Help and click User Guide to display a menu of Simple Western instrument User Guides. If the com-
puter you’re using has an internet connection, the latest online version of the User Guide PDF will display. 
When an internet connection isn’t available, the User Guides PDF shipped with the original installer for the 
software will open instead. The latest versions of all User Guides are also available online at  
https://www.proteinsimple.com/technical_library.html.

Checking for and Installing New Versions of Compass for Simple Western 
Compass for Simple Western can automatically check to see if a newer version of software is available. To do 
this:

1. Make sure the computer being used has an active internet connection.
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2. Select Help and click Check for Updates. If an update is found, the following screen will display: 

3. Click Finish to start the download and install the update. 

4. Follow the on-screen instructions to complete the software installation. 

5. Reboot the computer before using the new version of Compass for Simple Western.

Viewing Release Notes
Select Help and click Release Notes to view feature updates and bug fixes for new and past versions of 
Compass for Simple Western. If the computer you’re using has an internet connection, the latest online ver-
sion of the release notes PDF will display. When an internet connection isn’t available, the release notes PDF 
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shipped with the original installer for the software will open instead. We recommend you review these notes 
whenever a software update is installed. The latest release notes are also available online at  
https://www.proteinsimple.com/technical_library.html

Exporting the Software Log
Select Help and click Export Logs to view the software log file.

Sending Run Files to Technical Support
If the computer you’re using has an internet connection, Compass for Simple Western can zip and send a run 
file directly to ProteinSimple Technical Support. 

1. Open the run file you’d like to send in the Analysis screen.

2. Select Help and click Send Run File:

3. Enter your Name, Company and E-mail address, and any details in the Comments section:
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4. Click Send. The progress window displays:

5. When the file upload is complete, the following message displays. Click OK. 
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Compass for Simple Western Version Information
Select Help and click About Compass for SW to view the software version and build number information.

Directory and File Information
The main Compass for Simple Western directory is located in the Program Files folder, and also contains 
PDF files of the Jess, Wes and Sally Sue/Peggy Sue User Guides. 
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Compass for Simple Western assay and run files are located in the Documents folder in the User directory 
on your computer: 

• Assays Folder - Contains all assay files that you’ve saved.

• New Assays Folder - Contains Simple Western assay template files. 

• Runs Folder - Contains all run files. Run data is automatically written to this folder. 

• Blots Folder - Contains all Western blot image files that you’ve saved.

NOTE: When a Compass for Simple Western software update is performed, the template assays in the New 
Assays folder are overwritten. If you have customized these assays, we recommend saving them in a 
unique subfolder prior to updating the software, then transferring them back to the New Assays folder 
after the update to avoid losing your assay customizations. 
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File Types

The following file types are used by Compass for Simple Western:

• Assay Files - Use an *.assay file extension. 

• Run Files - Use a *.cbz file extension. The default file format for run files is Date_Time_AssayName. An 
example run file name would be 2012-09-28_18-50-53_Simple Western.cbz. 

• Blot Files - Use a *.btz file extension. 

• Protocol Files - Exported protocol files use a *.protocol file extension. 

• Template Files - Exported template files use a *.template file extension. 

• Analysis Settings Files - Exported analysis settings files use a *.settings file extension. 
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Chapter 2:  
Size Assays

Chapter Overview
• Assay Screen Overview

• Reagent Color Coding

• Opening an Assay

• Immunoassays: Creating a New Assay

• Total Protein Assays: Creating a New Assay

• Protein Normalization on Jess: Creating a New Assay

• RePlex Assays on Jess: Creating a New Assay

• Making Changes to an Existing Assay

• Switching Between Open Assays

• Creating a Template Assay 

• Viewing and Changing the Detection Exposures

• Copying Protocols and Templates

• Printing Protocols and Templates

• Importing and Exporting Protocols and Templates
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Assay Screen Overview
The Assay screen is used to create, view, and edit assays. To access this screen, click Assay in the screen tab:

Assay Screen Panes

The Assay screen has four panes:

• Layout - Displays a map of the assay plate and shows where assay reagents will be located.

• Protocol - Lists individual assay protocol steps and parameters that Jess, Wes, Sally Sue or Peggy Sue 
will execute for each of the capillaries.

• Notes - Lets you enter specific assay information that is saved with the assay and can be used for 
future reference. 

• Template - Enter annotations for the individual well and row reagents in the assay plate.
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Software Menus Active in the Assay Screen

You can use the following software menus:

• File

• Edit

• Instrument (when Compass for Simple Western is connected to Jess, Wes, Sally Sue or Peggy Sue)

• Window

• Help

The File and Edit menu options specific to the Assay screen are described next.

File Menu

The following File menu options are active:

• New Assay - Creates a new assay from a starter template.

• Open Assay - Opens an existing assay.

• Save - Saves the open assay.

• Save As - Saves the open assay under a different file name. 

• Import Protocol - Imports a saved protocol file into an assay.

• Import Template - Imports a saved template file into an assay.

• Export Protocol - Exports the current protocol file for future use.

• Export Template - Exports the current template file for future use.

• Print - Prints the information in the Protocol or Template panes.

• Exit - Closes Compass for Simple Western.
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Edit Menu

The following Edit menu options are active: 

• Copy - Copies the information in the Protocol or Template panes into other documents. 

• Default Analysis - Displays the default settings that will be used to analyze the run data generated 
with an assay. 

• Preferences - Set and save your preferences for data export, plot colors in the graph and Twitter set-
tings. See Chapter 11, “Setting Your Preferences“ for more information.
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Reagent Color Coding

Immunoassays

The Assay screen uses color coding to identify various assay reagents in all panes. The following example 
shows the Layout pane for chemiluminescence assays on the left and fluorescence assays (Jess only) on the 
right:

 

Protein Normalization on Jess

The Assay screen uses color coding to identify protein normalization reagent (green), which can be included 
with every size assay plate setup. There’s no need to run protein normalization as a separate assay. 

• Orange - Samples and Ladder

• Magenta - Antibody Diluent (2 or Milk-Free)

• Light Teal - Primary antibody

• Teal - Secondary HRP conjugate

• Gold - Luminol/Peroxide mix

• Light Blue - Water dispensed around Sepa-
ration and Stacking Matrices

• Orange - Samples and Ladder

• Magenta - Antibody Diluent (2 or Milk-Free)

• Light Teal - Primary antibody

• Red - Streptavidin-NIR (fluorescence only) 
or HRP (chemiluminescence only)

• Teal - Secondary antibody

• Gold - Luminol/Peroxide mix (chemilumi-
nescence only)
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• Orange - Samples and Ladder

• Green - Protein Normalization reagent

• Magenta - Antibody Diluent (2 or Milk-Free)

• Light Teal - Primary antibody

• Red - Streptavidin-NIR

• Teal - Secondary NIR/IR Conjugate

Total Protein Assays

The Assay screen uses color coding to identify various assay reagents in all panes. The Layout pane is shown 
in the following example: 

• Orange - Samples and Ladder

• Magenta - Labeling reagent

• Light Teal - Antibody Diluent

• Teal - Total Protein Streptavidin-HRP

• Gold - Luminol/Peroxide mix

• No color coding - Separation Matrix (clearly designated)
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• No color coding - Stacking Matrix (clearly designated)

• Light Blue - Water dispensed around Separation and Stacking Matrices

RePlex Assays on Jess

Jess lets you run two immunoassays or an immunoassay with Total Protein in a single run. This is done in two 
different probing cycles. These assay combinations are currently validated on Jess:

• Chemiluminescence + chemiluminescence

• Chemiluminescence + Total Protein

• Chemiluminescence/NIR fluorescence + Total Protein

• NIR fluorescence+ NIR fluorescence

• NIR fluorescence + chemiluminescence

The Assay screen uses color coding to identify various assay reagents in all panes. The following examples 
show the Layout pane for a few of the RePlex Assay combinations listed above: 

Chemiluminescence + Chemiluminescence

• Orange - Ladder and samples 

• Magenta - Antibody Diluent (2 or Milk-Free) 

• Light Teal - Primary antibody for Probe 1

• Red - Streptavidin-HRP

• Teal - Secondary antibody for Probe 1

• Light Teal - Primary antibody for Probe 2

• Teal - Secondary antibody for Probe 2

• Gold - Luminol/Peroxide mix 

• Purple - RePlex reagent mix
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Chemiluminescence/NIR fluorescence + 
Total Protein

• Orange - Ladder and samples 

• Peach - Total Protein labeling reagent

• Magenta - Antibody Diluent (2 or Milk-Free) 

• Light Teal - Primary antibody for Probe 1

• Red - Streptavidin-NIR

• Teal - Secondary antibody for Probe 1

• Green - Total Protein Streptavidin-HRP for 
Probe 2 

• Gold - Luminol/Peroxide mix 

• Purple - RePlex reagent mix

NIR fluorescence + NIR fluorescence

• Orange - Ladder and samples 

• Magenta - Antibody Diluent (2 or Milk-Free)

• Light Teal - Primary antibody for Probe 1

• Red - Streptavidin-NIR

• Teal - Secondary antibody for Probe 1

• Light Teal - Primary antibody for Probe 2

• Teal - Secondary antibody for Probe 2

• Purple - RePlex reagent mix
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Opening an Assay
To open an existing assay:

1. Select File in the main menu and click Open Assay. 

2. A list of the last five assays opened will display. Select one of these assays or click Browse to open the 
Assay folder and select a different assay. 

3. To make changes to the assay, follow the instructions under “Immunoassays: Creating a New Assay” on 
page 32 for changing the assay parameters. Select File from the main menu and click Save. 
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Immunoassays: Creating a New Assay 
To create a new assay, we recommend using one of the template assays and making any necessary modifi-
cations from there. 

NOTE: This section provides details on how to create a standard immunoassay on Jess, Wes, Peggy Sue 
and Sally Sue. To create a RePlex Assay on Jess that includes an immunoassay, see “RePlex Assays on Jess: 
Creating a New Assay” on page 60.

Step 1 - Open a Template Assay

1. Select File in the main menu and click New Assay:

2. Select the template assay for your instrument by selecting the instrument-appropriate Assay Type or 
Immunoassay, Size Range and Cartridge Type (if running Jess or Wes), or choose Open Assay to 
select from the menu of saved assays. 

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and 
Save before proceeding.
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Step 2 - Assign Assay Plate Reagents (Optional)

1. Click on the Layout tab. Displayed are the default row locations where each reagent should be placed 
on the assay plate.

NOTE: For Sally Sue and Peggy Sue, up to 96 different samples or conditions (lysates, proteins, antibodies 
or incubation times) can be assayed using the full eight cycles to accommodate experimental needs.

Jess or Wes plate layout:

• Row A - Biotinylated Ladder (A1) and Sample (A2-25) 
• Row B - Blocking (Milk-Free Antibody Diluent) or Protein Normalization Reagent
• Row C - Milk-Free Antibody Diluent (C1) and Primary antibody (C2-C25)
• Row D - Streptavidin-HRP or NIR (D1) and Secondary conjugate (D2-D25)
• Row E - Luminol-S/Peroxide mix (chemiluminescence only)
• Row F - Empty
 
Sally Sue/Peggy Sue plate layout:
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• Row A - Biotinylated Ladder (A1) and Sample (A2-12)
• Row B - Blocking (Antibody Diluent)
• Row C - Antibody Diluent (C1) and Primary antibody (C2-C12)
• Row D - Streptavidin-HRP (D1) and Secondary HRP conjugate (D2-D12)
• Row J - Luminol-S/Peroxide mix
• Row M - Water (M5-M20)
• Row N - Water (N5-N6 and N19-N20) and Separation Matrix (N7-N18)
• Row O - Water (O5-O6 and O19-O20) and Stacking Matrix (O7-O18)
• Row P - Water (P5-P20)

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert pro-
vided with the Simple Western kits.

2. If needed, well assignments can be modified as described below. Any row assignments changed in the 
Layout pane are updated in the Protocol pane automatically.

• To move a reagent row to another location - Click the row in the Layout pane, then drag and 
drop it on the new location. The row from which it was moved will be reassigned as empty.

• To insert a sample row - Click an empty row or the row below where the new sample row 
should be inserted, then click the S icon (Insert a sample row) in the Layout pane toolbar. A new 
sample row will be added in the empty row or inserted above the selected row.
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• To insert a detection row - Click an empty row or the row below where the new detection row 
should be inserted, then click the D icon (Insert a detection row) in the Layout pane toolbar. A 
new detection row will be added in the empty row or inserted above the selected row.

• To insert a fourth or fifth incubation reagent - Click an empty row or the row below where the 
new incubation reagent should be inserted, then click the 4 icon (Insert a quaternary row) in the 
Layout pane toolbar. A new incubation reagent row will be added in the empty row or inserted 
above the selected row.
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A fifth incubation reagent can now be added by repeating the above and clicking the 5 icon (Insert 
a Quinary row) instead.

NOTES:  
When using the fourth and fifth incubation steps, only five cycles can typically be performed per run as 
more water is needed per cycle for the additional wash steps. 
 
Row J is the last row assignment that can be used on the assay plate. New, sample, incubation or luminol 
rows cannot be inserted if row J already has an assigned reagent. To insert a row in this case, you must 
first move the contents of row J to another area on the plate.

• To delete a row - Click the row to be deleted, then click the red X icon (Delete a row) in the tool-
bar. Only empty rows and fourth incubation rows can be deleted. Rows for required assay 
reagents cannot be deleted.

NOTES:  
For Sally Sue and Peggy Sue, you can put samples, antibodies and blocking buffer in Rows A-J and in col-
umns 1-12 or 13-24. 
 
For chemiluminescence assays, we recommend keeping two rows empty between the substrate and the 
closest dispensed HRP conjugate to avoid any interaction with the substrate. 
 
Rows K and L are purposely left empty, don’t put anything into these wells.  
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Separation and Stacking matrices can only be pipetted into the designated wells. 
 
Water is used in the wells to reduce the potential of evaporation of the matrices.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to 
change parameters. When creating a new assay, the default protocol automatically assigns all reagent 
locations for the assay. The Sally Sue assay is shown as an example: 

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment 
and one or more parameter settings. To view the details for a step, click on the white arrow next to the 
step name. We recommend using the default protocol settings for the assays. An expanded list of the 
default protocol step parameters is shown below:
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2. You can change the primary or secondary antibody incubation time. Click the cell in the value column 
next to Primary Ab Time (min) or Secondary Ab Time (min) and enter a new value in minutes: 
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3. You can change the primary and secondary antibody incubation reagent row location. Click the cell in 
the value column next to Well Row and select a different row on the assay plate: 

NOTE: Only rows you’ve designated as primary antibody in the Layout tab can be selected in the Well Row 
drop-down menu.

4. The default detection mode is High Dynamic Range (HDR). See “High Dynamic Range Detection Profile” 
on page 71 for more information. 
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Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to 
Detection to expand the row. Click the cell in the exposure column next to Detection Profile to open the 
Detection Profile window. 

Deselect the High Dynamic Range checkbox. Additional times can be added to the protocol by clicking 
the Add button, entering the values and selecting OK.
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For non-RePlex assays on Jess, when the High Dynamic Range box is unchecked, you also have the 
option of selecting the RePlex Dynamic Range:

5. You can modify any other protocol parameters as needed. 
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NOTES:  
For more information on changing protocol step parameters other than incubation times, contact  
ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local 
Field Application Specialist. 
 
When a protocol is being edited, an asterisk will appear in the Protocol tab to indicate changes have been 
made and should be saved. 

Step 4 - Add Assay Notes (Optional)

1. Click on the Notes tab. 

2. Click in the pane and type any assay or protocol notes. This information will be stored with the assay and 
run data. 

NOTE: When notes are being edited, an asterisk will appear in the Notes tab to indicate changes have 
been made and should be saved. 
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Step 5 - Select a Schedule (Optional for Sally Sue and Peggy Sue)

Sally Sue and Peggy Sue can execute cycles serially or in parallel. To choose a schedule option, select Edit 
and click Schedule.

• Serial - Each cycle is executed in sequential order, and each cycle completes before the next one 
starts. Selecting this option result in the longest run times.

• Overlapping - Cycle steps are executed in parallel if timing permits shared use of the separation 
tray and robot. Each cycle will run through to completion once started. This option offers a 
reduction in overall run time without affecting the individual run time for each cycle.

• Overlapping with Hold (default) - Each cycle executes through the separate step in sequence 
and then enters a variable length hold step where capillaries remain in the incubation tray. More 
sample stability is provided with this option as proteins are 'locked' to the capillary wall and 
therefore more stable than samples on the assay plate. This option also results in the most signif-
icant reduction in overall run time. 

NOTE: We recommend using the Overlapping with hold option. For more information on when to use 
other schedule options, please contact ProteinSimple Technical Support toll-free in the US and Canada at 
1-888-607-9692 (option 3) or your local Field Application Specialist. 

Step 6 - Add Assay Plate Annotations (Optional)

Custom reagent names, notes and annotations can be entered for individual rows and wells on the assay 
plate. This information will be stored with assay and run data. During post-run analysis, this information will 
be used to apply custom analysis settings to specific sample names, blocking reagent names, primary anti-
body names or sample and primary antibody attributes. This will be explained in more detail in “Analysis Set-
tings Overview” on page 292.

NOTE: Template pane information can also be added or updated after a run is complete. 

To enter annotations:
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1. Click on the Template tab. The default annotations for reagent rows and individual wells on the assay 
plate will display:

2. Change or add row and well annotations as needed. To do this:

a. To enter annotations for a specific well - Right click the well and select Edit or click Edit in the 
upper right corner of the pane or double click the selected well. The following box will display:

Enter the reagent name, notes or specific attributes (for example, sample concentration or dilution 
ratio):
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Click OK. The new information will display in the selected well: 

b. To enter annotations for multiple wells or a row - To select individual wells, press and hold the 
Control key and then select individual wells. To select a sequential set of wells or a full row, press and 
hold the Shift key, then select the first well and last well. Next, right click and select Edit or click Edit 
in the upper right corner of the pane. The following box will display:

Enter the reagent name, notes and specific attributes (for example, sample concentration or dilution ratio):

Click OK. The new information will display in the selected wells: 
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NOTE: When annotations are being edited, an asterisk will appear in the Template tab to indicate 
changes have been made and should be saved. Only Name and Attribute will be used by Compass for 
Simple Western to annotate the data.

Step 7 - Save the Assay

1. Select File from the main menu and click Save As. Enter the assay name and click Save. 
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NOTE: New assays are saved in the Compass Assays directory. 

Step 8 - Modify Default Analysis Parameters (Optional) 

You can preset the parameters used to analyze run data generated with the assay. 

1. Select Edit from the main menu and click Default Analysis. The following screen will display:

2. We recommend using the default parameters for Simple Western assays. However, you can modify any 
you want, then click OK. For detailed information on analysis parameters, please refer to “Analysis Set-
tings Overview” on page 292.
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Total Protein Assays: Creating a New Assay 
To create a new assay, we recommend using one of the template assays and making any necessary modifi-
cations from there. 

NOTE: This section provides details on how to create a standard Total Protein assay on Wes, Peggy Sue 
and Sally Sue. To create a RePlex Assay on Jess that includes a Total Protein assay, see “RePlex Assays on 
Jess: Creating a New Assay” on page 60.

Step 1 - Open a Template Assay

1. Select File in the main menu and click New Assay: 

2. Select the template assay for your instrument by selecting Total Protein Size as your assay type, Size 
Range and Cartridge Type if running Jess or Wes, or choose Open Assay to select from the menu of 
saved assays.

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and 
Save before proceeding.
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Step 2 - Assign Assay Plate Reagents (Optional)

1. Click on the Layout tab. Displayed are the default row locations where each reagent should be placed 
on the assay plate.

NOTE: For Sally Sue and Peggy Sue, up to 96 different samples or conditions (lysates, proteins, antibodies 
or incubation times) can be assayed using the full eight cycles to accommodate experimental needs.

Jess and Wes plate layout:

• Row A - Biotinylated Ladder (A1) and Sample (A2-A25)
• Row B - Antibody Diluent (B1) and Labeling Reagent (B2-25)
• Row C - Antibody Diluent 
• Row D - Total Protein Streptavidin-HRP
• Row E - Luminol-S/Peroxide mix
• Row G - Wash buffer
• Row H - Wash buffer
• Row I - Wash buffer
• Row M-P - Pre-filled Separation Reagents
 
Sally Sue/Peggy Sue plate layout: 
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• Row A - Biotinylated Ladder (A1) and Sample (A2-A12)
• Row B - Antibody Diluent (B1) and Total Protein Labeling Reagent (B2-12)
• Row C - Antibody Diluent
• Row D - Total Protein Streptavidin-HRP
• Row J - Luminol-S/Peroxide mix
• Row M - Water (M5-M20)
• Row N - Water (N5-N6 and N19-N20) and Separation Matrix (N7-N18)
• Row O - Water (O5-O6 and O19-O20) and Stacking Matrix (O7-O18)
• Row P - Water (P5-P20)

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert 
provided with the Simple Western kits.

2. If needed, well assignments can be modified. Any row assignments changed in the Layout pane are 
updated in the Protocol pane automatically. 

• To move a reagent row to another location - Click the row in the Layout pane, then drag and 
drop it on the new location. The row from which it was moved will be reassigned as empty.
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• To insert a sample row - Click an empty row or the row below where the new sample row 
should be inserted, then click the S icon (Insert a sample row) in the Layout pane toolbar. A new 
sample row will be added in the empty row or inserted above the selected row.

• To insert a detection row - Click an empty row or the row below where the new detection row 
should be inserted, then click the D icon (Insert a detection row) in the Layout pane toolbar. A 
new detection row will be added in the empty row or inserted above the selected row.

• To insert a fourth or fifth incubation reagent - Click an empty row or the row below where the 
new incubation reagent should be inserted, then click the 4 icon (Insert a quaternary row) in the 
Layout pane toolbar. A new incubation reagent row will be added in the empty row or inserted 
above the selected row.
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A fifth incubation reagent can now be added by repeating the above and clicking the 5 icon (Insert 
a Quinary row) instead.

NOTES:  
When using the fourth and fifth incubation steps, only five cycles can typically be performed per run as 
more water is needed per cycle for the additional wash steps. 
 
Row J is the last row assignment that can be used on the assay plate. New, sample, incubation or luminol 
rows cannot be inserted if row J already has an assigned reagent. To insert a row in this case, you must 
first move the contents of row J to another area on the plate.

• To delete a row - Click the row to be deleted, then click the red X icon (Delete a row) in the tool-
bar. Only empty rows and fourth incubation rows can be deleted. Rows for required assay 
reagents cannot be deleted.
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NOTES:  
We recommend keeping two rows empty between the substrate and the closest dispensed HRP conjugate 
to avoid any interaction with the substrate. 
 
Rows K and L are purposely left empty, don’t put anything into these wells.  
 
Separation and Stacking matrices can only be pipetted into the designated wells. 
 
Water is used in the wells to reduce the potential of evaporation of the matrices.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to 
change parameters. When creating a new assay, the default protocol automatically assigns all reagent 
locations for the assay. The Sally Sue assay is shown as an example: 

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment 
and one or more parameter settings. To view the details for a step, click on the white arrow next to the 
step name. We recommend using the default protocol settings for the assays. An expanded list of the 
default protocol step parameters is shown:
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2. You can change the biotin labeling and Total Protein streptavidin-HRP incubation time. Click the cell in 
the value column next to Biotin Labeling Time (min) or Total Protein HRP Time (min) and enter a new 
value in minutes: 
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3. You can also change the biotin labeling and Total Protein streptavidin-HRP row location. Click the cell in 
the value column next to Well Row and select a different row on the assay plate: 

NOTE: Only rows you’ve designated as labeling reagent in the Layout tab can be selected in the Well Row 
drop-down menu.

4. The default detection mode is High Dynamic Range (HDR). See “High Dynamic Range Detection Profile” 
on page 71 for more information. 
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Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to 
Detection to expand the row. Click the cell in the exposure column next to Detection Profile to open the 
Detection Profile window. 

Deselect the High Dynamic Range checkbox. Additional times can be added to the protocol by clicking 
the Add button, entering the values and selecting OK.
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5. You can modify any other protocol parameters as needed. 

NOTES:  
For more information on changing protocol step parameters other than incubation times, contact  
ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local 
Field Application Specialist. 
 
When a protocol is being edited, an asterisk will appear in the Protocol tab to indicate changes have been 
made and should be saved. 

Steps 4 - 8

Steps 4 through 8 for creating a Total Protein Assay are the same as when you’re creating an Immunoassay. 
Please go to “Step 4 - Add Assay Notes (Optional),” starting on page 42 to continue.
Compass for Simple Western User Guide



page 58 Chapter 2: Size Assays
Protein Normalization on Jess: Creating a New Assay

Step 1 - Open a Template Assay

1. Select File in the main menu, click New Assay and choose Jess:

2. Select the template assay by selecting Protein Normalization in addition to Fluorescence and/or 
Chemiluminescence as your assay type, Size Range and Cartridge Type, or choose Open Assay from 
the File menu to select from the menu of saved assays.

NOTE: If you make changes to the assay, such as defining the wells in the plate, be sure to select File and 
Save before proceeding.

Step 2 - Assign Assay Plate Reagents

1. Click on the Layout tab. Displayed is the default row location (green) where the protein normalization 
reagent should be placed on the assay plate.
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Jess plate layout:

• Row A - Biotinylated Ladder (A1) and Sample (A2-A25)
• Row B - Protein Normalization Reagent 
• Row C - Milk-Free Antibody Diluent 
• Row D - Milk-Free Antibody Diluent (D1) and Primary Antibody Multiplex mix (D2-D25) 
• Row E - Streptavidin-NIR (E1) and Secondary Antibody Multiplex mix (E2-E25) 
• Row F - Empty
• Row G - Wash buffer
• Row H - Wash buffer
• Row I - Wash buffer
• Row M-P - Pre-filled Separation Reagents

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert 
provided with the Simple Western kits.

Step 3 - Modifying the Assay Protocol (Optional for All Instruments)

Steps 3 for creating a Protein Normalization Assay on Jess are the same as when you’re creating an Immuno-
assay. Please go to “Step 3 - Modifying the Assay Protocol (Optional for All Instruments),” starting on page 37 to 
continue.

Steps 4 - 8

Steps 4 through 8 for creating a Protein Normalization Assay are the same as when you’re creating an Immu-
noassay. Please go to “Step 4 - Add Assay Notes (Optional),” starting on page 42 to continue.
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RePlex Assays on Jess: Creating a New Assay

Step 1 - Open a Template Assay

1. Select File in the main menu, click New Assay and choose Jess:

Alternatively you can choose Open Assay from the File menu to select from the menu of saved assays.

NOTES:  
If you make changes to the assay, such as defining the wells in the plate, be sure to select File and Save 
before proceeding. 
 
Creating a RePlex assay is currently only supported when Access Control is disabled. When Access Control 
is enabled in Preferences, the RePlex checkbox will not be available for selection.

2. Select RePlex.  

These RePlex Assay combinations are currently validated on Jess:
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• Chemiluminescence + chemiluminescence
• Chemiluminescence + Total Protein
• Chemiluminescence/NIR fluorescence + Total Protein
• NIR fluorescence + NIR fluorescence
• NIR fluorescence + chemiluminescence
The assay selected for Probe 1 is run first. When Probe 1 is complete, Jess performs a wash, RePlex purge, 
and wash step combination prior to beginning the assay selected for Probe 2. 

3. Select the assays to run in Probe 1 and 2. The default selection is chemiluminescence for both.

To run two immunoassays: Select any combination of chemiluminescence or fluorescence for Probes 
1 and 2. For example:

To run one immunoassay and one Total Protein assay: Select Total Protein, then select any combi-
nation of chemiluminescence or fluorescence for Probe 1. Probe 2 will be used for the Total Protein 
assay. For example:

4. Select Size Range and Cartridge Type.
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Step 2 - Assign Assay Plate Reagents

1. Click on the Layout tab. Default row locations where each reagent should be placed on the assay plate 
are displayed. Reagents used in Probe 1 are labeled ‘1’ on the plate, those used in Probe 2 are labeled ‘2’:

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert 
provided with the Simple Western kits.

2 Immunoassays

• Row A - Biotinylated ladder (A1) and Samples (A2-A25) 

• Row B - Blocking: Milk-Free Antibody Diluent

• Row C - Primary Probe 1: Milk-Free Antibody Diluent (C1) 
and Primary antibody for Probe 1(C2-C25)

• Row D - Secondary Probe 1: Streptavidin-HRP or NIR (D1) 
and Secondary antibody for Probe 1 (D2-D25)

• Row E - Primary Probe 2: Milk-Free Antibody Diluent (E1) 
and Primary antibody for Probe 2 (E2-E25)

• Row F- Secondary Probe 2: Milk-Free Antibody Diluent 
(F1) and Secondary antibody for Probe 2 (F2-F25)

• Row J - Luminol/Peroxide mix (chemiluminescence only)

• Row K - RePlex reagent mix

Immunoassay + Total Protein

• Row A - Biotinylated ladder (A1) and Samples (A2-25)

• Row B - Total Protein biotin labeling reagent

• Row C - Blocking: Milk-Free Antibody Diluent

• Row D - Primary Probe 1: Milk-Free Antibody Diluent (D1) 
and Primary antibody for Probe 1 (D2-D25)

• Row E - Secondary Probe 1: Streptavidin-HRP or NIR (E1) 
and Secondary antibody for Probe 1 (E2-E25)

• Row F - Total Protein Streptavidin-HRP for Probe 2  
(F1-F25)

• Row J - Luminol/Peroxide mix (chemiluminescence only) 

• Row K - RePlex reagent mix
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2. If needed, the Secondary antibody row assignments for either Probe 1 or 2 can be deleted for assays 
where the Primary antibody contains HRP. Any row assignments changed in the Layout pane are 
updated in the Protocol pane automatically.

Click the Secondary antibody row you want to delete, then click the red X icon (Delete a row) in the 
toolbar. Only Secondary antibody rows can be deleted. Rows required for other assay reagents cannot 
be deleted.

Step 3 - Modifying the Assay Protocol (Optional)

1. Click on the Protocol tab. This pane shows the individual steps of the assay protocol and allows you to 
change parameters. When creating a new assay, the default protocol automatically assigns all reagent 
locations for the assay. A chemiluminescence/NIR fluorescence + Total Protein RePlex Assay is shown in 
this example:
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Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment 
and one or more parameter settings. To view the details for a step, click on the arrow next to the step 
name. We recommend using the default protocol settings for the assays. An expanded list of the default 
protocol step parameters is shown below:
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2. You can change the primary or secondary antibody incubation time. Click the cell in the value column 
next to Primary Antibody Time (min) or Secondary Antibody Time (min) and enter a new value in min-
utes: 

NOTE: If you won’t be using a Secondary antibody with Probe 1 or 2, set the Secondary Antibody incuba-
tion time to 0. 

3. The default detection mode fore chemiluminescent RePlex Assays is RePlex Dynamic Range (RDR). See 
“RePlex Dynamic Range Detection Profile” on page 72 for more information. The default detection 
mode for fluorescent RePlex Assays is NIR.
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Additional exposures can be collected in the assay, and IR exposures can be added if desired. To do this, 
click the white arrow next to Detection to expand the row. Click the cell in the exposure column next to 
Detection Profile in either the Probe 1 or Probe 2 column to open the Detection Profile window. 

Chemiluminescent detection:

Deselect the RePlex Dynamic Range checkbox. Up to 6 additional times (for a total of 7 exposures) can 
be added to the protocol by clicking the Add button, entering the values and selecting OK.
Compass for Simple Western User Guide



RePlex Assays on Jess: Creating a New Assay page 67
NIR Fluorescent detection:

Additional times can be added to the protocol by clicking the Add button, entering the values and 
selecting OK.

IR Fluorescent detection:

An IR detection profile can be added to the protocol by clicking the Add button, entering exposure val-
ues and selecting OK.
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4. You can modify any other protocol parameters as needed. 

NOTES:  
For more information on changing protocol step parameters other than incubation times, contact  
ProteinSimple Technical Support toll-free in the US and Canada at 1-888-607-9692 (option 3) or your local 
Field Application Specialist. 
 
When a protocol is being edited, an asterisk will appear in the Protocol tab to indicate changes have been 
made and should be saved. 

Steps 4 - 8

Steps 4 through 8 for creating a RePlex Assay are the same as when you’re creating an Immunoassay. Please 
go to “Step 4 - Add Assay Notes (Optional),” starting on page 42 to continue.
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Making Changes to an Existing Assay
1. Select File in the main menu and click Open Assay.

2. A list of the last assays opened will display. Select one of these assays or click Browse to open the assay 
folder and select a different assay.

3. Follow the steps in “Immunoassays: Creating a New Assay” on page 32 to make changes and save the 
assay. 

Switching Between Open Assays
If more than one run file is open, you can switch between viewing the assays for each run. To do this:

1. Click the down arrow in the run box.

2. Select the run for the assay you want to view from the drop down list.
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Creating a Template Assay
You can create and save template assays that can be used as a starting point for creating new assays. To do 
this:

1. Select File in the main menu. Click Open Assay to open an existing assay or click New Assay to open 
an existing template assay.

2. Follow the steps in “Immunoassays: Creating a New Assay” on page 32 to make changes to the assay. 

3. When changes are complete, select File in the main menu and click Save As. Select the New Assays 
folder:

4. Type the name for the new template assay and click Save. 

5. Select File in the main menu and click Open Assay. The new template assay will now be available in the 
drop down list:
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Viewing and Changing the Detection Exposures
To view the current detection profile, roll the cursor over the exposures cell in Protocol pane: 

High Dynamic Range Detection Profile

Starting with Compass for Simple Western 4.0 and the Jess instrument, HDR (high dynamic range) is the 
default detection profile for chemiluminescent detection. Exposure times for HDR have been optimized for 
best performance and can't be edited. These exposures differ for Jess, Wes and Peggy Sue or Sally Sue, and 
they were selected for maximum performance for each instrument when HDR mode is selected. Below is an 
example of different exposure settings:

To achieve a broader detection dynamic range, you need Compass for Simple Western v4.0. To download 
the latest version of the software go to Help > Check for Updates.
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For Jess and Wes, the higher dynamic range is achieved by using a more effective algorithm to create the 
High Dynamic Range multi-image analysis, refreshing substrate from the assay plate prior to each exposure 
and minimizing the time between substrate aspiration and Image. 

For Peggy Sue and Sally Sue only the new algorithm is used. This constitutes a divergence of Peggy Sue/Sally 
Sue vs Jess/Wes performance and you can expect a wider dynamic range on Jess and Wes. Note that for 
Peggy Sue/Sally Sue, you can select HDR for some cycles and uncheck it for others, giving you great flexibility 
for data analysis later.

NOTE: See “Images Analysis Settings” on page 293 to find out more about how data sets are analyzed 
under HDR and standard detection profiles.

If you need to switch to an older detection profile for data generated on another Simple Western instrument 
or if you'd rather not use HDR detection profile, uncheck the box next to HDR. Doing so reverts all instru-
ment functions to a pre-Compass 4.0 state. Under this detection profile, the exposure times can be edited. 
For non-RePlex assays on Jess, when the High Dynamic Range box is unchecked, you also have the option of 
selecting RePlex Dynamic Range:

RePlex Dynamic Range Detection Profile

For RePlex assays on the Jess instrument that use chemiluminescent detection, RePlex dynamic range (RDR) 
is the default detection profile. Exposure times for RDR use the short exposure times from HDR, eliminating 
the 128 and 512 second exposures. Below is an example of different exposure settings:
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NOTE: See “Images Analysis Settings” on page 293 to find out more about how data sets are analyzed 
under HDR and standard detection profiles.

If you'd rather not use the RDR detection profile, uncheck the box. For more information on RDR, please refer 
to Simple Western assay optimization guidelines. The exposure times can then be manually added and 
edited. For RePlex assays, up to 7 exposures may be added to the Detection Profile.
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Changing the Detection Profile

While we recommend using the default detection profile, you can change the profile, exposure times and 
exposure sequences if needed. To do this:

1. Select the exposures cell in the Protocol pane and click the button, or double-click in the cell. The fol-
lowing screen displays:

NOTE: Assays created and saved with Compass v2.7 or Compass for Simple Western v3.0 will have HDR 
unchecked by default. If you want HDR to be the default detection profile for that assay, check the box 
next to HDR in the Detection Profile, then re-save the assay.

a. To change an existing exposure time (applies for NIR and IR, and when HDR or RDR is 
unchecked for chemiluminescent detection) - Click in the exposure cell and enter a new time in 
seconds:
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b. To delete an existing exposure - Select a type or exposure cell and click Remove. 

c. To add a new exposure - Select Add. A new exposure will be added to the end of the list. Click in 
the exposure cell and enter an exposure time in seconds.

2. Click OK to save and exit.

Copying Protocols and Templates
The steps and parameters in the Protocol pane can be copied and pasted into other documents, as can the 
graphic image of the annotations in the Template pane. 

Copying an Assay Protocol

1. Click on the Protocol tab.

2. Select Edit in the main menu and click Copy.

3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select Paste. All 
assay protocol steps and parameters will be copied into the document as a list in the same format 
shown in the Protocol pane. 
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Copying an Assay Template

1. Click on the Template tab.

2. Select Edit in the main menu and click Copy.

3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select Paste. The 
assay template will be copied into the document as an image, exactly as it is shown in the Template 
pane. 

Printing Protocols and Templates
The information in the Protocol pane can be printed, as can a graphic image of the information in the Tem-
plate pane.

Printing an Assay Protocol

1. Click on the Protocol tab.

2. Select File in the main menu, click Print, and then click Print Protocol.

All assay protocol steps and parameters will be printed as a list in the same format shown in the Protocol 
pane. 

Printing an Assay Template

1. Click on the Template tab.

2. Select File in the main menu, click Print, and then click Print Template.
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The assay template will print as an image, exactly as it is shown in the Template pane. 

Importing and Exporting Protocols and Templates
The assay protocol in an open assay or run file can be exported as a separate file, as can the assay template 
annotation information. This allows the same assay protocol and template information to be imported into 
another assay at a later time, rather than having to re-enter assay protocol and template information manu-
ally. 

Importing an Assay Protocol

NOTE: Importing an assay protocol imports information into the Protocol pane only.

1. Open the assay you want to import the assay protocol in to.

2. Select File in the main menu and click Import Protocol.

3. Select a protocol file (*.protocol) and click OK. The imported information will display in the Protocol 
pane. 
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Exporting an Assay Protocol

NOTE: Exporting an assay protocol exports information in the Protocol pane only.

1. Open the assay you want to export the assay protocol from.

2. Select File in the main menu and click Export Protocol. The following window displays:

3. The default directory is Compass/Assays. Change the directory if needed.

4. Enter a protocol name and click Save. The protocol will be saved as a *.protocol file.
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Template Export and Import

The Template information including the sample and reagent names can be exported to a file. As an example, 
a default Jess/Wes Template is displayed in the Assay view.

There are three file format options:

• A comma separated CSV file that is best opened in a spreadsheet.

• An XML template file that has full control over the sample and reagent names and layout.

• A tab delimited TXT file that can be opened in a spreadsheet even when the decimal separator is set 
to a comma.

Exporting the Template to a CSV file

Follow the steps below to easily import a template into Compass for Simple Western, populating it with 
reagent names (sample, antibody, etc.) and their corresponding attributes (concentration, dilution factor, 
etc.). This example uses a Jess/Wes Template, but the same steps can be followed for a Sally Sue or Peggy 
Sue plate template.

1. Select File in the main menu and click Export Template. The following window displays:
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Make sure the Save as type is set to CSV.

2. Enter a protocol name and click Save. The protocol will be saved as a *.csv file.

3. Open the CSV file in a spreadsheet program like Microsoft® Excel®.

The names in the spreadsheet are arranged in the same order as the Compass Template, and the rows 
alternate between names and attributes. 
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NOTE: The default assay has no attributes so these rows will be empty. 

4. Edit the names and add attributes, then save the spreadsheet as a CSV file. 

NOTE: Make sure not to edit the first column of the spreadsheet, this corresponds to the ladder wells.

5. To import the edited CSV file into Compass for Simple Western, select File in the main menu, click 
Import Template and then browse to the .cvs file you just saved. Once imported, the edited CSV file 
displays the edited Sample names and Primary Antibody with attributes in the Template.

Template Cut and Paste

The names and attributes in the Template can be copied and pasted within Compass for Simple Western, 
between two copies of Compass, and between Compass and a spreadsheet like Microsoft® Excel®.

All you need to do is enter names in a spreadsheet row, then copy to the clipboard. Next, select a well in the 
Template and paste from the clipboard. The new names will be pasted into the row at the selected column 
and columns to the right. Here’s a quick example of how to do it:

1. Copy these three rows from a spreadsheet:

2. Select a well in the Template, A2 is selected for this example:
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3. Paste the names from the clipboard.

Note: Make sure not to select any of the ladder wells (A1, B1, C1, etc.)

4. To include attributes, add them in the next row:

5. Pasting into the Template will update the names and attributes.
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Multiple rows can also be copied and pasted with names and attributes on alternate rows:

Only wells in the same row can be selected, but multiple rows will be pasted into the rows below.

Note: Make sure not to select any of the ladder wells (A1, B1, C1, etc.)
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Chapter 3:  
Running a Size Assay

Chapter Overview
• Starting a Run

• Stopping a Run
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Starting a Run

Step 1 - Get Ready

1. Create or open an assay file in Compass for Simple Western.

2. Prepare the assay plate using the information provided in the product insert.

IMPORTANT 
To prevent well evaporation and ensure best results, keep a lid on the assay plate until ready to use. 

3. Prepare the instrument following the procedure described in the User Guide.

IMPORTANT 
Capillaries are light sensitive. Keep them covered until you are ready to transfer the capillary 
cartridge or box to the instrument.

4. Place assay plate into the sample tray of the instrument.

Step 2 - Start the Run

You can start a run in one of two ways depending on whether you want to run an assay using existing 
parameters or set up a new assay.

1. New run of an existing assay:

a. Select File in the main menu and click Open Assay.
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b. A list of the last five assays opened will display. Select one of these assays or click Browse to open 
the Assay folder and select a different assay. 

2. Alternatively, choose New Assay and select one of the size assays to get the default assay conditions for 
using Jess, Wes, Sally Sue or Peggy Sue. 

a. The Start button will display. This indicates that an assay has been loaded.

a. Go to the Assay screen and verify this is the assay you want to use. If not, select File in the main 
menu, click Open Assay, and select another assay.

3. Click Start to begin the run.

For Jess and Wes:  
The Start Run window for immunoassays displays with the default run file name and location. In the 
example below, Start Run windows for a standard Immunoassay and a RePlex Assay are shown. You can 
edit the file name and/or click Browse if you want to save it in a different location: 
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NOTE: For Jess runs, if the cartridge type or plate installed in the instrument doesn’t match the assay 
selected for the run messages indicating this will display in the Start Run window. If this happens, click 
Cancel and adjust your assay settings before starting the run again.

Click Start to begin the run. Instrument status will change to Running, the Start button will change to 
Stop and the Run Progress bar will display:

For Sally Sue/Peggy Sue:  
This will launch the Start Run Wizard (continue on to the next step).

NOTE: If you didn't clean the manifold in Sally Sue or Peggy Sue prior to starting the run, a message will 
appear. If you see this message, click Yes to cancel the run and perform the manifold cleaning.
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4. Check Water and Waste. The fluid levels in the accessory module bottles will be checked by the soft-
ware. If the level in both bottles will allow Sally Sue an Peggy Sue to complete the run, the wizard screen 
will display Water Level OK and Waste Level OK messages. Click Next to proceed.

NOTE: If the waste level is too high or the water level is too low to complete the run, messages to indicate 
one or both will be presented in this screen. If this occurs, fill or empty each bottle as indicated using the 
procedures outlined in the Sally Sue/Peggy Sue User Guide. When this is complete, the error status will be 
automatically updated and allow the Start Run Wizard to proceed. 

5. Replace Sponge. You should use a new sponge each time a new experimental run is started. Discard 
the old sponge and put a new sponge in the manifold wash station. Click Next to proceed. 
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6. Start. The resource tray will automatically open. Fill the Wash Buffer, Running Buffer and Matrix Removal 
Buffer cups and insert the capillary box in the primary capillary box position. Add a secondary capillary 
box if more capillaries are required. Click Next when finished. The resource tray will close. 

NOTE: Make sure enough capillaries are loaded to complete the run. A capillary box should be inserted in 
the primary position first and if additional capillaries are needed, use the secondary position. When the 
primary box is depleted, Sally Sue or Peggy Sue will automatically move to the secondary box. Discard left-
over Running Buffer, Wash Buffer and Matrix Removal Buffer prior to refilling bottles for new run.
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NOTE: You can also refer to the labels on the resource tray for proper insertion of reagents. 

Primary
Capillary Box

Secondary
Capillary Box

Wash Buffer Matrix Removal Buffer orRunning Buffer or
Upper Running Buffer Lower Running Buffer
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7. Load Sample Plate. The sample tray will automatically open. Place the lidded 384-well plate on the 
cooling block in the tray, ensuring that the A1 well position is aligned with the upper left corner of the 
cold block. When this is complete, click Next. The sample tray will close.

A1 Position
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NOTES:  
Plate lids must be used on sample plates for Sally Sue and Peggy Sue. If a lid is not detected, a message will 
be displayed in the Start Run Wizard. Compass for Simple Western will reopen the sample tray to allow 
you to place the lid on the sample plate.  
 
When inserting the sample plate, ensure that the plate is firmly seated and level on the cold block. Plates 
that are not level can interfere with the movement of the sample tray. 

8. Begin the Automated Run. The data file name will automatically default to the assay name appended 
with the current date and time. To change the file name, begin typing in the text box. To change the 
directory where the data file will be stored, click Browse: 

Click Start to begin the run. Instrument status will change to Running, the Start button will change to 
Stop and the Run Progress bar will display: 
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The run will continue until complete (~14-19 hours depending on the assay).

Step 3 - Post-Run Procedures

1. Remove the capillary cartridge (Jess/Wes) or empty the capillary discard tray (Sally Sue/Peggy Sue). 

2. Remove the assay plate. 

3. Dispose of the assay plate and capillaries. Disposal will depend on the samples that have been assayed. 
If sample origins are unknown, we recommend that used capillaries cartridges, capillaries and plates be 
disposed of as biohazard waste. 

!WARNING! SHARPS HAZARD 
The capillaries may present a potential sharps hazard. Dispose of used capillaries in biomedical 
waste sharps containers.   

!WARNING! BIOHAZARD  
Samples and waste bottle contents should be handled by procedures recommended in 
the CDC/NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). 
The manual is available from the U.S. Government Printing Office or online at  
http://www.cdc.gov/biosafety/publications/bmbl5/.  
Depending on the samples used, waste bottle contents may constitute a biohazard. Use 
precaution when emptying the waste bottle. Dispose of waste bottle contents in accor-
dance with good laboratory practices and local, state/provincial and national environ-
mental and health regulations. Read and understand the Material Safety Data Sheets 
(MSDSs) provided by the manufacturers of the chemicals in the waste vial before you 
store, handle or dispose of chemical waste.
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Stopping a Run 
1. To stop a run, click Stop. 

a. Jess/Wes: When the run stops, the Start button with reappear and the instrument will start a pro-
cess that plugs the capillaries in the cartridge. Once that's done, you can then remove the capillary 
cartridge and plate and discard them. The stopped status, date and time will display in the Run Sum-
mary screen.

b. Sally Sue/Peggy Sue: When the run stops, Sally Sue’s or Peggy Sue’s status will go to Not Ready 
and a Cleanup button displays:

NOTE: If a run is stopped prior to completion, Sally Sue and Peggy Sue must perform a cleaning protocol 
to remove used capillaries from system trays. This is required to prepare the system for the next run. 

2. Click Cleanup. 

Allow Sally Sue and Peggy Sue to complete the cleaning protocol which takes about ten minutes. When 
complete, instrument status will change to Ready and a new run can be started. 
Compass for Simple Western User Guide



page 96 Chapter 3: Running a Size Assay
Compass for Simple Western User Guide



page 97
Chapter 4:  
Imaging a Blot on Jess

Chapter Overview
• Starting a Run
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Starting a Run

Step 1 - Get Ready

1. Prepare the membrane and assemble the blot cartridge following the product insert. 

2. Open Compass for Simple Western software on your desktop. 

3. Make sure that the software is connected to the instrument.

4. Insert the blot cartridge into the blot holder. The light in the blot holder will change from orange to blue 
when correctly seated.

5. Close the instrument door by gently pushing it until you feel Jess pull it closed. 

The software will automatically change to the Blot screen:

 

Step 2 - Start the Imaging Run

NOTE: Jess's door must be closed before starting the imaging run.

Blot
Holder
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Once the blot cartridge is installed and Jess’s door is closed, Compass for Simple Western will automatically 
provide a preview image.

1. Edit the exposure settings in the Exposures table.

• To add an exposure: Click Add then select the exposure time to change it. 
• To remove an exposure: Select the exposure and click Remove.
• To edit exposure time: Click on an exposure and enter a new time.
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2. Check the Markers box if the blot contains a molecular weight ladder.

3. To load the saved settings from an existing blot imaging protocol file (*.blot), click Open. Select the pro-
tocol file and click Open. 

4. You can change the Results File name and location if desired. Imaging file names are automatically gen-
erated as date_time_blot.btz and saved in the Compass for SW\Blots folder of your My Documents 
folder.

5. Optional: Add any comments you would like saved with your imaging run in the Comments box and 
click Save.
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6. Optional: To save the settings associated with this blot imaging protocol for future use, click Save.

7. Click Start to begin imaging. .

Step 3 - Imaging Run Summary and Analysis

Reviewing Imaging Data

When the imaging run starts, thumbnails are shown in the Run Summary screen.
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As images are acquired, they populate the predefined thumbnail boxes and also display in the Review pane. 
Unless you click on a thumbnail, the most recently acquired image displays in the Review pane. Images that 
haven’t been taken yet will display blank until the image is acquired.

The Run Summary pane will display thumbnail images for each exposure configured in the imaging proto-
col: 

NOTE: The Markers image is taken at the end of the imaging run. If you click Stop before all exposures are 
taken, the software will prompt you to confirm that you want to stop the run before the Markers image is 
taken.

Adjusting Blot Images

You can adjust the blot image using the Review pane toolbar.
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The toolbar has the following options:

An unadjusted blot image is shown in the following example: 

Exporting Image Files

To export raw images for further analysis, from the main menu, select File > Export Images. Then select a 
folder to export the files to.

Contrast Adjustment

Auto Contrast

Invert

Overlay Markers
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Compass for Simple Western will automatically launch a Windows Explorer window for you to access the 
saved files. Images are saved in .png format, and both raw and adjusted images are saved in the folder. 

• Raw chemiluminescence images are saved as: <Results File Name>_Chemi_<Exposure Num-
ber>_<Exposure Time>.

• Processed images, as shown in the Review pane, are saved as: <Results File Name>_<Exposure 
Time>_view.  

• Raw and processed marker images are saved as: <Results File Name>_Markers and <Results File 
Name>_Markers_view, if selected during the blot imaging protocol.

Step 4 - Post-Imaging Procedures

When imaging is done, you'll need to: 

1. Remove the blot cartridge. 

2. Remove your membrane and clean the blot cartridge by rinsing it with water. Dry with a lint-free wipe.

3. Wipe down the area underneath the blot cartridge in the instrument with a dry lint-free wipe.

4. Keep the blot cartridge in a dry, clean area protected from dust.

Stopping a Run
To stop an imaging run, click Stop and confirm your choice. When the run stops, the Start button will reap-
pear so you can start another run when you’re ready. 
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Chapter 5:  
Charge Assays

Chapter Overview
• Assay Screen Overview

• Reagent Color Coding

• Opening an Assay

• Creating a New Assay

• Making Changes to an Existing Assay

• Switching Between Open Assays

• Creating a Template Assay

• Viewing and Changing the Detection Exposures

• Copying Protocols and Templates

• Printing Protocols and Templates

• Importing and Exporting Protocols and Templates
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Assay Screen Overview
The Assay screen is used to create, view and edit assays. To access this screen, click Assay in the screen tab:

Assay Screen Panes

The Assay screen has four panes:

• Layout - Displays a map of the assay plate and shows where assay reagents will be located.

• Protocol - Lists individual assay protocol steps and parameters that Peggy Sue will execute for each 
of the 12 capillaries simultaneously.

• Notes - Lets you enter specific assay information that is saved with the assay and can be used for 
future reference. 

• Template - Enter annotations for the individual well and row reagents in the assay plate. 
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Software Menus Active in the Assay Screen

The following software menus are available:

• File

• Edit

• Instrument (when Compass for Simple Western is connected to Peggy Sue)

• Window

• Help

The File and Edit menu options specific to the Assay screen are described next.

File Menu

The following File menu options are active:

• New Assay - Creates a new assay from a starter template.

• Open Assay - Opens an existing assay.

• Save - Saves the open assay.

• Save As - Saves the open assay under a different file name. 

• Import Protocol - Imports a saved protocol file into an assay.

• Import Template - Imports a saved template file into an assay.

• Export Protocol - Exports the current protocol file for future use.

• Export Template - Exports the current template file for future use.

• Print - Prints the information in the Protocol or Template panes.

• Exit - Closes Compass for Simple Western.
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Edit Menu

The following Edit menu options are active: 

• Copy - Copies the information in the Protocol or Template panes into other documents. 

• Default Analysis - Displays the default settings that will be used to analyze the run data generated 
with an assay. 

• Analysis - Not active in this screen.

• Preferences - Set and save custom preferences for data export, plot colors in the graph and Peggy 
Sue’s Twitter settings. See Chapter 11, “Setting Your Preferences“ for more information.
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Reagent Color Coding
The Assay screen uses color coding to identify various assay reagents in all panes. The Layout pane is shown 
in the following example: 

• Orange - Samples

• Light Blue - Primary antibody 

• Teal - Tertiary antibody

• Yellow - Secondary HRP conjugate

• Gold - Luminol/Peroxide mix
Compass for Simple Western User Guide



page 110 Chapter 5: Charge Assays
Opening an Assay
To open an existing assay:

1. Select File in the main menu and click Open Assay.

2. A list of the last five assays opened will display. Select one of these assays or click Browse to open the 
Assay folder and select a different assay. 
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Creating a New Assay 
To create a new assay, we recommend using the Peggy Sue template assay and modifying from there as 
needed. 

Step 1 - Open a Template Assay

1. Select File in the main menu and click New Assay:

T

2. A list of template assays that can be used as a starting point for new assays will display. Click Peggy Sue 
Charge. The Peggy Sue template assay and default settings will display in the Assay screen: 
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Step 2 - Assign Assay Plate Reagents (Optional)

1. Click on the Layout tab. This pane displays the default row locations of where each reagent should be 
placed on the assay plate. 

NOTE: Up to 96 different samples or conditions (lysates, proteins, antibodies or incubation times) can be 
assayed using the full eight cycles to accommodate experimental needs.

• Row A - Samples

• Row B - Primary Antibody
• Row C- Secondary Antibody
• Row D - Tertiary Antibody (optional) 
• Row E - Luminol/Peroxide mix

NOTE: For details on sample, reagent and assay plate preparation, please refer to the product insert pro-
vided with the Simple Western kits.

2. If needed, well assignments can be modified as described below. Any row assignments changed in the 
Layout pane are updated in the Protocol pane automatically.

• To move a reagent row to another location - Click the row in the Layout pane, then drag and 
drop it on the new location. The row from which it was moved will be reassigned as empty.
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• To insert a new row - Click the row below where the new one should be inserted, then click 
Insert an empty row (circle icon) in the Layout pane toolbar. A new row will be inserted above 
the selected row.

• To insert a sample row - Click an empty row or the row below where the new sample row 
should be inserted, then click Insert a sample row (S icon) in the Layout pane toolbar. A new 
sample row will be added in the empty row or inserted above the selected row.

• To insert a detection row - Click an empty row or the row below where the new detection row 
should be inserted, then click Insert a detection row (D icon) in the Layout pane toolbar. A new 
detection row will be added in the empty row or inserted above the selected row.
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• To insert a fourth or fifth incubation reagent - Click an empty row or the row below where the 
new incubation reagent should be inserted, then click Insert a Quaternary Row (4 icon) in the 
Layout pane toolbar. A new incubation reagent row will be added in the empty row or inserted 
above the selected row.

A fifth incubation reagent can now be added by repeating the above and clicking Insert a Quinary 
Row (5 icon) instead.

NOTES:  
When using the fourth and fifth incubation steps, only five cycles can typically be performed per run as 
more water is needed per cycle for the additional wash steps. 
 
Row J is the last row assignment that can be used on the assay plate. New, sample, incubation or luminol 
rows cannot be inserted if row J already has an assigned reagent. To insert a row in this case, you must 
first move the contents of row J to another area on the plate.

• To delete a row - Click the row to be deleted, then click Delete (red x icon) in the toolbar. Only 
empty rows and fourth incubation rows can be deleted. Rows for required assay reagents cannot 
be deleted.
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NOTE: Samples, antibodies and blocking buffer can be dispensed in Rows A-J and in columns 1-12 or 13-
24. Rows K-P cannot be used for assay reagents. 

Step 3 - Modifying the Assay Protocol (Optional)

1. Click on the Protocol tab. This pane displays the individual steps of the assay protocol and allows you to 
change parameters as needed. When creating a new assay, a default protocol will display which auto-
matically assigns all reagent locations for Cycle 1:

Each row contains an assay protocol step. Each step can contain a reagent assay plate row assignment 
and one or more parameter settings. To view the details for a step, click on the white arrow next to the 
step name. We recommend using the default protocol settings for Peggy Sue assays. An expanded list of 
the default protocol step parameters is shown:
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2. Five incubation steps are allowed per protocol. You can select the type of incubation for each step. The 
available incubation types and their default Simple Western use is as follows:

• First incubation - Primary antibody
• Second incubation - Secondary antibody
• Third incubation - User defined (tertiary antibody)
• Fourth incubation - User defined (quaternary antibody)
• Fifth incubation - User defined (custom)
To change the type, click the incubation step name and select an option from the drop down list. 

3. If needed, change the primary incubation time. To do this, click the cell in the value column next to Pri-
mary Ab Time (min) and enter a new value in minutes: 
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4. If needed, change the primary incubation reagent row location. To do this, click the cell in the value col-
umn next to Well Row and select a different row on the assay plate: 

NOTE: Only rows designated as primary antibody in the Layout tab can be selected in the Well Row drop-
down menu.

5. If needed, change the secondary incubation time. To do this, click the cell in the value column next to 
Secondary Ab Time (min) and enter a new value in minutes: 
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6. If needed, change the secondary incubation reagent row location. To do this, click the cell in the value 
column next to Well Row and select a different row on the assay plate: 

NOTE: Only rows designated as secondary antibody in the Layout tab can be selected in the Well Row 
drop-down menu.

7. Additional exposures can be collected in the assay if desired. To do this, click the white arrow next to 
Detection to expand the row. Click the cell in the exposure column next to Detection Profile to open the 
Detection Profile window. Additional times can be added to the protocol by clicking the Add button, 
entering the values and selecting OK.
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8. Modify any other protocol parameters as needed. 

9. To add additional cycles to the assay protocol, click in any cell with a value in a cycle column.

• To add one cycle, either click Add or click the down arrow next to Add and select 1 Cycle
• Select 4 Cycles from the drop down menu to add four additional cycles
• Select All Cycles from the drop down menu to add the number of cycles needed to reach the 

maximum of eight 
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New cycle columns will display using the same parameters used for cycle 1. 

Repeat steps 1-8 to change parameters for the added cycles. As cycles are added and reagent locations 
are selected, cycle number assignments will update in the Layout pane assay plate map:

NOTES:  
For more information on changing protocol step parameters other than incubation times, contact  
ProteinSimple Technical Support. 
 
When a protocol is being edited, an asterisk will appear in the Protocol tab to indicate changes have been 
made and should be saved. 

Step 4 - Add Assay Notes (Optional)

1. Click on the Notes tab. 

2. Click in the pane and type any assay or protocol notes. This information will be stored with the assay and 
run data. 
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NOTE: When notes are being edited, an asterisk will appear in the Notes tab to indicate changes have 
been made and should be saved. 

Step 5 - Select a Schedule (Optional)

Peggy Sue can execute cycles serially or in parallel. To choose an option, select Edit and click Schedule.

• Serial - Each cycle is executed in sequential order, and each cycle completes before the next one 
starts. Selecting this option result in the longest run times.

• Overlapping - Cycle steps are executed in parallel if timing permits shared use of the separation 
tray and robot. Each cycle will run through to completion once started. This option offers a 
reduction in overall run time without affecting the individual run time for each cycle.

• Overlapping with Hold (default) - Each cycle executes through the separate step in sequence 
and then enters a variable length hold step where capillaries remain in the incubation tray. More 
sample stability is provided with this option as proteins are 'locked' to the capillary wall and 
therefore more stable than samples on the assay plate. This option also results in the most signif-
icant reduction in overall run time.
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NOTE: We recommend using the overlapping with hold option. For more information on when to use 
other schedule options, please contact ProteinSimple Technical Support. 

Step 6 - Add Assay Plate Annotations (Optional)

Custom reagent names, notes and annotations can be entered for individual rows and wells on the assay 
plate. This information will be stored with assay and run data. During post-run analysis, this information will 
be used to apply custom analysis settings to specific sample names, primary antibody names or sample and 
primary antibody attributes. This will be explained in more detail in “Analysis Settings Overview” on 
page 422.

NOTE: Template pane information can also be added or updated after a run is complete. 
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To enter annotations:

1. Click on the Template tab. The default annotations for reagent rows and individual wells on the assay 
plate will display:

2. Change or add row and well annotations as needed. To do this:

a. To enter annotations for a specific well - Right click the well and select Edit or click Edit in the 
upper right corner of the pane or double click the selected well. The following box will display:
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Enter the reagent name, notes or specific attributes (for example, sample concentration or dilution 
ratio):

Click OK. The new information will display in the selected well: 

b. To enter annotations for multiple wells or a row - To select individual wells, press and hold the 
Control key and then select individual wells. To select a sequential set of wells or a full row, press and 
hold the Shift key, then select the first well and last well. Next, right click and select Edit or click Edit 
in the upper right corner of the pane. The following box will display:
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Enter the reagent name, notes and specific attributes (for example, sample concentration or dilution ratio):

Click OK. The new information will display in the selected wells: 

NOTE: When annotations are being edited, an asterisk will appear in the Template tab to indicate 
changes have been made and should be saved. Only Name and Attribute will be used by Compass for 
Simple Western to annotate the data.
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Step 7 - Save the Assay

1. Select File from the main menu and click Save As. Enter the assay name and click Save. 

NOTE: New assays are saved in the Compass Assays directory. 
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Step 8 - Modify Default Analysis Parameters (Optional) 

You can preset the parameters used to analyze run data generated with the assay. 

1. Select Edit from the main menu and click Default Analysis. The following screen will display:

2. We recommend using the default parameters for Simple Western assays. However, you can modify any 
parameters as needed, then click OK. For detailed information on analysis parameters, please refer to 
“Analysis Settings Overview” on page 422.
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Making Changes to an Existing Assay
1. Select File in the main menu and click Open Assay.

2. A list of the last assays opened will display. Select one of these assays or click Browse to open the assay 
folder and select a different assay.

3. Follow the steps in “Creating a New Assay” on page 111 to make changes and save the assay. 

Switching Between Open Assays
If more than one run file is open, you can switch between viewing the assays for each run. To do this:

1. Click the down arrow in the run box.

2. Select the run for the assay you want to view from the drop down list.
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Creating a Template Assay
You can create and save template assays that can be used as a starting point for creating new assays. To do 
this:

1. Select File in the main menu. Click Open Assay to open an existing assay or click New Assay to open 
an existing template assay.

2. Follow the steps in “Creating a New Assay” on page 111 to make changes to the assay. 

3. When changes are complete, select File in the main menu and click Save As. Select the New Assays 
folder:

4. Type the name for the new template assay and click Save. 

5. Select File in the main menu and click New Assay. The new template assay will now be available in the 
drop down list:
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Viewing and Changing the Detection Exposures
To view the current detection profile, roll the cursor over the exposures cell in Protocol pane: 

High Dynamic Range Detection Profile

Starting with Compass for Simple Western 3.1, HDR (high dynamic range) is the default detection profile. 
Exposure times for HDR have been optimized for best performance and can't be edited: 
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Each row represents an individual exposure that will be taken during the run. To achieve a broader detection 
dynamic range for a charge assay, you need Compass for Simple Western v3.1 or higher. To download the 
latest version of the software go to Help > Check for Updates.

For Peggy Sue and NanoPro 1000, the higher dynamic range is achieved by using a more effective algorithm 
to create the High Dynamic Range multi-image analysis (now called High Dynamic Range in the Analysis 
window). Note that for these instruments, you can select HDR for some cycles, and uncheck it for others, giv-
ing you great flexibility for data analysis later.

NOTE: See “Images Analysis Settings” on page 430 to find out more about how data sets are analyzed 
under HDR and standard detection profiles.

If you'd rather not use HDR detection profile, uncheck the box next to HDR. Doing so reverts all instrument 
functions to a pre-Compass 3.1 state. Under this detection profile, the exposure times can be edited:

NOTE: Assays created and saved with Compass v2.7 or Compass for Simple Western v3.0 will have HDR 
unchecked by default. If you want HDR to be the default detection profile for that assay, check the box 
next to HDR in the Detection Profile, then re-save the assay.
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Changing the Detection Profile

While we recommend using the default detection profile, you can change the profile, exposure times and 
exposure sequences if needed. To do this:

1. Select the exposures cell in the Protocol pane and click the button, or double-click in the cell. The fol-
lowing screen  displays:

NOTE: Assays created and saved with Compass v2.7 or Compass for Simple Western v3.0 will have HDR 
unchecked by default. If you want HDR to be the default detection profile for that assay, check the box 
next to HDR in the Detection Profile, then re-save the assay.

a. To change an existing exposure time (applies when HDR is unchecked) - Click in the exposure 
cell and enter a new time in seconds:
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b. To delete an existing exposure - Select a type or exposure cell and click Remove. 

c. To add a new exposure - Select Add. A new exposure will be added to the end of the list. Click in 
the exposure cell and enter an exposure time in seconds.

2. Click OK to save and exit.

Copying Protocols and Templates
The steps and parameters in the Protocol pane can be copied and d into other documents, as can the 
graphic image of the annotations in the Template pane. 

Copying an Assay Protocol

1. Click on the Protocol tab.

2. Select Edit in the main menu and click Copy.

3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select. All assay pro-
tocol steps and parameters will be copied into the document as a list in the same format shown in the 
Protocol pane. 
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Copying an Assay Template

1. Click on the Template tab.

2. Select Edit in the main menu and click Copy.

3. Open a document (Microsoft® Word®, Excel®, etc.). Right click in the document and select. The assay 
template will be copied into the document as an image, exactly as it is shown in the Template pane. 

Printing Protocols and Templates
The information in the Protocol pane can be printed, as can a graphic image of the information in the Tem-
plate pane.

Printing an Assay Protocol

1. Click on the Protocol tab.

2. Select File in the main menu, click Print, and then click Print Protocol.

All assay protocol steps and parameters will be printed as a list in the same format shown in the Protocol 
pane. 

Printing an Assay Template

1. Click on the Template tab.

2. Select File in the main menu, click Print, and then click Print Template.
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The assay template will print as an image, exactly as it is shown in the Template pane. 

Importing and Exporting Protocols and Templates
The assay protocol in an open assay or run file can be exported as a separate file, as can the assay template 
annotation information. This allows the same assay protocol and template information to be imported into 
another assay at a later time, rather than having to re-enter assay protocol and template information manu-
ally. 

Importing an Assay Protocol

NOTE: Importing an assay protocol imports information into the Protocol pane only.

1. Open the assay you want to import the assay protocol in to.

2. Select File in the main menu and click Import Protocol.

3. Select a protocol file (*.protocol) and click OK. The imported information will display in the Protocol 
pane. 
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Exporting an Assay Protocol

NOTE: Exporting an assay protocol exports information in the Protocol pane only.

1. Open the assay you want to export the assay protocol from.

2. Select File in the main menu and click Export Protocol. The following window displays:

3. The default directory is Compass/Assays. Change the directory if needed.

4. Enter a protocol name and click Save. The protocol will be saved as a *.protocol file.

Importing an Assay Template

NOTE: Importing an assay template imports information into the Template pane only.

1. Open the assay you want to import the assay template in to.

2. Select File in the main menu and click Import Template.

3. Select a template file (*.template) and click OK. The imported information will display in the Template 
pane. 
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Exporting an Assay Template

NOTE: Exporting an assay template exports information in the Template pane only.

1. Open the assay you want to export the assay template from.

2. Select File in the main menu and click Export Template. The following window displays:

3. The default directory will be Compass/Assays. Change the directory if needed.

4. Enter a template name and click Save. The template will be saved as a *.template file.
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Chapter 6:  
Running a Charge Assay on Peggy 
Sue

Chapter Overview
• Starting a Run

• Stopping a Run
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Starting a Run 

Step 1 - Get Ready

1. Open Compass for Simple Western software.

2. Prepare instrument: empty waste, refill water and add a new manifold sponge.

3. Create or open desired assay file.

4. Prepare assay plate following the procedure described in the product insert.

IMPORTANT 
To prevent well evaporation and ensure best results, keep a lid on the assay plate until ready to use. 

5. While plate is spinning, add Wash Buffer, Anolyte and Catholyte to resource tray cups. Place capillary box 
in the designated resource tray position.

IMPORTANT 
Capillaries are light sensitive. Keep the cover on the box until you are ready to transfer the capillary 
box to the resource tray.

6. Place assay plate into the sample tray of the instrument and press Start.

Step 2 - Start the Run

1. New run of an existing assay:

a.Select File in the main menu and click Open Assay.
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b. A list of the last five assays opened will display. Select one of these assays or click Browse to open 
the Assay folder and select a different assay. 

2. Alternatively, choose New Assay and select Peggy Sue Charge to get the default Peggy Sue assay con-
ditions. 

c. The Start button will display. This indicates than an assay has been loaded.

a. Go to the Assay screen and verify this is the assay you want to use. If not, select File in the main 
menu, click Open Assay, and select another assay.

3. Click Start. This will launch the Start Run Wizard.

NOTE: If the manifold was not cleaned prior to starting the run, a message indicating this will display. If 
this occurs, click Yes to cancel the run and perform the manifold cleaning.
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4. Check Water and Waste. The fluid levels in the accessory module bottles will be checked by the soft-
ware. If the level in both bottles will allow Peggy Sue to complete the run, the wizard screen will display 
Water Level OK and Waste Level OK messages. Click Next to proceed.

NOTE: If the waste level is too high or the water level is too low to complete the run, messages to indicate 
one or both will be presented in this screen. If this occurs, fill or empty each bottle as indicated using the 
procedures outlined in the Peggy Sue User Guide. When this is complete, the error status will be automati-
cally updated and allow the Start Run Wizard to proceed. 
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5. Replace Sponge. A new sponge should be used each time a new experimental run is started. Discard 
the old sponge and put a new sponge in the manifold wash station.

6. Start. The resource tray will automatically open. Fill the Wash Buffer, Anolyte and Catholyte cups and 
insert the capillary box in the primary capillary box position. Add a secondary capillary box if more capil-
laries are required. Click Next when finished. The resource tray will close. 

NOTE: Make sure enough capillaries are loaded to complete the run. A capillary box should be inserted in 
the primary position first and if additional capillaries are needed, use the secondary position. When the 
primary box is depleted, Peggy Sue will automatically move to the secondary box. Discard leftover Run-
ning Buffer, Wash Buffer and Matrix Removal Buffer prior to refilling bottles for new run.
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NOTE: You can also refer to the labels on the resource tray for proper insertion of reagents.

Primary
Capillary Box

Secondary
Capillary Box

Wash Buffer CatholyteAnolyte
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7. Load Sample Plate. The sample tray will automatically open. Place the lidded 384-well plate on the 
cooling block in the tray, ensuring that the A1 well position is aligned with the upper left corner of the 
cold block. When this is complete, click Next. The sample tray will close.

A1 Position
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NOTES:  
Peggy Sue requires that plate lids be used on sample plates. If a lid is not detected, a message will be dis-
played in the Start Run Wizard. Compass for Simple Western will reopen the sample tray to allow you to 
place the lid on the sample plate.  
 
When inserting the sample plate, ensure that the plate is firmly seated and level on the cold block. Plates 
that are not level can interfere with the movement of the sample tray. 

8. Begin the Automated Run. The data file name will automatically default to the assay name appended 
with the current date and time. To change the file name, begin typing in the text box. To change the 
directory where the data file will be stored, click Browse: 

Click Start to begin the run. Instrument status will change to running, and the stop button and progress 
bar will display: 
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The run will continue until complete (~14-19 hours depending on the assay).

Step 3 - Post-Run Procedures

1. Empty the capillary discard tray. 

2. Remove the assay plate. 

3. Dispose of the assay plate and capillaries. Disposal will depend on the samples that have been assayed. 
If sample origins are unknown, we recommend that used capillaries and plates be disposed of as bio-
hazard waste. 

!WARNING! SHARPS HAZARD 
The capillaries may present a potential sharps hazard. Dispose of used capillaries in biomedical 
waste sharps containers.   

!WARNING! BIOHAZARD  
Samples and waste bottle contents should be handled by procedures recommended in 
the CDC/NIH manual: Biosafety in Microbiological and Biomedical Laboratories (BMBL). 
The manual is available from the U.S. Government Printing Office or online at  
http://www.cdc.gov/biosafety/publications/bmbl5/.  
Depending on the samples used, waste bottle contents may constitute a biohazard. Use 
precaution when emptying the waste bottle. Dispose of waste bottle contents in accor-
dance with good laboratory practices and local, state/provincial, or national environmen-
tal and health regulations. Read and understand the Material Safety Data Sheets (MSDSs) 
provided by the manufacturers of the chemicals in the waste vial before you store, han-
dle, or dispose of chemical waste.
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Stopping a Run 
1. To stop a run, click Stop. When the run stops, instrument status will go to Not Ready and a Cleanup but-

ton displays:

NOTE: If a run is stopped prior to completion, Peggy Sue must perform a cleaning protocol to remove used 
capillaries from system trays. This is required to prepare the system for the next run. 

2. Click Cleanup. 

Allow Peggy Sue to complete the cleaning protocol which takes about ten minutes. When complete, 
instrument status will change to Ready and a new run can be started. 
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Chapter 7:  
Run Status

Chapter Overview
• Run Summary Screen Overview

• Opening Run Files

• Viewing File and Run Status Information

• Watching Standards Separation Movies

• Viewing Current and Voltage Plots

• Switching Between Open Run Files

• Closing Run Files
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Run Summary Screen Overview
The Run Summary screen is used to monitor run progress, watch movies of the fluorescent standards sepa-
ration, and view current and voltage plots for a run. To access this screen, click Run Summary in the screen 
tab:

Run Summary Screen Panes

The Run Summary screen has three panes:

• Status - Displays run file information and current status of a run in progress. 

• Separation - Lets you view a movie of the fluorescent standards separation for each cycle of the 
experimental run.

• IV Plot - Lets you view plots of the total current and voltage measured during separation for all capil-
laries for each cycle of the experimental run. 
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Software Menus Active in the Run Summary Screen

The following software menus are available: 

• File

• Edit

• Instrument (when Compass for Simple Western is connected to an instrument)

• Window

• Help

The File and Edit menu options specific to the Run Summary screen are described next.

File Menu

The following File menu options are active:

• Open Run - Opens a run file.

• Add Run - Open and view other run files in addition to the one that is already open.

• Close - Closes the run file currently being viewed. 

• Close All - Closes all open run files.

• Save - Saves the open run file.

• Save As - Saves the open run file under a different file name. 

• Run Report - Creates a report of the run in .pdf format.

• Exit - Closes Compass for Simple Western.
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Edit Menu

The following Edit menu options are active: 

• Preferences - Set and save custom preferences for data export, plot colors in the graph and Twitter 
settings. See Chapter 11, “Setting Your Preferences“ for more information.

Opening Run Files
You can open one run file or multiple run files at a time to compare information between runs.

Opening One Run File

1. Select File in the main menu and click Open Run.

2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 
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Opening Multiple Run Files

1. To open the first run file, select File in the main menu and click Open Run.

2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

3. To open another run file, select File in the main menu and click Add Run.

4. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

5. Repeat the last two steps to open additional runs.

NOTES:  
When adding multiple data files for analysis, they must contain matching detection channels (for exam-
ple chemi, IR/NIR fluorescence, or IR/NIR fluorescence with Protein Normalization). 
 
When adding multiple RePlex data files (Jess only), the channels for both probes must contain matching 
detection files. For example, a chemiluminescence with Total Protein data file can’t be added to a chemilu-
minescence/chemiluminescence data file.
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Viewing File and Run Status Information
Information specific to each run file is shown in the Status pane:
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The run file name, path (directory location) and assay used is displayed along with instrument serial number 
and the run start/complete date and time. 

• To go to the run file directory location - Double click the path hyperlink, or right-click and select 
Open Directory.

• To copy the path - Right-click on the path hyperlink and click Copy. The path can then be copied 
into documents. The path can also be copied into the Windows Explorer address bar to launch Com-
pass for Simple Western and open the run file automatically. 

• Kit info - Compass for Simple Western v2.7 and higher displays the type of kit used to run the assay 
(regular for immunoassays, total protein or charge), the molecular range and whether or not the split 
Running Buffer was used. 

• Plate S/N - For Jess and Wes, the plate serial number (S/N) information is captured and displayed for 
all assays.
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Assay Steps: Size-based Assays

Each assay step that is executed during the run is represented by an icon. The time the individual step is 
scheduled to start is shown under each icon. Details on what happens during each assay step is as follows:

RePlex Assays (Jess Only)

Step Description

Sample Loading Step - Capillaries are moved to the assay plate in the sample tray where 
Separation Matrix, Stacking Matrix, biotinylated ladder and samples are aspirated. Capillar-
ies are then transferred to the running buffer trough. 

Separation Step - Samples and fluorescent standards are separated in the capillaries. Cap-
illaries are then exposed to UV light, which immobilizes the separated proteins to the walls 
of each capillary. During the separation, voltage and current are monitored and displayed 
in the IV Plot. Separation of the fluorescent standards is recorded and a movie of the sepa-
ration is compiled for viewing when separation is complete in the Separation pane. After 
separation, Matrix Removal Buffer is aspirated.

Label Step (Total Protein only)- Capillaries are moved to the assay plate in the sample 
tray and Biotin labeling reagent is aspirated. When incubation is complete, Wash Buffer is 
aspirated.

Blocking Step - Capillaries are moved to the assay plate in the sample tray and blocking 
reagent (Milk-Free Antibody Diluent) is aspirated. When incubation is complete, Wash Buf-
fer is aspirated.

Primary Antibody (1°) Step - Capillaries are moved to the assay plate in the sample tray 
and primary antibody is aspirated. When incubation is complete, Wash Buffer is aspirated.

Secondary Antibody (2°) Step - Capillaries are moved to the assay plate in the sample 
tray and secondary HRP/NIR/IR antibody conjugate and Streptavidin-HRP/NIR is aspirated. 
When incubation is complete, Wash Buffer is aspirated.

HRP Step (Total Protein only) - Capillaries are moved to the assay plate in the sample tray 
and Total Protein Streptavidin-HRP is aspirated. When incubation is complete, Wash Buffer 
is aspirated.
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When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following 
example, the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

Detect Step - Capillaries are moved to the assay plate in the sample tray and Luminol-Per-
oxide solution is aspirated (chemiluminescence only). Emitted chemiluminescent light is 
detected with the CCD camera. For fluorescence detection on Jess, emitted fluorescent 
signal is detected.

Purge Step - Capillaries are moved to the assay plate in the sample tray and Wash Buffer is 
aspirated. RePlex reagent mix is then aspirated to remove the primary and secondary anti-
bodies from the immobilized sample proteins. This is followed by another round of Wash 
Buffer. 

Results Step - Results are available in the Analysis screen.

Step Description
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Standard Size Assays

Step Description

Sample Loading Step - Capillaries are moved to the assay plate in the sample tray where 
Separation Matrix, Stacking Matrix, biotinylated ladder and samples are aspirated. Capillar-
ies are then transferred to the running buffer trough (Wes/Jess) or separation tray (Sally 
Sue/Peggy Sue). 

Separation Step - Samples and fluorescent standards are separated in the capillaries. Cap-
illaries are then exposed to UV light, which immobilizes the separated proteins to the walls 
of each capillary. During the separation, voltage and current are monitored and displayed 
in the IV Plot. Separation of the fluorescent standards is recorded and a movie of the sepa-
ration is compiled for viewing when separation is complete in the Separation pane. After 
separation, Matrix Removal Buffer (Jess/Wes) or Wash Buffer (Peggy Sue/Sally Sue) is aspi-
rated.

Protein Normalization Step (Jess only) - Capillaries are moved to the assay plate in the 
sample tray and the protein normalization reagent is aspirated. When incubation is com-
plete, Wash Buffer is aspirated.

Blocking Step - Capillaries are moved to the assay plate in the sample tray and blocking 
reagent (Milk-Free Antibody Diluent) is aspirated. Capillaries are then transferred to an incu-
bator tray (Sally Sue/Peggy Sue). When incubation is complete, Wash Buffer is aspirated.

Primary Antibody or Total Protein Labeling Reagent (1°) Step - Capillaries are moved 
to the assay plate in the sample tray and primary antibody or labeling reagent is aspirated. 
Capillaries are then transferred to an incubator tray (Sally Sue/Peggy Sue). When incuba-
tion is complete, Wash Buffer is aspirated.

Secondary Antibody or Total Protein Streptavidin-HRP (2°) Step - Capillaries are 
moved to the assay plate in the sample tray and secondary HRP/NIR/IR antibody conjugate 
and Streptavidin-HRP/NIR (Immunoassays), or Total Protein Streptavidin-HRP (Total Protein 
Assays) is aspirated. Capillaries are then transferred to an incubator tray (Sally Sue/Peggy 
Sue). When incubation is complete, Wash Buffer is aspirated.

Detect Step - Capillaries are moved to the assay plate in the sample tray and Luminol-Per-
oxide solution is aspirated. Capillaries are then transferred to the separation tray (Sally Sue/
Peggy Sue) where the emitted chemiluminescent light is detected with the CCD camera. 
For fluorescence detection on Jess, emitted fluorescent signal is detected.
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When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following 
example, the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

Assay Steps: Charge-based Assays

Each assay step that is executed during the run is represented by an icon. The time the individual step is 
scheduled to start is shown under each icon. Details on what happens during each assay step is as follows:

Results Step - Results are available in the Analysis screen.

Hold Step (Sally Sue/Peggy Sue only) - This step is used for overlapping or overlapping 
with hold schedule options. A cycle that has completed a specific step will go into a hold 
step while the remaining cycles execute the same step in parallel. For example, once 
cycle1 completes the separate step, it may go into a hold step while cycle 2 executes the 
separate step. This execute and hold pattern will continue until all cycles have completed 
the separate step.

Step Description

Sample Loading Step - Capillaries are moved to the assay plate in the sample tray and 
samples are aspirated. Capillaries are then transferred to the separation tray. 

Separation Step - Samples, ampholyte mix and fluorescent pI standards are separated in 
the capillaries. Capillaries are then exposed to UV light, which immobilizes the separated 
proteins to the walls of each capillary. During the separation, voltage and current are mon-
itored and displayed in the IV Plot. Separation of the fluorescent standards is recorded and 
a movie of the separation is compiled for viewing in the Separation pane after separation is 
complete. 

Step Description
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When a run is in progress, icons for steps that have not executed will be grey (inactive). In the following 
example, the Secondary Antibody (2°) step is executing and the Detect and Results steps have not started:

Primary Antibody (1°) Step - Capillaries are moved to the assay plate in the sample tray 
and primary antibody is aspirated. Capillaries are then transferred to an incubator tray. 
When incubation is complete, Wash Buffer is aspirated.

Secondary Antibody (2°) Step - Capillaries are moved to the assay plate in the sample 
tray and secondary HRP-conjugated antibody is aspirated. Capillaries are then transferred 
to an incubator tray. When incubation is complete, Wash Buffer is aspirated.

Detect Step - Capillaries are moved to the assay plate in the sample tray and Luminol-Per-
oxide solution is aspirated. Capillaries are then transferred to the separation tray where the 
emitted chemiluminescent light is detected with the CCD camera. 

Results Step - Results are available in the Analysis screen.

Hold Step - This step is used for overlapping or overlapping with hold schedule options. A 
cycle that has completed a specific step will go into a hold step while the remaining cycles 
execute the same step in parallel. For example, once cycle1 completes the separate step, it 
may go into a hold step while cycle 2 executes the separate step. This execute and hold 
pattern will continue until all cycles have completed the separate step.

Step Description
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Watching Standards Separation Movies
You can view a movie of the fluorescent standards separation in all 12 capillaries. To do this:

1. Click the Separation tab.

2. The player control panel has play/pause, rewind and fast forward buttons, and a slider bar that allows 
you to scroll through the movie manually:
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Click Play (button on far left) to view the movie. In the examples below, standards for a Peggy Sue/Sally 
Sue size assay (top left) and a charge assay (top right) are shown, as well as a Jess RePlex size assay (bot-
tom):

NOTE: Complete separation movies of the fluorescent standards are not available until the separation 
step has finished executing. If the movie is played while the separation step is executing, the movie will 
only show separation progress up to the current point in time. 
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Viewing Current and Voltage Plots
You can view plots of the total current and voltage measured during separation for all 12 capillaries. To do 
this, click the IV Plot tab. In the examples below, the IV plot for a size assay is on the left, and the IV plot for a 
charge assay is on the right: 

The blue Y-axis and plot shows the run voltage in volts (V), and the red Y-axis and plot shows the run current 
in micro amps (μA). The X-axis displays time in seconds.

• To zoom in on an area of the plot - Hold the mouse button down and draw a box around the area 
with the mouse.

• To zoom out - Click Zoom Out in the upper right corner of the pane. 

NOTE: The IV plot for a run in progress will not be available until the separation step starts executing. The 
plot is then displayed in real-time. 
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Switching Between Open Run Files
If more than one run file is open, you can switch between viewing the run information in each. To do this:

1. Click the down arrow in the run box.

2. Select the run you want to view from the drop down list.

Closing Run Files
If more than one run file is open, you can close just one file or all the open files at the same time. 

• To close the run file being viewed - Select File from the main menu and click Close. 

• To close all open run files - Select File from the main menu and click Close All. 
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Chapter 8:  
Controlling Jess, Wes, Sally Sue and  
Peggy Sue

Chapter Overview
• Instrument Control

• Self Test

• Viewing and Changing System Properties

• Viewing Log Files

• Status Modes
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Instrument Control
The Instrument menu allows you to control Jess, Wes, Sally Sue and Peggy Sue.

NOTE: Instrument menu options are active only when a computer with Compass for Simple Western is 
connected directly to Jess, Wes, Sally Sue or Peggy Sue. Available functions will vary depending on the 
instrument.

Starting a New Run

To start a new run, select Instrument in the main menu and click New Run. Then follow the steps described 
in “Step 2 - Start the Run” on page 86 for size assays or “Step 2 - Start the Run” on page 140 for charge assays.

Opening Trays (Sally Sue and Peggy Sue)

To open any of the five trays, select Instrument and click Open Trays. The tray control window will appear:

Open a tray by clicking on its button. The button will become highlighted indicating the tray is open.
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NOTE: Only one tray can be open at a time. 

To close a tray, click the corresponding tray button again.

NOTE: If the tray control window is closed when a tray is open, the tray will close automatically. 

Cleaning 

Two cleaning options are available for Sally Sue and Peggy Sue.

Manual Clean

This option is used for general manual cleaning and cleaning the manifold head. To do a manual cleaning, 
select Instrument and click Manual Clean. The manifold head will move to a safe position for easy access 
and the vacuum will turn on. 

NOTE: Please contact Protein Simple Technical Support toll-free in the US and Canada at 1-888-607-9692 
(option 3) if you have any questions regarding the manifold cleaning procedure.

Cleanup

This option is a fully automated cleaning step. The manifold head is flushed, the separation tray troughs are 
aspirated and washed, and any capillaries left in the trays or gripper are picked up and discarded. This option 
should be selected when the instrument has not been used for more than a week or if a run error occurs. 
Cleaning takes about 8 minutes to complete. 
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To start the protocol, select Instrument and click Cleanup. A window will appear with instructions:

Sally Sue’s or Peggy Sue’s status will change to cleaning, and the stop button and the cleaning progress bar 
display. The Assay screen provides cleaning status details:

When cleaning is complete, instrument status will change to Ready.

Cleaning After a Run Error

Additional cleaning steps are required if an error occurs that stops the run. When this happens, the red Error 
status light on Sally Sue’s or Peggy Sue's front panel will come on.

Click on the Reset button displayed in Compass for Simple Western software. The following instructions will 
appear: 
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If the troughs in the separation tray are empty, click on OK and proceed with “Cleanup” on page 167.

If Running Buffer is present in the separation tray, click on Cancel and manually remove the buffer. Evapora-
tion of the Running Buffer will result in a highly viscous residue which the automatic cleaning feature cannot 
remove. 

To remove the Running Buffer:

1. Select Instrument and click Open Trays. 

2. Click Separation to open the separation tray. 

3. Add 800 μL of deionized water to the troughs in the separation tray and soak for 20 minutes.

4. Remove the water by either aspirating with a pipette or with the vacuum wand located on the inside of 
Sally Sue’s or Peggy Sue's left door.

5. Repeat the steps above until the Running Buffer or residues are completely removed.

6. To complete the cleaning process, select Instrument and click Cleanup.
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Self Test
Jess, Wes, Sally Sue and Peggy Sue can perform a series of self tests to check for proper instrument perfor-
mance. To start the test, select Instrument and click Self Test. The test takes approximately 15 to 30 minutes 
depending on the instrument. 

NOTE: We recommend performing the self test prior to starting a run.

To view the test log at completion of the test, select Instrument, click Properties and click View Logs. See 
“Self Test Logs” on page 174 for more information.

Viewing and Changing System Properties
Select Instrument and click Properties to display system properties which include:

• Name

• Location

• Type

• Serial number

• Instrument software version (firmware)

• Network name and address

• Date and time of the instrument clock
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• To change system name or location - click in the name or location boxes and enter the new infor-
mation. 

• To sync the instrument clock with the computer - click Set to PC time.

Viewing Log Files

Error Logs

1. Select Instrument in the main menu and click Properties to display system properties.

2. Click View Error Log. A list of system logs will display: 

Insert image here.
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3. Select a log file and click View. The log details will display:
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4. Click Save File As to save a copy of the log file.
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Self Test Logs

1. Select Instrument in the main menu and click Properties to display system properties.

2. Click View Test Log. A list of self test logs will display: 
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3. Select a log file and click View. The individual test details will display: 

4. Click Save File As to save a copy of the log file.
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Status Modes
The instrument status bar displays status, buttons and progress bars depending on what Jess, Wes, Sally Sue 
or Peggy Sue is doing. 

• Ready/Start button - The instrument is ready and an assay is loaded. Click Start to begin a run.

• Not Ready/Clean button - The instrument is not ready and must perform system cleaning. Click 
Clean to start the cleaning protocol.

• Not Ready/Reset button - The instrument is not ready and must reinitialize. Click Reset to start the 
initialization protocol. 

• Running/Stop button - The instrument is running an assay. The run name, time the run started and 
when it will complete display in the run progress bar. Click Stop to stop the run.

• Cleaning/button not active - The instrument is running a cleaning protocol. The time the cleaning 
protocol started and when it will complete display in the run progress bar. 

• Error/Reset button - An error has occurred. Go to the Status window in the Run Summary screen 
to view details. When the source of the error is corrected, click Reset. 
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Chapter 9:  
Size Assay Data Analysis

Chapter Overview
• Analysis Screen Overview

• Opening Run Files

• How Run Data is Displayed in the Analysis Screen

• Viewing Run Data

• Run Data Notifications and Warnings

• Checking Your Results

• Group Statistics

• Copying Data Views and Results Tables

• Exporting Run Files

• Running Reports

• Changing Sample Protein Identification

• Changing the Virtual Blot View

• Changing the Electropherogram View

• Closing Run Files

• Analysis Settings Overview

• Images Analysis Settings

• Normalization (Jess only)

• Peak Names Settings

• Standard Curve Settings

• System or Loading Control Settings
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• Standard Curve Settings

• Importing and Exporting Analysis Settings
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Analysis Screen Overview
The Analysis screen is used to view run data including electropherograms, capillary images, lane view data 
and tabulated results. Any post-run analysis is also done in this screen. To access this screen, click Analysis in 
the screen tab: 

Analysis Screen Panes

The Analysis screen has seven panes, each displays the following data for up to 96 capillaries per experimen-
tal run:

• Experiment - Lists the assay protocol steps and assay template information.

• Graph - Displays electropherogram data for sample proteins, fluorescent standards or capillary regis-
trations.

• Image - Displays a 12-capillary image of the separated sample proteins, fluorescent standards or cap-
illary registrations.

• Lane - Displays data for sample proteins, fluorescent standards or capillary registrations as bands in 
individual lanes. This virtual blot-like image is similar to traditional blot results.

• Peaks - Lists the tabulated results for sample proteins and information for identified fluorescent stan-
dards and capillary registrations.

• Capillaries - Displays a list of the sample proteins Compass for Simple Western named automatically 
using the user-defined peak name analysis parameters.

• Analysis Options - Displays options to change various exposure settings and edit/label peak attri-
butes.
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NOTE: The reported molecular weight for sample proteins in Compass for Simple Western may vary from 
apparent molecular weights using other techniques and based on sample and assay conditions.
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Software Menus Active in the Analysis Screen

The following software menus are available:

• File

• Edit

• View

• Instrument (when Compass for Simple Western is connected to Jess, Wes, Sally Sue or Peggy Sue)

• Window

• Help

The File, Edit and View menu options specific to the Analysis screen are described next.

File Menu

The following File menu options are active:

• Open Run - Opens a run file.

• Add Run - Opens and views other run files in addition to those that are already open.

• Close - Closes the run file currently being viewed. 

• Close All - Closes all open run files.

• Save - Saves changes to the open run file.

• Save As - Saves changes to the open run file under a different file name. 

• Export Tables - Exports the results for all capillaries in the run in .txt format.

• Export Spectra - Exports the raw data traces for each capillary in the run in .txt or .cdf format.

• Run Report - Creates a report of the run in .pdf format.

• Exit - Closes Compass for Simple Western.
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Edit Menu

The following Edit menu options are active: 

• Copy - Lets you copy data shown in the graph, lane, peaks or capillaries panes. See “Copying Data 
Views and Results Tables” on page 244 for more information. 

• Analysis - Displays the analysis settings used to analyze the run data and lets you change them as 
needed. See “Analysis Settings Overview” on page 292 for more information. 

• Preferences - Lets you set and save custom preferences for data export, plot colors in the graph and 
Twitter settings. See Chapter 11, “Setting Your Preferences“ for more information.

View Menu

The following View menu options are active: 

• Selected View - Displays data in a per capillary (single) view format.

• All View - Displays data in a per 12- or 25-capillary (multiple) view format.

• Standards - Lets you change the data view to show only the fluorescent standards. 

• Registration - Lets you change the data view to show only the capillary registrations (Sally Sue and 
Peggy Sue only).

• Samples - Lets you change the data view to show sample proteins. 

• Filter - Lets you display data only for specific capillaries or named proteins. 

• View Region - Lets you change the molecular weight (x-axis) range of the data displayed. 
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• Show Hidden- Shows capillaries that are hidden from the data view.

Opening Run Files
You can open one or multiple run files at a time to compare data between runs.

Opening One Run File

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass 
for Simple Western first, then open the file.

1. Select File in the main menu and click Open Run.

2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

Opening Multiple Run Files

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass 
for Simple Western first, then open the file.

1. To open the first run file, select File in the main menu and click Open Run.
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2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

3. To open another run file, select File in the main menu and click Add Run.

4. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. When a run is added, its data will append to the open run file, and will 
display as a second set of up to 25 capillaries (Jess/Wes) or 96 capillaries (Sally Sue/Peggy Sue) in all 
screen panes. The second run file name will also appear in the Compass title bar:
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5. Repeat the last two steps to add additional runs. 

NOTES:  
When adding multiple data files for analysis, they must contain matching detection channels (for exam-
ple chemi, IR/NIR fluorescence, or IR/NIR fluorescence with Protein Normalization). 
 
When adding multiple RePlex data files (Jess only), the channels for both probes must contain matching 
detection files. For example, a chemiluminescence with Total Protein data file can’t be added to a chemilu-
minescence/chemiluminescence data file.
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How Run Data is Displayed in the Analysis Screen
Data in the run file is compartmentalized for easy review in one of six panes in the Analysis screen.

Experiment Pane: Assay and Capillary Information 

The experiment pane displays assay and capillary information for each of the 25 capillaries (Jess/Wes) or 96 cap-
illaries (Sally Sue/Peggy Sue) in the run. A maximized view of the experiment panes for a standard Immunoas-
say on Sally Sue and a RePlex Assay with two fluorescent NIR Immunoassays on Jess are shown below.

• To view all columns - Click the Experiment tab, then use the scroll bar or click Maximize in the 
upper right corner. 

• To resize columns - Click the Experiment tab. Roll the mouse over a column border until the sizing 
arrow appears, then click and drag to resize. 

Experiment pane column descriptions for the default assay are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

NOTE: Data notification icons will display in the sample column if Compass for Simple Western detected a 
potential analysis issue or data was manually modified by the user. For more information see “Run Data 
Notifications and Warnings” on page 227. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Primary (default name) will display. 

• Primary 1 (Jess RePlex Assays only) - Primary antibody name for Probe 1. If primary antibody names 
were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary 
(default name) will display. 
Compass for Simple Western User Guide



How Run Data is Displayed in the Analysis Screen page 187
• Primary 2 (Jess RePlex Assays only) - Primary antibody name for Probe 2. If primary antibody names 
were entered in the assay template (Assay screen), those names will display here. Otherwise, Primary 
(default name) will display. 

• Secondary - Secondary antibody name. If secondary antibody names were entered in the assay tem-
plate (Assay screen), those names will display here. Otherwise, Secondary (default name) will display. 

NOTE: The Secondary column will not display for RePlex Assays on Jess with two immunoassays. 

• Cycle (Sally Sue/Peggy Sue only) - Run cycle number. There are 12 capillaries in one cycle for Sally 
Sue/Peggy Sue. 

NOTE: Sally Sue and Peggy Sue can run up to eight cycles (12 capillaries per cycle) in an experiment. Each 
cycle is designated in the Experiment summary.

• Cap - Capillary number.

• S (Peggy Sue/Sally Sue only) - Well on the assay plate used for sample. 

• 1 (Peggy Sue/Sally Sue only) - Well on the assay plate used for primary antibody or Total Protein 
labeling reagent.

• 2 (Peggy Sue/Sally Sue only) - Well on the assay plate used for secondary HRP-conjugate or Total 
Protein Streptavidin-HRP.

• 3 (Peggy Sue/Sally Sue only) - Well on the assay plate used for a tertiary antibody.
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Graph Pane: Electropherogram Data

Click the Graph tab to view data for sample proteins, fluorescent standards or capillary registrations. Data for 
samples is shown in the following example, and proteins are displayed as peaks:

More Graph view options will be described in more detail in “Changing the Electropherogram View” on 
page 268.
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Image Pane: Capillary Separation Image Data

Click the Image tab to view final separation images of sample proteins, fluorescent standards or capillary 
registrations for up to 96 capillaries per experimental run. Image data for samples is shown in the following 
example:
Compass for Simple Western User Guide



page 190 Chapter 9: Size Assay Data Analysis
Select the blue All Images icon at the top right of the Image view pane to display sample, raw, and back-
ground images. Image data for multiple sample types is shown in the following example: 
Compass for Simple Western User Guide



How Run Data is Displayed in the Analysis Screen page 191
Lane Pane: Virtual Blot-Like Image Data

Click the Lane tab to view data for sample proteins, fluorescent standards or capillary registrations as bands 
in individual lanes. This virtual blot-like image is similar to traditional blot results. Data for samples in the lane 
view for an Immunoassay (immunodetected proteins), Protein Normalization (for Jess only), and from a Total 
Protein Assay are displayed as bands in the examples below. 
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To view information for a band, roll the mouse over a band until the info box appears. 

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein 
Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques 
and based on sample and assay conditions.

Lane data displayed in the virtual blot is automatically aligned by Compass for Simple Western. To view raw, 
unaligned lane data and learn more about virtual blot viewing options, see “Changing the Virtual Blot View” 
on page 261.
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Std Curve Pane: Standard Curve Fit Data

Click the Std Curve tab to view a linear or 4-parameter curve fit of your standard curve proteins. Data for the 
samples in the std curve view is shown in the following example where proteins are displayed as dots. 

Concentration of the sample proteins is automatically determined by Compass based on defined values of 
the standard curve. 

Peaks Pane: Calculated Results

Click the Peaks tab to view tabulated results for sample proteins, normalized sample proteins shown as  
Corr. Area (when Normalization is enabled), fluorescent standards or capillary registrations. Each row in the 
table shows the individual results for each peak detected in each capillary. Data for samples in the peaks 
table for an Immunoassay, a Total Protein Assay, Protein Normalization (Jess only) and a RePlex Assay (Jess 
only) are shown in the following examples: 
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NOTES:  
Peaks that Compass for Simple Western names automatically using the user-defined peak name analysis 
parameters are color-coded. 
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The reported molecular weight for sample proteins detected using an Immunoassay or a Total Protein 
Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques 
and based on sample and assay conditions.

• To view all rows - Click the Peaks tab, then use the scroll bar or click Maximize in the upper right 
corner. 

• To resize columns - Click the Peaks tab. Roll the mouse over a column border until the sizing arrow 
appears, then click and drag to resize. 

Peak table column descriptions are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen) or Analysis 
Options pane, those names will display here. Otherwise, Sample (default name) will display. 

• Primary - Primary antibody name. For Immunoassays, if primary antibody names were entered in the 
assay template (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Pri-
mary (default name) will display. For Total Protein Assays, Antibody Diluent will display as the default 
name.

• Secondary - Secondary antibody name. If secondary antibody names were entered in the assay tem-
plate (Assay screen) or Analysis Options pane, those names will display here. Otherwise, Secondary 
(default name) will display.

• Cap 

• Sally Sue and Peggy Sue: Cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 
3.

• Jess and Wes: Capillary number.
• Jess RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4. 

NOTE: Sally Sue and Peggy Sue run up to eight cycles in an experiment, 12 capillaries at a time. Capillary 
and cycle numbers are displayed in the Experiment tab.

• Peak - Peak number. Peaks are numbered in order of detection. 

• Name - Peak name. Displays peaks that Compass for Simple Western named automatically using the 
user-defined peak name analysis parameters. Cells will be blank if Compass was not able to name the 
peak or if naming parameters were not entered.

• Position - Displays the pixel position of a peak in the image.

• MW (kDa) - Displays the calculated molecular weight in kDa for the peak (shown for sample data 
only).

• Height - Displays the calculated peak height.
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• Area - Displays the calculated peak area (shown for sample data only).

• % Area - Reported when area is calculated using the Gaussian method (default for Immunoassays, 
see “Peak Find Settings” on page 301 for more information). Displays the calculated percent area for 
the named peak compared to all named peaks. This value results from dividing the individual peak 
area by the sum of all named peak areas for the capillary and multiplying by 100 (shown for named 
peak sample data only).

• % Total - Reported when area is calculated using the Dropped Line method (default for Total Protein 
Assays, see “Peak Find Settings” on page 301 for more information). Displays the calculated percent 
area for the peak compared to the total area measured in the capillary. This value results from dividing 
the individual peak area by the entire area under the curve for the capillary and multiplying by 100.

• Conc (Concentration) - Displays the calculated concentration of protein for the named peak. This 
column will not appear unless a standard curve is defined.

• Corr. Area - Displays the corrected area for the peak. This column will not appear unless a Loading 
Control is defined or Normalization is enabled in Analysis Preferences.

• For PN channel - A linear correction calculation is applied to peak area to represent amount of 
protein. The linear calculation correction factor is Corr. Area = Area + (1e-5 * Area2). The normal-
ization factor is not used for this calculation.

• For Chemi, NIR, and IR channel peaks - Corrected area is determined by first calculating the 
Capillary Normalization factor for each capillary and then correcting the peak area as follows:

Capillary Normalization Factor = Normalization area for chosen capillary/Normalization area for 
reference capillary in Analysis settings.

Then,

Corr. Area = Peak area/Capillary Normalization factor.

• Width - Displays the calculated peak width (shown for sample data only).

• S/N - Displays the calculated signal to noise ratio for the peak (shown for sample data only). Please 
note this calculation is based on a peak finding algorithm to provide a relative ratio comparing all 
peaks within the electropherogram in Compass. 

• Baseline - Displays the raw baseline signal of each peak

• Channel - Detection channel (Chemi, NIR, IR, PN)

Capillaries Pane: User-Specified Peak Names

Click the Capillaries tab to view tabulated results for sample proteins associated with specific primary anti-
bodies, Protein Normalization area, or Total Protein area in the run data. Compass for Simple Western labels 
these sample peaks automatically using user-defined peak name settings. Each row in the table shows the 
individual results for the named peaks detected in each capillary. Data for samples in the capillaries table is 
shown in the following example for an Immunoassay and a RePlex Assay with two immunoassays. 
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For standard Total Protein Assays where area calculation is handled via Dropped Lines by default, the Capil-
laries tab is shown below. Compass for Simple Western labels the sample peaks automatically using user-
defined peak name settings. Each row in the table shows the individual results for the total area and named 
peaks detected in each capillary.

• Total Area - Total area measured in the capillary when using a standard Total Protein Assay.
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For RePlex Assays with Total Protein enabled where the TP Area column accounts for this measurement 
automatically, the capillaries tab is shown below.

• TP Area - Total area measured in the capillary for the Total Protein signal.

• TPN (%) - Total Protein signal for chosen capillary/Total Protein signal for reference capillary in the 
Analysis settings.

When using the Protein Normalization Module on Jess, where the PN Corr.Area column accounts for this 
measurement automatically, the capillaries tab is shown below.

PN Corr.Area is determined by first calculating the normalization factor for each capillary and then correcting 
the peak area for each signal as follows: 

Capillary Normalization Factor = Protein Normalization signal for chosen capillary/Protein Normaliza-
tion signal for reference capillary in Analysis settings.

Then,

PN Corr.Area = PN Area + (1e-5 * Area2)

PN (%) = Capillary Normalization Factor x 100, as percentage
Compass for Simple Western User Guide



How Run Data is Displayed in the Analysis Screen page 199
NOTES:  
Peaks that Compass for Simple Western names automatically with user-defined peak name settings are 
color-coded. 
 
Information displayed for fluorescent standards and capillary registration data will be for identified stan-
dards or registration peaks.

• To view all rows - Click the Capillaries tab, then use the scroll bar or click Maximize in the upper 
right corner. 

• To resize columns - Click the Capillaries tab. Roll the mouse over a column border until the sizing 
arrow appears, then click and drag to resize. 

Capillaries table column descriptions are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay 
screen) or Analysis Options pane, those names will display here. Otherwise, Primary (default name) will 
display.

• Secondary - Secondary antibody name. If secondary antibody names were entered in the assay tem-
plate (Assay screen) or Assay Options pane, those names will display here. Otherwise, Secondary 
(default name) will display. 

• Capillary

• Sally Sue and Peggy Sue: Cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 
3.

• Jess and Wes: Capillary number.
• Jess RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 4. 

NOTE: Sally Sue and Peggy Sue run12 capillaries at a time in a cycle and are able to run up to eight cycles 
in an experiment. The information on cycle and capillary number is displayed in the Experiment tab.

• Peak Name Columns - An individual column per peak name will display for every peak identified by 
name in the run data. Cells for capillaries in these columns will be blank if Compass for Simple West-
ern did not find peaks automatically using the user-defined peak name analysis parameters (or none 
were entered).
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• To view % area in the peak name columns - the Gaussian Fit area calculation setting must first 
be selected. To do this, select Analysis from the Edit menu, then select Peak Fit page. In the 
Peak Find box, select Gaussian Fit for the Area Calculation setting (default for Immunoassays). 
Next, select Area % in the upper right corner of the Capillaries pane. This displays the calculated 
percent area for the named peak compared to all named peaks. This value results from dividing 
the individual peak area by the sum of all named peak areas for the capillary and multiplying by 
100.

• To view peak area in the peak name columns (default) - Select Area in the upper right corner 
of the pane. This displays calculated peak area for the individual peak only. 

• To view corrected peak area in the peak name columns - Select Corr. Area in the upper right 
corner of the pane. This displays the corrected peak area for the named peak compared with the 
loading control peak or reference capillary when Protein Normalization is enabled in the Analysis 
settings.

• To view concentration in the peak name columns - Select Conc. in the upper right corner of 
the pane. This displays the calculated concentration for the named peak compared with the 
standard curve.

• To view % total in the peak name columns - The Dropped Lines area calculation setting must 
first be selected. To do this, select Analysis from the Edit menu, then select Peak Fit page. In the 
Peak Find box, select Dropped Lines for the Area Calculation setting (default for Total Protein 
Assays). Next, select % Total in the upper right corner of the Capillaries pane. This displays the 
calculated percent total for the named peak compared to the total area measured in the capillary. 
This value results from dividing the individual peak area by the entire area under the curve for the 
capillary and multiplying by 100.
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Viewing Run Data
Each run file contains the following data for up to 96 capillaries:

• Sample data - For the proteins in the sample.

• Standards data - For the fluorescent standards run with each sample.

• Registration data (Sally Sue and Peggy Sue only) - For tracking capillaries as they are moved for 
various assay steps. 

Data can be viewed for one, all, or individually selected capillaries. 

Switching Between Sample, Standards and Registration Data Views

You can switch between viewing sample, standards and registration data in a run file using the View bar or 
View menu: 

Data buttons in the View bar: 

Show Standards

Show Registrations

Show Samples
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• To view sample data - Click Show Samples in the View bar or select View in the main menu and 
click Samples:

• Data in this view is for sample proteins only.
• Graph view data displays electropherograms in chemiluminescence, NIR or IR units (y-axis) and 

molecular weight in kDa (x-axis). If protein normalization was performed in the same immunoas-
say run, the overlay is also displayed in the Graph view.

• Lane view data displays sample proteins only.
• Image view data displays sample proteins only.
• Results for each protein are shown in the peaks and capillaries tables.

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein 
Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques 
and based on sample and assay conditions.

For information on checking and identifying sample peaks, see “Step 4 – Checking the Ladder” on 
page 234 or “Step 5 – Checking Samples” on page 236.
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• To view standards data - Click Show Standards in the View bar or select View in the main menu 
and click Standards:

NOTE: For RePlex Assays (Jess only), standards data will be displayed regardless of what channel (Probe 1 
or Probe 2) is selected.

• Data in this view is for the fluorescent standards only. These standards are premixed with each 
sample prior to analysis. 

• Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis). 
• Lane view data displays fluorescent standards only.
• Image view data displays fluorescent standards only.
• Standards are highlighted in both the peaks and capillaries tables and marked with an S.
For information on checking and identifying standards peaks, see “Step 2 – Checking Fluorescent Sizing 
Standards” on page 230.
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• To view registration data (Sally Sue and Peggy Sue only) - Click Show Registrations in the View 
bar or select View in the main menu and click Registration:
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• Data in this view shows capillary registration only. 
• Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis). 
• Lane view data displays capillary registration only.
• Image view data displays capillary registration only.
• Registrations are highlighted in both the peaks and capillaries tables and marked with an R.

Because capillaries in Sally Sue and Peggy Sue must be moved multiple times during the run, their posi-
tions are tracked to account for potential changes in imaging position as they are moved to and from 
the separation block. To do this, one of the standards is used as a capillary registration. An image of the 
standard used for registration is taken at the end of the separation step prior to chemiluminescent 
imaging. The position of this peak in the registration image is then compared to the position of the 
same standard peak in the standards image. The shift value listed in the peaks table is the change in 
pixel position between the two images. Compass for Simple Western data is then aligned to account for 
any changes in capillary position. 

For information on checking and identifying registration peaks, see “Step 3 – Checking Capillary Regis-
trations (Sally Sue and Peggy Sue Only)” on page 233.
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Selecting and Displaying Capillary Data

You can choose to view data from one, multiple, or all capillaries at once.

• To look at data for one capillary - Click a row in the experiment pane. Data for just the row selected 
will display in all data views and tables. The following example shows sample data displayed in the 
lane and peaks panes when one sample is selected: 
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• To look at data for multiple non-sequential capillaries - Hold the Ctrl key and select the rows you 
want to view in the experiment pane. Data for only the rows selected will display in all data views and 
results tables. The following example shows sample data displayed in the graph (in multiple view) 
and capillaries panes when multiple rows are selected:
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• To look at data for multiple sequential capillaries - Hold the Shift key and select the first and last 
rows you want to view in the experiment pane. Data for only the selected rows will display in all data 
views and results tables. The following example shows standards data displayed in the image and 
peaks panes when multiple sequential rows are selected:
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• To look at data for all capillaries - Hold the Shift key and select the first and last rows in the experi-
ment pane. Data for all rows will display in all data views and results tables. The following example 
shows standards data displayed in the lane and peaks panes when all rows are selected. The pane 
scroll bars can be used to view all 8 cycles:
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Switching Between Fluorescence Channel Views (Jess Only)

You can switch between displaying run data in the graph, image and lane panes for samples run using HRP-
tagged or fluorophore dye-containing secondaries in the View bar. Protein normalization overlay data can 
also be selected here. This view is selected in the View bar: 

Detection channels in the View bar: 

Switching Between Single and Multiple Views of the Capillaries

You can switch between displaying run data in the graph, image and lane panes in a per capillary (single) 
format or up to 96 capillary format. This view is selected in the View bar or the View menu. 

Capillary view buttons in the View bar: 

Overlay chemiluminescent 
channel 

Overlay near infrared channel

Overlay infrared channel

Overlay protein normalization 
channel

Single View

Multiple View
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• To view data in a per capillary format - Click Single View in the View bar or select View in the main 
menu and click Single View:

Data for the row(s) selected in the experiment pane will display as follows:

• Electropherograms in the graph pane display overlaid or stacked (depending on the graph 
option chosen). 

• Results for only the selected row(s) will display in the peaks and capillaries tables.
• The selected row(s) are highlighted in the image pane:
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• Lanes for only the selected row(s) are displayed in the lane pane:
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• To view data in a multiple capillary format - Click Multiple View in the View bar or select View in 
the main menu and click Multiple View:

Data for the row(s) selected in the experiment pane will display as follows:

• Electropherograms corresponding to the selected row(s) are highlighted and displayed in the 
graph pane. 

• Results for selected capillaries display in the peaks and capillaries tables and are highlighted.
• The selected row(s) are highlighted in the image pane:
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• All selected lanes display in the lane pane, and lanes corresponding to the selected row(s) are 
highlighted. 
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Viewing RePlex Channel Views (Jess Only)

Probe 1 data displays by default when you open a RePlex run file. To display a second Probe 1 or Probe 2 
channel data, click the channel icon in the View bar. Channel designations are shown below: 

Detection channels in the View bar: 

Chemiluminescent channel 
(grey)

Near infrared channel (red)

Unused channel (no color)

Channel data is displayed 

Channel data is available but 
not displayed

Probe 1 Channels

Probe 2 Channel
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The initial view displays Probe 1 data only. In this example, the Probe1 channel is chemiluminescence.
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Probe 1 data is labeled in all data views as P1 or Probe 1: 

• Graph view: 

• Image view:
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• Lane view - sample lanes are labeled probe number: capillary number

• Peaks and Capillaries table: rows are labeled probe number: capillary number
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Viewing Data for Probe 2

To view chemiluminescent or NIR data for Probe 2, select it’s channel in the view bar: 

Probe 2 data is labeled P2 or Probe 2:

Probe 2 Channel
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• Graph view will display data stacked or overlaid depending on the option chosen:

• Image view will display separate images for each probe:
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• Lane view will display P1 and P2 lanes side by side: 

• Peaks and Capillaries tables will display all row data for P1 first, then P2: 
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Viewing Data for a Second Channel in Probe 1

To view the second channel data for Probe 1, for example in a RePlex Chemiluminescence/NIR fluorescence 
+ Total Protein assay, select it’s channel in the view bar: 

• Graph view will display data stacked or overlaid channel data depending on the option chosen:

Probe 1 Channel 1

Probe 1 Channel 2
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• Image view will display individual images for each channel:
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• Lane view will display lanes for each channel overlaid: 

• Peaks and Capillaries tables will list data for both channels: 

Hiding Capillary Data

Capillary data can be hidden from view if needed. To do this:

1. Click the Experiment tab. 
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2. Select the rows you want to hide, then right click on one of the selected rows and click Hide:

Data for selected rows will be hidden in all data views and results tables (except for the image pane). 

• To view hidden rows - Select View in the main menu and click Show Hidden. Hidden rows will 
become visible again in all panes, and hidden rows will be marked with an X in the experiment pane:

• To unhide rows - Select the hidden row(s). Right click on one of the selected rows and click Unhide. 

Setting Run Data Display Filters

The filter lets you auto-hide specific capillaries in the run file data, or only show data for peaks that Compass 
for Simple Western identified automatically using the user-defined peak name analysis parameters. 

NOTE: When more than one run file is open, filter settings will be applied to all files.

• To filter data to show specific capillaries only - Select View in the main menu and click Filter. 
Uncheck the boxes for the capillaries you do not want shown, then click OK. 
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Only data for the checked capillaries will display in data views and results tables, unchecked capillaries 
will be hidden. 

• To filter data to show named peaks only - Select View in the main menu and click Filter. Select 
Show named peaks only then click OK. Only data for peaks that Compass for Simple Western identi-
fied automatically using the user-defined peak name analysis parameters will display in data views 
and results tables, all other peak data will be hidden.

Run Data Notifications and Warnings
If Compass for Simple Western detects a potential data issue, a notification or warning will display next to 
the row in the experiment pane. A list of warnings, notifications and corrective actions are as follows: 

 • Manual correction of sample data notification - Indicates the user modified sample 
data manually, such as adding or removing a sample peak. Rolling the mouse over the 
icon displays the type of data modification made.
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 • Standards warning - Indicates that one of the standards may not be identified prop-
erly. This can be resolved by manually identifying the standards. Please refer to “Step 2 – 
Checking Fluorescent Sizing Standards” on page 230 for details. Rolling the mouse over 
the icon displays warning details.

 • Manual correction of standards data notification - Indicates the user modified the 
standards data manually. Rolling the mouse over the icon displays the type of data 
modification made.

 • Registrations warning - Indicates that a capillary registration was not identified prop-
erly. This can be resolved by manually identifying the registration peak. Please refer to 
“Step 3 – Checking Capillary Registrations (Sally Sue and Peggy Sue Only)” on page 233 
for details. Rolling the mouse over the icon displays warning details.

 • Manual correction of registrations notification - Indicates the user modified the 
capillary registration data manually. Rolling the mouse over the icon displays the type of 
data modification made.
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Checking Your Results
Compass for Simple Western detects proteins, fluorescent standards and capillary registrations and reports 
results automatically with no user-interaction. However, we recommend you review the data as outlined in 
this section as good general practice to ensure accurate results. If a data warning is presented in the experi-
ment pane, the following steps will also help you identify and correct any issues.

Step 1 – Review the Fluorescent Sizing Standards Movie

All capillaries should have three fluorescent sizing standards. To verify the standards separated in the capil-
lary correctly: 

1. When the run has completed, click the Run Summary screen tab. 

2. Click the Separation tab and play the movie (this will be the fluorescent standards separation). 

 • Peak fit warning - Indicates that a peak cannot be fit properly. This is typically caused 
either by a very small peak in the electropherogram or a peak that is very close to the 
end of the molecular weight range. This can be resolved by removing the peak. Please 
refer to “Step 4 – Checking the Ladder” on page 234 or “Step 5 – Checking Samples” on 
page 236 for details. Rolling the mouse over the icon displays warning details.
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3. For each capillary, verify that the standards visibly separated. Each fluorescent point in the capillary rep-
resents one of the three sizing standards. 

Step 2 – Checking Fluorescent Sizing Standards

To verify the standards are identified correctly: 

1. Click the Analysis screen tab. 

2. Click Show Standards in the View bar. Verification that the standards have been correctly identified can 
be done in either the graph or lane panes.
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Graph Pane: 

a. Click Single View in the View bar. 

b. Click on the first row in the experiment pane, then click the Graph tab. Check that the electrophero-
gram has three standard peaks labeled Std 1, Std 29 and Std 230 (for 12-230 kDa size assays), Std 57 
and Std 280 (for 66-440 kDa size assays) or Std 1 and Std 29 (for 2-40 kDa size assay). They will also be 
identified with a green S in the peaks table.

If standards are not identified correctly, they can be manually corrected as follows:

• If an incorrect peak is identified as a standard - Right click the peak in the electropherogram 
or peaks table and select Not a Standard. Compass for Simple Western should correctly 
reassign the remaining peaks as standards, and update the peaks table.

• To set an unidentified peak as a standard - Right click the peak in the electropherogram or 
peaks table and select Force Standard. Compass for Simple Western will assign the peak as a 
standard, and correctly reassign the remaining standard peaks. A lock icon indicating the stan-
dard was set manually will display next to the peak in the peaks table. 

NOTE: To remove standards peak assignments that were made manually, right click on the peak in the 
electropherogram or peaks table and click Clear. 
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c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards 
are identified correctly.

Lane Pane: 

a. Click Multiple View in the View bar. 

b. Click on the first row in the experiment pane, then click the Lane tab. Standards will be bands and 
identified with a green outline. Check that all standard bands are labeled: Std 1, Std 12 and Std 230 
(for 12-230 kDa size assays) or Std 57 and Std 280 (for 66-440 kDa size assays). They will also be iden-
tified with a green S in the peaks table. To view band labels, roll the mouse over the individual bands. 

If standards are not identified correctly, they can be manually corrected as follows:

• If an incorrect band is identified as a standard - Right click the band in the lane or peaks 
table and select Not a Standard. Compass for Simple Western should correctly reassign the 
remaining bands as standards.

• To set an unidentified band as a standard - Right click the band in the lane or peaks table 
and select Force Standard. Compass for Simple Western will assign the band as a standard, 
and correctly reassign the remaining standard bands.

c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards 
are identified correctly.
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Step 3 – Checking Capillary Registrations (Sally Sue and Peggy Sue Only)

All capillaries should have a single capillary registration peak. To verify the registrations are identified cor-
rectly: 

1. Click the Analysis screen tab. 

2. Click Show Registrations and Single View in the View bar. 

3. Click the Graph tab.

4. Click on the first row in the experiment pane. The registration peak will be the first and largest peak in 
the electropherogram. Check that the registration peak is identified and labeled Reg 1 in the electro-
pherogram. It will also be identified with a purple R in the peaks table. 

5. If the registration peak is not identified correctly, right click the correct registration peak in the electro-
pherogram or peaks table and select Registration Force. Compass for Simple Western will assign the 
new peak as the capillary registration. A lock icon indicating the registration was set manually will dis-
play next to the peak in the peaks table.
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NOTE: To remove registration peak assignments that were made manually, right click on the peak in the 
electropherogram or peaks table and click Registration Clear. 

6. Repeat the previous steps for the remaining rows in the experiment pane to make sure all registrations 
are identified correctly.

Step 4 – Checking the Ladder

Depending on the size assay you are running, the biotinylated ladder should have the following sizing stan-
dards: 12, 40, 66, 116, 180 and 230 kDa (for 12-230 kDa size assays), or 66, 116, 200, 280 and 440 kDa (for 66-
440 kDa assays). To verify the ladder standards are identified correctly:

1. Click the Analysis screen tab. 

2. Click Show Samples in the View bar. Verification that the ladder standards have been correctly identi-
fied can be done in either the graph or lane panes, but manual corrections must be done in the graph 
pane.

Graph Pane: 

a. Click Single View in the View bar. 

b. Click on the row in the experiment pane that contains the ladder (typically row 1), then click the 
Graph tab. Check that the electropherogram has either six ladder peaks (for 12-230 kDa size assays) 
or five ladder peaks (for 66-440 and 2-40 kDa size assays). In the example below, the electrophero-
gram has six peaks labeled Ldr 12, Ldr 40, Ldr 66, Ldr 116, Ldr 180 and Ldr 230.
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If ladder peaks are not identified correctly, they can be manually corrected as follows:

• If an incorrect peak is identified as a ladder peak - Right click the peak in the electrophero-
gram or peaks table and select Remove peak. Compass for Simple Western should correctly 
reassign the remaining peaks as ladder standards.

• To set an unidentified peak as a ladder peak - Right click the peak in the electropherogram 
or peaks table and select Add Peak. Compass for Simple Western will assign the peak as a lad-
der standard, and correctly reassign the remaining ladder standards peaks.

NOTE: To remove ladder peak assignments that were made manually and go back to the original view of 
the data, right click in the electropherogram and click Clear All. 

Lane Pane: 

a. Click either Single View or Multiple View in the View bar. 

b. Click on the row in the experiment pane that contains the ladder (typically row 1), then click the 
Lane tab. Check that the lane has either six ladder bands (for 12-230 kDa size assays) or five ladder 
bands (for 66-440 kDa and 2-40 kDa size assays). In the example below, the lane has six peaks labeled 
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Ldr 12, Ldr 40, Ldr 66, Ldr 116, Ldr 180 and Ldr 230. To view band labels, roll the cursor over the indi-
vidual bands. If ladder bands are not identified correctly, they must be corrected in the graph pane 
as described in the previous section. 

Step 5 – Checking Samples 

All sample proteins in the graph and lane panes will be labeled automatically with the calculated protein 
size. 

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein 
Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques 
and based on sample and assay conditions.

To verify that sample proteins are identified correctly:

1. Click the Analysis screen tab. 

2. Click Show Samples in the View bar. Verification that sample proteins have been correctly identified 
can be done in either the graph or lane panes, but manual corrections must be done in the graph pane.
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Graph Pane: 

a. Click Single View in the View bar. 

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the 
Graph tab.

If sample peaks are not identified correctly, they can be manually corrected as follows:

• If an incorrect peak is identified as a sample peak - Right click the peak in the electrophero-
gram or peaks table and select Remove peak. Compass for Simple Western will no longer 
identify it as a sample peak in the electropherogram and the peak data will be removed in the 
results tables. 

• To set an unidentified peak as a sample peak - Right click the peak in the electropherogram 
or peaks table and select Add Peak. Compass for Simple Western will calculate and display the 
results for the peak in the results tables and identify the peak in the electropherogram.

NOTE: To remove sample peak assignments that were made manually and go back to the original view of 
the data, right click in the electropherogram and click Clear All. 
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c. Repeat the previous steps for the remaining sample rows in the experiment pane to make sure all 
sample proteins are identified correctly.

Lane Pane: 

a. Click either Single View or Multiple View in the View bar. 

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the 
Lane tab. To view sample protein band labels, roll the cursor over the individual bands. If sample 
bands are not identified correctly, they must be corrected in the graph pane as described in the pre-
vious section. 

Step 6 – Assigning Peak Names (Optional)

Compass for Simple Western can identify and automatically name sample proteins associated with specific 
primary antibodies in the run data using user-specified peak name settings. For more information on how to 
do this see “Peak Names Settings” on page 308.
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Group Statistics
The Grouping View is used to analyze replicates by calculating the mean, standard deviation and CV of 
named proteins (see “Peak Names Settings” on page 308 for detailed information on entering named pro-
teins). Statistics for each protein are also plotted for easy comparison between samples, antibodies, and pro-
teins. 

Using Groups

1. A group is automatically created for capillaries with the same sample and primary antibody name, so to 
use this feature, this information must first be entered into the Assay template. To do this: 

a. Click the Assay tab and go to the Template pane.

b. Enter sample names and primary antibody names as described in “Step 6 - Add Assay Plate Annota-
tions (Optional)” on page 43. Be sure to enter the same sample and/or primary antibody names for 
the groups of samples you want to calculate statistics for. 

In this example there are two sample types, Sample A and Sample B which were run with two dif-
ferent antibodies, Primary 1 and Primary 2. 

Each of the two samples were run with each of the two antibodies twice in every cycle. This creates 
four groups for the combination of two samples and two antibodies.

2. To set a grouping option, go to Edit >Preferences and select the Grouping page. Then check the 
option you want to use. These options allow you to group capillaries in multiple ways:
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• Group across runs - Groups capillaries from multiple runs. This option creates fewer groups and 
generates statistics across multiple runs. 

• Group across cycles - Groups capillaries run in different cycles. You can use this for Jess/Wes 
runs too.

• No option selected - When only one run is open, groups will only contain capillaries from the 
same cycle. When more than one run is open, groups are created for each run.

3. Click Apply and then select OK.

4. Group your results and view the associated statistics by selecting View and clicking on Grouping. 
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Viewing Statistics

Peak and Capillary Groups

The Peak Groups pane reports statistics for each named protein in every group. Each group shows the 
statistics for named proteins which includes average area, standard deviation and %CV. The number in 
parenthesis after the sample name indicates the number of capillaries in the group.

Clicking the arrow next to a group lists the individual capillaries in the group and reported data for each cap-
illary:

The Capillary Groups pane pivots the Peak Groups results to show statistics for named protein peaks in 
individual columns.
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Group Plots

The mean values for named peaks in each group are plotted in bar graphs with error bars showing the stan-
dard deviation. The plots compare different antibodies for the same sample and different samples for the 
same antibody to allow a choice of presentation. The y-axis on the plot will be concentration if a standard 
curve is defined.

Hiding or Removing Capillaries in Group Analysis

Hidden capillaries are not included in groups. However, hiding capillaries provides an easy way to reject indi-
vidual capillaries from the statistical analysis. See “Viewing RePlex Channel Views (Jess Only)” on page 216 for 
details on how to do this.

Larger groups of capillaries can also be excluded from analysis. To do this, select View and click Filter.
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Uncheck the box next to the cycles or capillaries you wish to remove and click OK. This data will now be 
removed from the grouped view statistics.
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Copying Data Views and Results Tables
You can copy and paste data and results tables into other documents, or save a data view as a graphic file. 

Copying Data Views

1. Click in the graph or lane pane.

2. Select Edit in the main menu and click Copy, or right click and select Copy. 

3. If you selected copy from the graph pane the following window will display, click Copy. If you selected 
copy from the lane pane skip to the next step.

4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select 
Paste. A graphic of the copied data view will be pasted into the document.

Copying Results Tables

1. Click in the peaks or capillaries pane.

2. Select one or multiple rows.

3. Select Edit in the main menu and click Copy, or right click and select Copy. 

4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select 
Paste. Data for the rows selected will be pasted into the document.

Saving the Graph View as an Image File

1. Click in the graph pane.

2. Select Edit in the main menu and click Copy, or right click and select Copy. 

3. Select an image option (EMF, PNG or PDF) in the pop-up window, then click Save.
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4. Select a directory to save the file to and enter a file name, then click OK. 

Exporting Run Files 
Results tables and raw plot data can be exported for use in other applications. 

Exporting Results Tables 

To export the information in the peaks and capillaries tables:

1. Click File in the main menu and click Export Tables.

2. Select a directory to save the files to and click OK. Data will be exported in .txt format.

NOTE: To exclude export of standards data or export results table data in .csv format, see “Setting Data 
Export Options” on page 465.

Exporting Raw Sample Electropherogram Data 

To export raw sample plot data: 

1. Click File in the main menu and click Export Spectra.
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• To export data in .txt format - Select Text Format. Plots will be exported in one file for all capil-
laries.

• To export data in .cdf format - Select Andi Format. Plots will be exported in one file per capil-
lary.

2. Select a directory to save the files to and click OK. Data will be exported in the selected format.

Running Reports
Compass for Simple Western v3.0 and higher can create and export run reports in .pdf format.

1. Open your run file, then select File > Run Report. The Run Report window displays. 

2. Select or deselect the information you want included in your report. 
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3. Enter a file name for the report. The report file is saved in the same location as the run file is by default.

4. Click OK. When the report is done, the directory containing the report will display so you can open the 
report. 

A full report includes the following: 

• Run information

• Protocol details
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• Plate layout

• Analysis settings
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• Lane views (for all cycles on Peggy Sue and Sally Sue):

 

• Lane views (Channel Lanes Overlay for Jess Only):

 

NOTE: The channel lanes overlay is also divided in the report as individual NIR, IR and Standard channel 
lanes.

• IV plot:
Compass for Simple Western User Guide



page 250 Chapter 9: Size Assay Data Analysis
• Sample plots for each capillary of each cycle (for Peggy Sue and Sally Sue only):

You can also include the fluorescent standards graphs for each capillary, registration graphs (Peggy Sue and 
Sally Sue only) and the standard peaks position and registration peak offsets in pixels in the report.

• Sample plots for each capillary by channel (Jess only):
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NOTE: The example shown is for the NIR channel on Jess only. The report can also include the IR channel, 
fluorescent standards graphs and protein normalization for each capillary, in addition to sample peak 
area data, the standard peaks position and registration peak offsets in pixels.

• Sample images:

NOTE: The report can also include images of other channels and standards.
Compass for Simple Western User Guide



page 252 Chapter 9: Size Assay Data Analysis
• Analysis log:

Changing Sample Protein Identification
Compass for Simple Western allows you to customize what sample proteins are reported in the results tables 
by making manual adjustments in the electropherogram or peaks table.

Adding or Removing Sample Data 

1. Click Show Samples in the View bar. 

2. Click Single View in the View bar. 

3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the 
Graph tab.

• To remove a peak from the data - Right click the peak in the electropherogram or peaks table 
and select Remove peak. Compass for Simple Western will no longer identify it as a sample 
peak in the electropherogram and the peak data will be removed in the results tables. 
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• To add an unidentified peak to the data - Right click the peak in the electropherogram or 
peaks table and select Add Peak. Compass for Simple Western will calculate and display the 
results for the peak in the results tables and identify the peak in the electropherogram.

NOTES:  
To remove sample peak assignments that were made manually and go back to the original view of the 
data, right click in the electropherogram and click Clear All.  
 
Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.

Hiding Sample Data

You can hide the results for a sample protein in the results tables without completely removing it from the 
reported results. To to this:

1. Click Show Samples in the View bar. 

2. Click Single View in the View bar. 
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3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the 
Graph tab.

4. Right click the peak in the electropherogram or peaks table and select Hide peak. Compass for Simple 
Western will hide the peak data in the results tables.
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5. To view hidden peak data, click View in the main menu and click Show Hidden. Hidden peak data will 
display in the results table and be marked with an X. 

6. To unhide a peak, right click on the peak in the electropherogram or peaks table and select Unhide 
Peak. 

Changing Peak Names for Sample Data

If Compass for Simple Western did not automatically name a sample protein associated with a specific pri-
mary antibody, this can be adjusted manually. You can do this in the Analysis Options pane.
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You can change the name or molecular weight of a peak, the channel and its associated color, or designate 
corresponding capillaries. Click the desired peak in the Graph view, lane in the Lane view or row in the Peaks 
Table. Then in the Analysis Options pane, Peak Names menu, click Modify: 

The New option in the Name dropdown box creates a new default Peak Name using the current channel 
and capillaries that are selected.

Rename the peak and modify the parameters, then click Create.
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The tooltip next to the Caps field has useful information on acceptable nomenclature when designating 
capillaries to apply a Peak Name to:
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Alternatively, right click the peak in the electropherogram, peaks table or lane view and click Name, then 
click a name in the list. Compass for Simple Western will change the peak name in the electropherogram 
and results tables, and adjust peak names for other sample proteins accordingly. 

Next, enter the appropriate peak name in the Peak Name box:
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NOTES:  
For details on how to specify peak name settings, see “Peak Names Settings” on page 308. 
 
Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.

Displaying Sample Data for Named Peaks Only

You can adjust the sample data to display results only for user-specified named peaks. To do this: 

1. Click Show Samples in the View bar. 

2. Click View in the main menu and click Filter. 

3. Check the Show Named Peaks only box and click OK.
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Compass for Simple Western will hide peak data in the electropherogram and results tables for all 
unnamed peaks, and instead only display data for named peaks in the electropherogram and results 
tables.
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Changing the Virtual Blot View
Options in the lane pane let you change the contrast or invert the virtual blot, remove baseline noise, 
change lane labels or overlay standards data on sample lanes. 

The Lane pane toolbar has the following options:

Adjusting the Contrast

1. Click the Contrast Adjustment button. The contrast tool will display:

Contrast Adjustment

Invert

Lane Options

Remove Baseline

Overlay Standards Data
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2. There are two ways you can use the Contrast Adjustment tool. The slider is unlocked by default, so you 
can slide it left or right until the desired contrast is reached. You can also lock the slider at a fixed posi-
tion and save your desired contrast levels. This lets you reproduce the same contrast level across data 
files.

3. To lock the slider, select Edit > Analysis, and click the Lane Contrast page. Select Fixed Levels. The 
numbers displayed refer to the current White and Black levels for the chemiluminescence or fluores-
cence (Jess only) run being analyzed. Change these settings and click Apply to see how they impact the 
contrast on the lane view. Once you’re satisfied with the changes, click OK.

• When the you select Fixed Level, the slider won’t be available in the lane view.
• The Lane Contrast setting can be also be determined and saved in the Default Analysis of the 

Assay. That way, any data obtained by running the assay will all have the same contrast settings.
• Lane Contrast settings from the assay or run analysis windows can be exported to be applied to 

other assays or runs.

Inverting the Virtual Blot

1. Click the Invert button. The virtual blot image will invert: 
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2. Click the Invert button again to return to the default view.

Selecting Lane Labels

The labels shown above the lanes in the virtual blot can be customized. To do this: 

1. Click the Lane Options button. The label box will display. Lane labels for a standard Immunoassay and a 
RePlex Assays are shown:
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2. The following lane display options are available:

• Independent Probe Scales (RePlex Assays only) - Checking this box allows the user to have 
independent control of contrast scales for Probe 1 and Probe 2 data for RePlex assays when using 
the Contrast Adjustment button.

• Lane order by Probe (RePlex Assays only) - Checking this box displays lanes based on the 
probe number. All Probe 1 data will be displayed side by side, followed by Probe 2 data. 

The following label options are available for all assays. Check one or multiple label boxes, and uncheck 
those you don’t want to display. To remove labels completely, uncheck all boxes.

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

• Blocking - Blocking reagent name. If a name was entered in the assay template (Assay screen), that 
name will display here. Otherwise, Blocking (default name) will display. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template 
(Assay screen), those names will display here. Otherwise, Primary (default name) will display. 

• Secondary Ab - Secondary antibody name. If a secondary antibody name was entered in the assay 
template (Assay screen), those names will display here. Otherwise, Secondary (default name) will 
display. 

• Capillary
• Sally Sue and Peggy Sue: Cycle and capillary number. For example, C1:3 indicates cycle 1, cap-

illary 3. 
• Jess and Wes: Capillary number. 
• Jess RePlex Assays: Probe and capillary number. For example, P1:4 indicates Probe 1, capillary 

4. 
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NOTE: Sally Sue and Peggy Sue run up to eight cycles (12 capillaries at a time), so the cycle number dis-
played will always be C1-C8 depending on the number of cycles programmed. 

• Attributes - Attribute text. If attribute information was entered for any of the rows or wells in the 
assay template (Assay screen), up to four can be selected and displayed as lane labels.

Viewing the Uncorrected Sample Baseline

1. Click the Remove Baseline button (active for sample data only). This will remove the automatic base-
line correction. 

2. Click the Remove Baseline button again to return to the default, baseline corrected view.

Overlaying Standards Data on Sample Lanes

Data for the standards can be overlaid on the sample data in the virtual blot so you can view the raw, 
unaligned (uncorrected) lane data. To do this: 

1. Click the Overlay Standards Data button (active for sample data only). An overlay of the raw sample 
and standards data will display: 
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2. Click the Overlay Standards Data button again to return to the default, auto-aligned view.
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Moving Lanes in the Virtual Blot View

Lanes in the virtual blot view can be moved to make it easier to compare specific lanes of data. To do this: 

1. Click a lane in the virtual blot. Hold the mouse button down and drag the lane to a new position. 

2. Release the mouse button. The lane will now be repositioned in the virtual blot view. 
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Changing the Electropherogram View
Options in the graph pane let you zoom and scale electropherograms, overlay or stack plots and change the 
peak and plot information displayed. 

The graph pane toolbar has the following options:

Autoscaling the Electropherogram

Click the Autoscale button to scale the y-axis to the largest peak in the electropherogram.

Auto Scale

Graph Options

Stack the Plots

Overlay the Plots
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Click the Autoscale button again to return to default scaling.
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Stacking Multiple Electropherograms

Electropherogram data for multiple capillaries can be stacked vertically in the graph pane for comparison. To 
do this:

1. Click Single View.

2. Select multiple rows in the experiment pane.

3. Click the Stack the Plots button. The individual electropherograms for each row selected will stack in 
the graph pane. 

You can customize the colors used for the stacked plot display. For more information see “Selecting Custom 
Plot Colors for Graph Overlay” on page 466.
Compass for Simple Western User Guide



Changing the Electropherogram View page 271
Overlaying Multiple Electropherograms

The electropherogram data for multiple capillaries can also be overlaid on top of each other for comparison 
in the graph pane. To do this:

1. Click Single View.

2. Select multiple rows in the experiment pane.

3. Click the Overlay the Plots button. The individual electropherograms for each row selected will overlay 
in the graph pane. 

You can customize the colors used for the overlay plot display. For more information see “Selecting Custom 
Plot Colors for Graph Overlay” on page 466.
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Zooming

To zoom in on a specific area of the electropherogram, hold the mouse button down and draw a box around 
the area with the mouse: 
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To return to default scaling, right click in the electropherogram and click Zoom Out. 

Customizing the Data Display

You can customize electropherogram peak labels, plot labels and display options. To do this, select the 
Graph Options button. 
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Peak Labels

You can customize the labels used to identify peaks in the electropherogram with these options: 

Matching Peak Names - Checking this box will draw vertical lines through each named peak. Using this 
option with Stack the Plots or Overlay the Plots features is useful for visual comparison of named peaks 
across multiple capillaries.

• Peak Names - Checking this box will display peak name labels on all named peaks in the electro-
pherogram. 

NOTE: If more than one peak label option is selected, peak name labels will always be used for named 
peaks.
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• Peak Values - Checking this box will display the molecular weight labels on all peaks in the electro-
pherogram. 

NOTES:  
When viewing standards and registration data, this option is called Peak Positions. Labels displayed are 
peak positions rather than molecular weight.  
 
If more than one peak label option is selected, peak name labels will always be used for named peaks. 
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and 
based on sample and assay conditions.
Compass for Simple Western User Guide



page 276 Chapter 9: Size Assay Data Analysis
Baseline, All Exposures and Grid Options

You can view the calculated baseline fit, peak integration, view all exposures and show grid lines with these 
options.

• Fitted peaks - Checking this box will display how the peaks were fit by the software. 

• For Immunoassays, the software uses Gaussian fit by default: 

NOTE: This option is only available for sample data. 
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• For Total Protein Assays, the software uses Dropped Lines fit by default: 

• Baseline Fit - Checking this box will display the calculated baseline for the peaks. Baseline points will 
also display for regions of the electropherogram considered to be at baseline. 
Compass for Simple Western User Guide



page 278 Chapter 9: Size Assay Data Analysis
NOTE: This option is only available for sample data. 

• All Exposures - Checking this option will overlay all the chemiluminescence or fluorescence (Jess 
only) exposure times acquired for a particular run.The peak that corresponds to the exposure time 
selected in the Analysis window on the Images page will be outlined in blue and the Peaks table 
below the graph window displays the data corresponding to the selected exposure time.  
 
In the image below, the All Exposures option is displayed and the 30 second exposure selected in the 
Analysis window is outlined in blue.
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Viewing all the exposures in a single image can aid in spotting potential signal burnout.

Exposure times are sequential, so longer exposures may have less signal. Since the y-axis in the graph 
view reports signal/time, the peak heights for the different exposures should be fairly similar. The peak 
heights and areas will decrease over time with normal HRP enzyme or fluorophore decay, which is 
expected to occur in the late exposures (longer than 120 or 240 seconds). 

If on the other hand you observe a quicker signal (peak height) decline over time in the tall peaks vs. 
smaller peaks for a chemiluminescence run, then this decline is what we refer to as burnout and is a 
result of local Luminol depletion.

As a rule of thumb, start by looking at the shortest exposure times (typically 5 to 30 seconds). If the peak 
heights from each exposure have similar values, then there is likely no signal burnout. If the peak height 
decreases significantly during those early exposure times, this is an indication of potential signal burn-
out. Another hallmark of signal burnout is peaks developing shoulders and eventually splitting as expo-
sure time increases.

If you experience burnout, the first thing to do is to reduce the signal level by lowering the sample con-
centration in the assay. We do not recommend lowering the primary or secondary antibody concentra-
tion. Keeping the primary antibody concentration at saturation conditions keeps your assay linear and 
reproducible. 

The image below shows a chemiluminescence detection example where the peak height from 5 to 30 
seconds declines significantly and it is split in two peaks by 30 seconds. In this case we would recom-
mend that you start by lowering the sample concentration.
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• Grid Lines - Checking this box will display grid lines in the graph area. 
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Independent Probe Scales (RePlex Assays Only)

Checking this option displays Probe 1 and Probe 2 data using the same detection channel on independent 
y-axis scales. The Probe 1 y-axis will display on the left and the Probe 2 y-axis will display on the right. Y-axis 
labels will indicate P1 and/or P2. The following example show the graph display with the Independent Probe 
Scales off (top) and on (bottom).

NOTE: When more than one channel is used for Probe 1, all data for a channel is displayed on the same y-
axis when viewing three or more channels.
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Plot Labels

You can customize the plot labels displayed on the electropherogram with these options. 

Plot labels are shown on the right side of the graph pane. 

• Sample - Checking this box will display the sample name. If sample names were entered in the assay 
template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.

• Primary - Checking this box will display the primary antibody name. If primary antibody names were 
entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default 
name) will display. 

• Capillary - Checking this box will display the cycle and capillary number. For example, C1:3 indicates 
cycle 1, capillary 3. 

• Attributes - Checking this box will display attribute text. If attribute information was entered for sam-
ples or primary antibodies in the assay template (Assay screen), they can be selected as plot labels.

• Exposure - Checking this box will display the exposure time(s) used for the data.

The following example shows an electropherogram with all plot labels selected: 
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Selecting Data Viewing Options 

The graph view menu provides you with multiple options for changing what type of electropherogram data 
is displayed. To access the view menu, click the down arrow next to the graph pane toolbar:

A check mark next to the menu option indicates it is currently selected. Multiple options can be selected at a 
time.

NOTE: Unless otherwise noted, graph view menu options are available for sample data only. 
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• Sample - Clicking this option will display raw, uncorrected sample data. 

• Sample Baseline Corrected - Clicking this option will display sample data with the baseline sub-
tracted (zeroed). This is the default view. 
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• Baseline Fit - Clicking this option will display the calculated baseline for the raw sample data. In the 
example that follows, both Baseline fit and Sample are selected.

NOTE: This option is selected automatically when Baseline Fit is selected in graph options. 

• Baseline Points - Clicking this option will display regions of the electropherogram considered to be 
at baseline. In the example that follows, both Baseline Points and Sample are selected.
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NOTE: This option is selected automatically when Baseline Fit is selected in graph options.

• Fit - Clicking this option will display the bounding envelope of the fitted peaks as calculated by the 
software for the raw sample data. In the example that follows, both Fit and Sample are selected.
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• Fit Baseline Corrected - Clicking this option will display the fitted peaks as calculated by the soft-
ware for the sample baseline corrected data. In the example that follows, both Fit Baseline Corrected 
and Sample are selected, the fit plot is on the bottom.

NOTE: When viewing standards or registration data, this option is called Standards Fluorescence or Regis-
tration Fluorescence, respectively. 
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• Standards - Checking this box aligns the molecular weight of the raw standards data to the sample 
data and overlays both electropherograms in the graph pane.

Adding and Removing Baseline Points

Points in the baseline can be added or removed as needed. To do this:

1. Click the Graph Options button in the graph pane toolbar and check Baseline Fit. This will display 
baseline points for the raw sample data. 

2. Use the mouse to draw a box around the area you want to correct. This will zoom in on the area. 
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3. Right click a baseline point and click Add Baseline Point or Remove Baseline Point.

NOTE: To clear the manual addition or removal of baseline points and go back to the original view of the 
data, right click in the electropherogram and click Clear All.

Selecting the X-Axis Molecular Weight Range

The molecular weight range used for the x-axis can be changed. To do this, Select View in the main menu 
and click View Region. The following pop-up window will display:
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• Selecting Analysis will match the range of the run data that was selected in the Peak Fit Analysis Set-
tings in both the electropherogram and virtual blot view. 

• Selecting Full will display the range of the run data for the entire capillary in both the electrophero-
gram and virtual blot view. (Insert View region Full)

• Selecting Custom allows you to manually enter the Lower and Upper ranges of the run data to be 
displayed in both the electropherogram and virtual blot view.(Insert View region Custom)
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NOTE: You can change the default x-axis range that Compass for Simple Western uses. For more informa-
tion, see “Normalization (Jess only)” on page 297.

Closing Run Files
If more than one run file is open, you can close just one file or all the open files at the same time. 

• To close one of multiple open run files - In the experiment pane, click on one of the sample rows in 
the file. Next click File from the main menu and click Close. 

• To close all open run files - Select File from the main menu and click Close All. 
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Analysis Settings Overview
Compass for Simple Western has a variety of analysis features and settings that you can modify as needed to 
enhance run data. 

To access the analysis settings, select Edit in the main menu and click Analysis. If more than one run file is 
open, select the run file you want to view analysis settings for from the list:

The following screen will display: 
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To move between analysis pages in this window, click on an option in the list on the left. The following anal-
ysis settings can be user-customized in Compass for Simple Western:

• Standards - Lets you customize the positions Compass for Simple Western uses to identify fluores-
cent standards and registration peaks.

• Ladders - Lets you customize the molecular weight Compass for Simple Western uses to identify 
molecular weight ladder(s), as well as change the capillary used.

• Images - Lets you view the chemiluminescent exposures taken during the run and view data for dif-
ferent exposures in the Analysis screen.

• Normalization (Jess only) - Lets you change the reference capillary used for protein normalization 
calculations and define region for normalization area. 

• Peak Names - Lets you enter custom naming settings for sample proteins associated with specific 
blocking reagents, primary antibodies or attributes and have Compass for Simple Western automati-
cally label the peaks in the run data. 

• Peak Fit - Lets you customize peak fit settings for sample data.

• Lane Contrast - Lets you enter custom contrast settings for detection channels in Lane View.

Images Analysis Settings
The Images settings in the Analysis window lets you see what Detection Profile was selected, what expo-
sures were taken during the run, and view data for different exposures in the Analysis screen. To access these 
settings, select Edit in the main menu and click Analysis, then click Images in the options list. 

NOTES:  
If you’re using Compass for Simple Western v3.1 or higher, High Dynamic Range is the default setting. 
 
If the run was performed with HDR unchecked, the data can still be analyzed with the improved HDR 
algorithm by selecting High Dynamic range from the drop down menu. For Jess/Wes runs, the increase in 
dynamic range will not be as noticeable since the substrate refresh was not performed.
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NOTE: The Images pane will only list the channels of data that are present in the run data file.

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 331. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 331. 

• Click Apply to see effects of changes before saving.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Exposure Settings

The exposure used for the sample data displayed in the Analysis screen is shown below for a standard che-
miluminescent Immunoassay with Protein Normalization and for a RePlex Assay (Jess only) with two chemi-
luminescent Immunoassays: 
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Even when the exposures for HDR are set and can’t be edited from the assay protocol, here you can choose 
to view each one separately including High Dynamic Range (HDR multi-image). 

NOTE: Sally Sue and Peggy Sue run up to eight cycles (12 capillaries per cycle). The individual exposure set-
ting selected for a specific cycle is applied for all 12 capillaries in that cycle unless selected for All cycles. 

• Multi-Image Analysis - Sample data displayed in the Analysis screen is compiled from all exposures 
taken during the run. The Multi-Image analysis allows you to keep using exactly the same settings as 
before, which is calculated using the algorithm in versions of Compass for Simple Wester v3.0 or 
Compass v2.7 or earlier. This is provided for backward compatibility and direct comparison to older 
data sets, but the HDR method is preferred for all new analyses.

• High Dynamic Range - The HDR method uses information from multiple exposures to achieve good 
signal-to-noise for low protein concentration while simultaneously maintaining signal monotonicity 
at high protein concentration (i.e. avoiding “burnout”).

• High Dynamic Range 4.0 - Algorithm improvements were made to the original High Dynamic 
Range analysis in HDR 4.0 to handle a wider range of burnout cases. HDR 4.0 is less sensitive to the 
level at which burnout occurs. When burnout occurred at a low level, the classical HDR method had 
trouble picking the optimal exposure and interpolating between exposures.
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• Exposure # - Sample data displayed in the Analysis screen is for this specific exposure only. 
 
To see the number of exposures and exposure times used for the run data, click the arrow in the drop 
down list next to All. 

NOTE: The number of exposures taken and exposure times shown were specified in the assay protocol 
(Assay screen) prior to executing the run and cannot be modified. 

Changing the Sample Data Exposure Displayed

The exposure used for the sample data displayed in the Analysis screen can be changed. To do this:

1. Select Edit in the main menu and click Analysis, then click Images in the options list.

2. Click the arrow in the drop down list next to All and select an exposure setting:

3. Click Apply and then click OK to save changes and exit. Sample data for the exposure selected will dis-
play in the Analysis screen.
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Normalization (Jess only)
The Normalization settings in the Analysis window lets you view and change the reference capillary used for 
protein normalization calculations, and adjust the control area and size region for determining the normal-
ization area. Normalization settings are applicable when using the Protein Normalization Module or when 
enabling the Total Protein feature for RePlex Assays. To access these settings, select Edit in the main menu 
and click Analysis, then click Normalization in the options list. 

NOTES:  
For Jess runs that include Protein Normalization or RePlex Total Protein assays, the default Reference Cap-
illary is set to 2.  
 
The Enable checkbox is selected by default and must stay selected to normalize immunoassay targets. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 331. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 331. 
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• Click Apply to see effects of changes before saving.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

NOTE: If you deselect the Enable checkbox in the Normalization settings, only Protein Normalization total 
protein values will display, immunoassay target data won’t be normalized.

To use the Protein Normalization fluorescence signal or RePlex Total Protein chemiluminescent sig-
nal from a reference capillary for protein normalization: Click the Reference Capillary drop down menu 
and select the capillary you’d like to use as the normalization control to normalize all other capillaries against. 
ProteinSimple recommends choosing the capillary that had the highest sample concentration. The default 
reference capillary is 2.

To manually assign a reference signal for protein normalization: Select the Control Area box and enter 
a signal value. This setting is helpful when you want to use the average signal from more than one capillary 
for normalization. 
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To change the sizing region that the normalization total area is determined: Enter new kDa values in 
the Area Start and Area End boxes.

Click Apply and then click OK to save changes and exit. Updated sample data using the new normalization 
settings will display in the Analysis screen.

Peak Fit Analysis Settings
The peak fit analysis settings page lets you view and change peak fit settings for sample data. To access 
these settings, select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 
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NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 331. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 331. 

• Click Apply and then click OK to save changes and exit.

• Click Cancel to exit without saving changes.
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Range Settings

• Minimum - The molecular weight value (in kDa) below which peaks will not be identified. This value 
will also be used as the default lower MW range for the data displayed in the electropherogram and 
virtual blot. 

• Maximum: The molecular weight value (in kDa) above which peaks will not be identified. This value 
will also be used as the default upper MW range for the data displayed in the electropherogram and 
virtual blot.

Baseline Settings

• Threshold - The variance, or roughness, in a baseline data segment below which a point will be 
called part of the baseline.

• Window - How long baseline data segments are expected to be in pixels. Shorter segments will allow 
the baseline to follow plateau sections of the signal.

• Stiffness - The amount the baseline is allowed to vary from a straight line. Settings between 0.1 and 
1.0 make the baseline fit closer to a straight line. Settings from 1.0 to 10.0 will make the baseline fit fol-
low the data more closely.

Peak Find Settings

• Threshold - The minimum signal to noise ratio required for a peak to be identified. A setting of 1.0 will 
detect many peaks, a setting of 10.0 will detect fewer peaks.

• Width - The approximate peak width (at full width half max) in pixels used to detect peaks. The mini-
mum value for this setting is 3.0. Larger widths help to eliminate the detection of shoulder peaks and 
noise peaks.

• Area Calculation - Two fits are used, either Gaussian Fit or Dropped Lines. These settings can be 
changed before or after the run is finished.

• For Immunoassays, peak area is calculated using Gaussian distribution by default: 
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• For Total Protein Assays, peak area is calculated using Dropped Lines. This type of area calculation 
is also often called the perpendicular drop method. This method is preferred when peaks overlap 
or are close to each other as they are in Total Protein Assays. This method draws two vertical lines 
from the left and right bounds of the peak down to the x-axis and then measures the total area 
bounded by the signal curve, the x-axis (y=0 line), and the two vertical lines. 

Peak Fit Analysis Settings Groups

Peak fit settings are saved as a group, and multiple settings groups can be created. Specific group settings 
can then be applied to individual capillaries, sample names or attributes in the run data.
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NOTES:  
We recommend using the Compass for Simple Western default values for peak fit analysis settings. These 
settings are included in the default Peak Fit group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 331.

Peak fit groups are displayed in the analysis settings box:

The Peak Fit group shown contains the Compass for Simple Western default analysis settings. You can make 
changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box. 

Creating a New Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click Add under the analysis settings box. A new group will be created:

3. Click on the new group and enter a new name.
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4. Modify range, baseline or peak find parameters as needed. 

5. To use the new group as the default peak fit settings for the run file data, click the arrow in the drop 
down list next to Default, then click the new group from the list. Peak fit settings in the new group will 
then be applied to the run data. 

6. Click Apply and then click OK to save changes. 

Changing the Default Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click the arrow in the drop down list next to Default, then click a new default group from the list.
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3. Click Apply and then click OK to save changes. Peak fit settings in the group selected will be applied to 
the run data. 

Modifying a Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to modify. 

3. Modify range, baseline or peak find parameters as needed. 

4. Click Apply and then click OK to save changes. The new peak fit settings will be applied to the run data.

Deleting a Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to delete and click Remove. 
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3. Click OK to save changes. 

Applying Peak Fit Groups to Specific Run Data

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to apply to specific run data.

3. Application of peak fit groups to specific run data is done in the override box. Click Add under the over-
ride box. A default override data set will be created from sample information found in the run file. 

4. Click the cell in the Apply To column, then click the down arrow. 
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5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• Sample names - All sample names entered in the assay template (Assay screen) will display in 
the drop down list, otherwise the default name of Sample will be shown. Select a sample name 
to apply group settings to all capillaries that use this sample name in the run file. 

• Attributes - All sample attributes entered in the assay template (Assay screen) will display in the 
drop down list. Select an attribute to apply group settings to all capillaries that use this attribute 
in the run file.

• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Probe (RePlex Assays only) - Select a probe to apply Peak Fit group settings to all capillaries 
within that probe.

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the peak fit group used for a data set, click the cell in the Settings column and 
click the down arrow. Select a group from the drop down list.
Compass for Simple Western User Guide



page 308 Chapter 9: Size Assay Data Analysis
7. Repeat the previous steps to apply other groups to specific run data. 

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click Apply and then click OK to save changes.

Peak Names Settings
The peak names analysis settings page lets you enter custom naming settings for sample proteins. Compass 
for Simple Western can automatically label sample peaks in the run data associated with specific blocking 
reagent names, primary antibody names or attributes. To access these settings, select Edit in the main menu 
and click Analysis, then click Peak Names in the options list. 
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NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 331. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 331. 

• Click Apply and then click OK to save changes and exit.

• Click Cancel to exit without saving changes.
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Peak Names Analysis Groups

Peak name settings are saved as a group, and multiple settings groups can be created. Specific group set-
tings can then be applied to individual capillaries, blocking reagent names or primary antibody names and 
attributes in the run data.

NOTE: Analysis settings are run-file specific. However, settings can be imported or exported for use with 
other run files. For more information see “Importing and Exporting Analysis Settings” on page 331.

Peak name groups are displayed in the analysis groups box:

The Peak Names group shown is a Compass for Simple Western template group. You can make changes to 
this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box. 

Creating a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the Protein template group in the analysis group box. 

3. Enter a new name for the group.

4. Click in the first cell in the Name column in the analysis groups peak table. 

5. Enter a sample protein name associated with the primary antibody used in the run.
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6. Click in the first cell in the MW column. 

7. Enter the molecular weight (in kDa) for the sample protein.

8. Click in the first cell in the Color column, then click the button.

The color selection box will display:
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The color selected will be used to identify the sample protein peak in the peaks and capillaries table in 
the Analysis screen. 

9. Click a color or define a custom color and click OK. The color selection will update in the table: 

10. Click in the first cell in the Range (%) column. 

11. Enter a range window for the MW entered. Compass for Simple Western will automatically name peaks 
found within this percent of the molecular weight. For example, if the molecular weight entered is 40 
kDa and a 10% range is used, all peaks between 36 and 44 kDa will be identified with this peak name. 

NOTE: The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein 
Assay in Compass for Simple Western may vary from apparent molecular weights using other techniques 
and based on sample and assay conditions.

Adding Peak Names Groups

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click Add under the Analysis Groups box. A new group will be created:
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3. Click on the new group and enter a new name.

4. Enter information in the Analysis Groups peak table as described in “Creating a Peak Names Group” on 
page 310. 

5. Click Apply and then click OK to save changes. 

Modifying a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the group in the Analysis Groups box you want to modify. 

3. Change the information in the Analysis Groups peak table as described in “Creating a Peak Names 
Group” on page 310. 

4. Click Apply and then click OK to save changes.

Deleting a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the group in the Analysis Groups box you want to delete and click Remove. 

3. Click Apply and then click OK to save changes. 

Applying Peak Names Groups to Run Data

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 
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2. Click on the group in the Analysis Groups box you want to apply to specific run data.

3. Application of peak names groups to specific run data is done in the override box. Click Add under the 
override box. A default override data set will be created. 

4. Click the cell in the Apply To column, then click the down arrow. 

5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• All - When this option is selected, peak names group settings will be applied to all capillaries in 
the run file.
Compass for Simple Western User Guide



Peak Names Settings page 315
• Blocking reagent - When this option is selected, group settings will be applied to all capillaries 
that use this reagent name in the run file. 

• Antibody names - All primary and secondary antibody names entered in the assay template 
(Assay screen) will display in the drop down list, otherwise the default name of Primary will be 
shown. Select a name to apply group settings to all capillaries that use the primary antibody 
name in the run file. 

• Attributes - All primary and secondary antibody attributes entered in the assay template (Assay 
screen) will display in the drop down list. Select an attribute to apply group settings to all capillar-
ies that use this attribute in the run file.

• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Probe (RePlex Assays only) - Select a probe to apply group settings to all capillaries within that 
probe.

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the peak names group used for a data set, click the cell in the Settings column 
and click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data. 
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8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click Apply and then click OK to save changes. Named peaks will be identified with a peak name label 
in the electropherogram and virtual blot, and will be color coded in the peaks and capillaries tables: 

Standard Curve Settings
To use a standard curve to quantitate the concentration of a target protein detected either by an 
Immunoassay or a Total Protein Assay, first create peak names groups as described earlier for your standard 
curve protein and the target protein. In the example below, GST-AKT1 is the standard curve protein and 
AKT1 is the target protein.

NOTE: Analysis settings are run file-specific. However, settings can be imported or exported for use with 
other run files. For more information see “Importing and Exporting Analysis Settings” on page 331.
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To set up a standard curve:

1. Click Standard Curves from the Peak Name submenu options.
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2. From the Peak drop down list, select the peak name for your standard curve protein.

3. Choose either a Linear or 4 Parameter (4PL) curve fit from the Fit drop down list.

4. To add another concentration, click Add under the Standard Curve table.

5. Repeat the previous steps to enter information for other concentrations. In the following example, four 
concentrations were entered:
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To remove a concentration, select its row and click Remove.

6. Enter the concentration units in the box (for example, pg/μL).

7. Click OK to save changes.

Applying Peak Names Groups to Run Standard Curve

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list.

2. Click on the group in the analysis settings box you want to apply to specific run data.
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3. Application of peak names groups to specific run data is done in the override box. Click Add under the 
override box. A default override data set will be created.

4. Click the cell in the Apply To column, then click the down arrow.

5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

a. All - When this option is selected, peak names group settings will be applied to all capillaries in the 
run file.

b. Blocking reagent - When this option is selected, group settings will be applied to all capillaries that 
use this reagent name in the run file.

c. Primary antibody names - All primary antibody names entered in the assay template (Assay 
screen) will display in the drop down list, otherwise the default name of Primary will be shown. 
Select a name to apply group settings to all capillaries that use the primary antibody name in the run 
file.

d. Attributes - All primary antibody attributes entered in the assay template (Assay screen) will dis- 
play in the drop down list. Select an attribute to apply group settings to all capillaries that use this 
attribute in the run file.

e. Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the cycle.

f. Probe (RePlex Assays only) - Select a probe to apply group settings to all capillaries within that 
probe.

g. Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number or 
range of capillaries:
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6. If you need to change the peak names group used for a data set, click the cell in the Settings column 
and click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data.

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click Apply and then click OK to save changes. The curve fit will be visible on the Std Curve tab and the 
concentration of the proteins will appear in the Peaks table:
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System or Loading Control Settings
It is possible to use a system or loading control protein to normalize data between capillaries, between runs 
and between instruments. First create peak names groups as described earlier for your control protein and 
the target protein. In the example below, System Control is the control protein and ERK1 is the target pro-
tein.

NOTE: Analysis settings are run file-specific. However, settings can be imported or exported for use with 
other run files. For more information see “Importing and Exporting Analysis Settings” on page 331.
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To identify the control protein:

1. Click Peak Names and select Loading Controls.

2. Select a Reference Capillary from the pull-down menu. The peak area of this capillary will be used to 
normalize the peak area of the named peaks. For RePlex assays (Jess only), the user can specify which 
probe to use as the reference, Probe 1 or Probe 2. All named peaks in both Probe 1 and Probe 2 will be 
normalized to the reference.

3. To manually assign the Control Area, click the box and enter the peak area of your control protein.

4. Click Apply and then click OK to save changes. Compass for Simple Western will automatically normal-
ize the peak area of the target protein against the control protein. The corrected area appears in the 
Corr. Area column in the Peaks table and in the Capillaries table:
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Standards Settings
The standards analysis settings page lets you view and change the position for fluorescent standards and set 
the registration peaks. To access this setting, select Edit in the main menu and click Analysis, then click 
Standards in the options list. The default standard settings for the 12-230 kDa, 66-440 kDa and 2-40 kDa size 
ranges are shown in the following example:
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• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 331. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 331. 

• Click Apply and then click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Standards Analysis Settings Groups

Standards settings are saved as a group, and multiple settings groups can be created. Specific group settings 
can then be applied to individual capillaries, sample names or attributes in the run data.
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Ladders Settings

The ladders analysis settings page lets you view and change the molecular weight and position for the lad-
der and change the capillary and channel/probe (Jess only) used for it. To access these settings, select Edit in 
the main menu and click Analysis, then click Ladders in the options list. 

For RePlex Assays (Jess only), select the ladder in Probe 1 or Probe 2, depending on the assay setup.

NOTE: Probe selection is not available with RePlex Assays that include Total Protein.

The default standard settings for the 12-230 kDa size range is shown in the following example for a standard 
Immunoassay and a RePlex Assay (Jess only): 
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NOTES:  
Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished exe-
cuting. Analysis changes made to an executing run will not be saved to the final run file.  
 
We recommend using the Compass for Simple Western default values for standards and ladders analysis 
settings. These settings are included in the default Standards and ladders group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 331.

Changing the Capillary Used for the Ladder

Known ladders are used to calculate the molecular weights of unknown sample proteins. As noted in each 
of the Master Kit Product Inserts, we strongly recommend that you use capillary 1 for the ladder. However, 
you can change the ladder capillary as needed, or opt to not use a ladder at all. 

NOTES:  
When the ladder capillary is set to none, fluorescent standards information is used to calculate sample 
protein molecular weight instead of the ladder.  
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and 
based on sample and assay conditions.

To change the ladder capillary:

1. Select Edit in the main menu and click Analysis, then click Ladders in the options list. 

2. Click the arrow in the drop down list next to Capillary, then click a capillary number or none from the list. 
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Compass for Simple Western will use the data in the selected capillary to recalculate molecular weights 
for sample proteins in the run data using the information in the ladder table. If none is selected, Com-
pass for Simple Western will instead use the information in the fluorescent peaks table (fluorescent stan-
dards) to calculate molecular weight for sample proteins. 

NOTES:  
When the ladder capillary is set to none, the ladder table becomes inactive and cannot be modified.  
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights based on other techniques as 
well as sample and assay conditions.

Creating a New Standard

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click Add under the analysis settings box. A new MW will be added.
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3. Click in the first cell in the MW column in the Fluorescent Peaks table. 

4. Enter the molecular weight (in kDa) for the fluorescent standard.

5. Click in the first cell in the Position column. 

6. Enter the position of the fluorescent standard peak.

NOTE: Standards peak positions are relative to each other. Only the difference in their position is used to 
help identify the standard peaks. When entering standard peak information for the first time, review the 
standards data in the Analysis screen to find the correct peak position.

7. Repeat the steps above for the remaining standards in the table. 

8. Select which standards should be used for molecular weight determination of sample proteins by click-
ing the checkbox in the Fit column. 

Creating a New Ladder

1. Select Edit in the main menu and click Analysis, then click Ladders in the options list. 

2. Click the arrow in the drop down list next to Capillary, then click a capillary number or none from the list. 
Capillary 1 is typically used for the ladder. 
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Compass for Simple Western will use the data in the selected capillary to calculate the molecular 
weights for sample proteins using the information in the ladder table. If none is selected, Compass for 
Simple Western will instead use the information in the fluorescent peaks table (fluorescent standards) to 
calculate molecular weight for sample proteins. 

NOTES:  
When the ladder capillary is set to none, the ladder table becomes inactive and cannot be modified.  
 
The reported molecular weight for sample proteins detected by an Immunoassay or a Total Protein Assay 
in Compass for Simple Western may vary from apparent molecular weights using other techniques and 
based on sample and assay conditions.

3. If a ladder capillary was selected, click in the first cell in the MW column in the ladder table. Enter the 
molecular weight (in kDa) for the ladder standard.
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4. Repeat the steps above for the remaining ladder MW values in the table. 

5. Click Apply and then click OK to save changes. 

Importing and Exporting Analysis Settings
The analysis settings in a run file can be exported as a separate file. This allows the same analysis settings to 
be imported into other assays or run files at a later time, rather than having to re-enter settings manually. 

Importing Analysis Settings

NOTE: Importing an analysis settings file populates the settings in all Analysis pages. 

1. Open the run file or assay you want to import analysis settings to.

2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).

3. Click Import on any page.

4. Select a settings file (*.settings) and click OK. The imported settings will display in all analysis pages. 

Exporting Analysis Settings

NOTE: Exporting an analysis settings file exports the settings in all Analysis pages. 

1. Open the run file or assay you want to export analysis settings from.

2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).
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3. Click Export on any page. The following window displays:

4. The default directory is Compass/Assays. Change the directory if needed.

5. Enter a file name and click Save. The settings will be saved as a *.settings file.
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Chapter 10:  
Charge Assay Data Analysis

Chapter Overview
• Analysis Screen Overview

• Opening Run Files

• How Run Data is Displayed in the Analysis Screen

• Viewing Run Data

• Run Data Notifications and Warnings

• Checking Your Results

• Group Statistics

• Copying Data Views and Results Tables

• Exporting Run Files

• Running Reports

• Changing Sample Protein Identification

• Changing the Virtual Blot View

• Changing the Electropherogram View

• Closing Run Files

• Analysis Settings Overview

• Advanced Analysis Settings

• Images Analysis Settings

• Peak Fit Analysis Settings
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• Peak Names Settings

• Standards Settings

• Importing and Exporting Analysis Settings
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Analysis Screen Overview
The Analysis screen is used to view run data including electropherograms, capillary images, lane view data 
and tabulated results. Any post-run analysis is also done in this screen. To access this screen, click Analysis in 
the screen tab: 

Analysis Screen Panes

The Analysis screen has six panes, each displays the following data for up to 96 capillaries per experimental 
run:

• Experiment - Lists the assay protocol steps and assay template information.

• Graph - Displays electropherogram data for immunodetected sample proteins, fluorescent standards 
or capillary registrations.

• Image - Displays a 12-capillary image of the separated immunodetected sample proteins, fluores-
cent standards or capillary registrations.

• Lane - Displays data for immunodetected sample proteins, fluorescent standards or capillary registra-
tions as bands in individual lanes. This virtual blot-like image is similar to traditional blot results.

• Peaks - Lists the tabulated results for immunodetected sample proteins and information for identi-
fied fluorescent standards and capillary registrations.

• Capillaries - Displays a list of the immunodetected sample proteins Compass for Simple Western 
named automatically using the user-defined peak name analysis parameters.
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NOTE: The reported pI for immunodetected sample proteins in Compass for Simple Western may vary 
slightly from predicted pIs based on sample, buffer and assay conditions.
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Software Menus Active in the Analysis Screen

The following software menus are available:

• File

• Edit

• View

• Instrument (when Compass for Simple Western is connected to Peggy Sue)

• Window

• Help

The File, Edit and View menu options specific to the Analysis screen are described next.

File Menu

The following File menu options are active:

• Open Run - Opens a run file.

• Add Run - Opens and views other run files in addition to those that are already open.

• Close - Closes the run file currently being viewed. 

• Close All - Closes all open run files.

• Save - Saves changes to the open run file.

• Save As - Saves changes to the open run file under a different file name. 

• Export Tables - Exports the results for all capillaries in the run in .txt format.

• Export Spectra - Exports the raw data traces for each capillary in the run in .txt or .cdf format.

• Run Report - Creates a report of the run in .pdf format.

• Exit - Closes Compass for Simple Western.
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Edit Menu

The following Edit menu options are active: 

• Copy - Lets you copy data shown in the graph, lane, peaks or capillaries panes. See “Copying Data 
Views and Results Tables” on page 381 for more information. 

• Analysis - Displays the analysis settings used to analyze the run data and lets you change them as 
needed. See “Analysis Settings Overview” on page 422 for more information. 

• Preferences - Lets you set and save custom preferences for data export, plot colors in the graph and 
Peggy Sue’s Twitter settings. See Chapter 11, “Setting Your Preferences“ for more information.

View Menu

The following View menu options are active: 

• Selected View - Displays data in a per capillary (single) view format.

• All View - Displays data in a per 12-capillary (multiple) view format.

• Standards - Lets you change the data view to show only the fluorescent standards. 

• Registration - Lets you change the data view to show only the capillary registrations.

• Samples - Lets you change the data view to show only immunodetected sample proteins. 

• Grouping - Lets you analyze replicates by calculating the mean, standard deviation and CV of named 
proteins.

• Filter - Lets you display data only for specific capillaries or named proteins. 
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• View Region - Lets you change the pI (x-axis) range of the data displayed. 

• Show Hidden- Shows capillaries that are hidden from the data view.

Opening Run Files
You can open one or multiple run files at a time to compare data between runs.

Opening One Run File

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass 
for Simple Western first, then open the file.

1. Select File in the main menu and click Open Run.

2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

Opening Multiple Run Files

NOTE: If you need to open a run file when another run is executing, launch another instance of Compass 
for Simple Western first, then open the file.

1. To open the first run file, select File in the main menu and click Open Run.
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2. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. 

3. To open another run file, select File in the main menu and click Add Run. 

4. A list of the last 10 runs opened will display. Select one of these runs or click Browse to open the Runs 
folder and select a different file. When a run is added, its data will append to the open run file, and will 
display as a second set of up to 96 capillaries in all screen panes. The second run file name will also 
appear in the Compass title bar: 
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5. Repeat the last two steps to open additional runs. 
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How Run Data is Displayed in the Analysis Screen
Data in the run file is compartmentalized for easy review in one of six panes in the Analysis screen.

Experiment Pane: Assay and Capillary Information 

The experiment pane displays assay and capillary information for each of the 96 capillaries in the run. A maxi-
mized view of the experiment pane is shown below. 

• To view all columns - Click the Experiment tab, then use the scroll bar or click Maximize in the 
upper right corner. 

• To resize columns - Click the Experiment tab. Roll the mouse over a column border until the sizing 
arrow appears, then click and drag to resize. 

Experiment pane column descriptions for the Peggy Sue Charge default assay are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

NOTE: Data notification icons will display in the sample column if Compass for Simple Western detected a 
potential analysis issue or data was manually modified by the user. For more information see “Run Data 
Notifications and Warnings” on page 365. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Primary (default name) will display. 

• Cycle - Run cycle number. There are 12 capillaries in one cycle. 
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NOTE: Peggy Sue can run up to eight cycles (12 capillaries per cycle) in an experiment. Each cycle is desig-
nated in the Experiment summary.

• Cap - Capillary number.

• S - Well on the assay plate used for sample. 

• 1 - Well on the assay plate used for primary antibody.

• 2 - Well on the assay plate used for secondary antibody.

• 3 - Well on the assay plate used for tertiary antibody (if used).

Graph Pane: Electropherogram Data

Click the Graph tab to view data for immunodetected sample proteins, fluorescent standards or capillary 
registrations. Data for samples is shown in the following example, and immunodetected proteins are dis-
played as peaks: 

More Graph view options will be described in more detail in “Changing the Electropherogram View” on 
page 400.
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Image Pane: Capillary Separation Image Data

Click the Image tab to view final separation images of immunodetected sample proteins, fluorescent stan-
dards or capillary registrations for up to 96 capillaries per experimental run. Image data for samples is shown 
in the following example: 
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Lane Pane: Virtual Blot-Like Image Data

Click the Lane tab to view data for immunodetected sample proteins, fluorescent standards or capillary reg-
istrations as bands in individual lanes. This virtual blot-like image is similar to traditional blot results. Data for 
samples in the lane view is shown in the following example, and immunodetected proteins are displayed as 
bands. 

To view information for a band, roll the mouse over a band until the info box appears. 

NOTE: The reported pI for immunodetected sample proteins in Compass for Simple Western may vary 
slightly from predicted pIs based on sample, buffer and assay conditions.

Lane data displayed in the virtual blot is automatically aligned by Compass for Simple Western. To view raw, 
unaligned lane data and learn more about virtual blot viewing options, see “Changing the Virtual Blot View” 
on page 394.
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Peaks Pane: Calculated Results

Click the Peaks tab to view tabulated results for immunodetected sample proteins, fluorescent standards or 
capillary registrations. Each row in the table shows the individual results for each peak detected in each cap-
illary. Data for samples in the peaks table is shown in the following example: 

NOTES:  
Peaks that Compass for Simple Western names automatically using the user-defined peak name analysis 
parameters are color-coded. 
 
The reported pI for immunodetected sample proteins in Compass for Simple Western may vary slightly 
from predicted pIs based on sample, buffer and assay conditions.

• To view all rows - Click the Peaks tab, then use the scroll bar or click Maximize in the upper right 
corner. 

• To resize columns - Click the Peaks tab. Roll the mouse over a column border until the sizing arrow 
appears, then click and drag to resize. 

Peak table column descriptions are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Primary (default name) will display. 

• Cap - Cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 3.

NOTE: Peggy Sue runs up to eight cycles in an experiment, 12 capillaries at a time. Capillary and cycle 
numbers are displayed in the Experiment tab.

• Peak - Peak number. Peaks are numbered in order of detection. 
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• Name - Peak name. Displays peaks that Compass for Simple Western named automatically using the 
user-defined peak name analysis parameters. Cells will be blank if Compass for Simple Western was 
not able to name the peak or if naming parameters were not entered.

• Position - Displays the pixel position of a peak in the image.

• pI - Displays the calculated pI for the peak. 

• Height - Displays the calculated peak height.

• Area - Displays the calculated peak area.

• % Area - Displays the calculated percent area for the named peak compared to all named peaks. This 
value results from dividing the individual peak area by the sum of all named peak areas for the capil-
lary and multiplying by 100 (shown for named peak sample data only).

• Width - Displays the calculated peak width (shown for sample data only).

• S/N - Displays the calculated signal to noise ratio for the peak. Please note this calculation is based on 
a peak finding algorithm to provide a relative ratio comparing all peaks within the electropherogram 
in Compass. 

Capillaries Pane: User-Specified Peak Names

Click the Capillaries tab to view tabulated results for sample proteins associated with specific primary anti-
bodies in the run data. Compass for Simple Western labels these sample peaks automatically using user-
defined peak name settings. Each row in the table shows the individual results for the named peaks 
detected in each capillary. Data for samples in the capillaries table is shown in the following example. 

NOTES:  
Peaks that Compass for Simple Western names automatically with user-defined peak name settings are 
color-coded. 
 
Information displayed for fluorescent standards and capillary registration data will be for identified stan-
dards or registration peaks.
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• To view all rows - Click the Capillaries tab, then use the scroll bar or click Maximize in the upper 
right corner. 

• To resize columns - Click the Capillaries tab. Roll the mouse over a column border until the sizing 
arrow appears, then click and drag to resize. 

Capillaries table column descriptions are as follows: 

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template (Assay 
screen), those names will display here. Otherwise, Primary (default name) will display. 

• Capillary - Cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 3.

NOTE: Peggy Sue runs12 capillaries at a time in a cycle and is able to run up to eight cycles in an experi-
ment. The Information on cycle and capillary number is displayed in the Experiment tab.

• Peak Name Columns - An individual column per peak name will display for every peak identified by 
name in the run data. Cells for capillaries in these columns will be blank if Compass for Simple West-
ern did not find peaks automatically using the user-defined peak name analysis parameters (or none 
were entered).

• To view % area in the peak name columns - Select % in the upper right corner of the pane. 
This displays the calculated percent area for the named peak compared to all named peaks. This 
value results from dividing the individual peak area by the sum of all named peak areas for the 
capillary and multiplying by 100.

• To view peak area in the peak name columns (default) - Deselect % in the upper right corner 
of the pane. This displays calculated peak area for the individual peak only. 
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Viewing Run Data
Each run file contains the following data for up to 96 capillaries:

• Sample data - For the immunodetected proteins in the sample.

• Standards data - For the fluorescent standards run with each sample.

• Registration data - For tracking capillaries as they are moved for various assay steps. 

Data can be viewed for one, all, or individually selected capillaries. 

Switching Between Sample, Standards and Registration Data Views

You can switch between viewing sample, standards and registration data in a run file using the View bar or 
View menu: 

Data buttons in the View bar: 

Show Standards

Show Registrations

Show Samples
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• To view sample data - Click Show Samples in the View bar or select View in the main menu and 
click Samples:

• Data in this view is for immunodetected sample proteins only.
• Graph view data displays electropherograms in chemiluminescence units (y-axis) and pI (x-axis). 
• Lane view data displays immunodetected sample proteins only.
• Image view data displays immunodetected sample proteins only.
• Results for each immunodetected protein are shown in the peaks and capillaries tables.

NOTE: The reported pI for immunodetected sample proteins in Compass for Simple Western may vary 
slightly from predicted pIs based on sample, buffer and assay conditions.

For information on checking and identifying sample peaks, see “Step 4 – Checking Samples” on 
page 372.
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• To view standards data - Click Show Standards in the View bar or select View in the main menu 
and click Standards:
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• Data in this view is for the fluorescent standards only. These standards are premixed with each 
sample prior to analysis. 

• Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis). 
• Lane view data displays fluorescent standards only.
• Image view data displays fluorescent standards only.
• Standards are highlighted in both the peaks and capillaries tables and marked with an S.
For information on checking and identifying standards peaks, see “Step 2 – Checking Fluorescent Sizing 
Standards” on page 367.

• To view registration data - Click Show Registrations in the View bar or select View in the main 
menu and click Registration:
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• Data in this view shows capillary registration only. 
• Graph view data displays electropherograms in fluorescence (y-axis) and position (x-axis). 
• Lane view data displays capillary registration only.
• Image view data displays capillary registration only.
• Registrations are highlighted in both the peaks and capillaries tables and marked with an R.

Because capillaries must be moved multiple times during the run, their positions are tracked to account 
for potential changes in imaging position as they are moved to and from the separation block. To do 
this, one of the standards is used as a capillary registration. An image of the standard used for registra-
tion is taken at the end of the separation step prior to chemiluminescent imaging. The position of this 
peak in the registration image is then compared to the position of the same standard peak in the stan-
dards image. The shift value listed in the peaks table is the change in pixel position between the two 
images. Compass for Simple Western data is then aligned to account for any changes in capillary posi-
tion. 

For information on checking and identifying registration peaks, see “Step 3 – Checking Capillary Regis-
trations” on page 371.
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Selecting and Displaying Capillary Data

You can choose to view data from one, multiple, or all capillaries at once.

• To look at data for one capillary - Click a row in the experiment pane. Data for just the row selected 
will display in all data views and tables. The following example shows sample data displayed in the 
lane and peaks panes when one sample is selected: 
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• To look at data for multiple non-sequential capillaries - Hold the Ctrl key and select the rows you 
want to view in the experiment pane. Data for only the rows selected will display in all data views and 
results tables. The following example shows sample data displayed in the graph (in multiple view) 
and capillaries panes when multiple rows are selected:
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• To look at data for multiple sequential capillaries - Hold the Shift key and select the first and last 
rows you want to view in the experiment pane. Data for only the selected rows will display in all data 
views and results tables. The following example shows standards data displayed in the image and 
peaks panes when multiple sequential rows are selected:
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• To look at data for all capillaries - Hold the Shift key and select the first and last rows in the experi-
ment pane. Data for all rows will display in all data views and results tables. The following example 
shows sample data displayed in the lane and peaks panes when all rows are selected. The pane scroll 
bars can be used to view all 8 cycles: 
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Switching Between Single and Multiple Views of the Capillaries

You can switch between displaying run data in the graph, image and lane panes in a per capillary (single) 
format or up to 96 capillary format. This view is selected in the View bar or the View menu. 

Capillary view buttons in the View bar: 

Selected View

All View
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• To view data in a per capillary format - Click Single View in the View bar or select View in the main 
menu and click Single View:

Data for the row(s) selected in the experiment pane will display as follows:

• Electropherograms in the graph pane display overlaid or stacked (depending on the graph 
option chosen). 

• Results for only the selected row(s) will display in the peaks and capillaries tables.
• The selected row(s) are highlighted in the image pane:
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• Lanes for only the selected row(s) are displayed in the lane pane:
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• To view data up to 96-capillary format - Click Multiple View in the View bar or select View in the 
main menu and click Multiple View:

Data for the row(s) selected in the experiment pane will display as follows:

• Electropherograms corresponding to the selected row(s) are highlighted and displayed in the 
graph pane. 

• Results for selected capillaries display in the peaks and capillaries tables and are highlighted.
• The selected row(s) are highlighted in the image pane:
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• All selected lanes display in the lane pane, and lanes corresponding to the selected row(s) are 
highlighted. 

Hiding Capillary Data

Capillary data can be hidden from view if needed. To do this:

1. Click the Experiment tab. 
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2. Select the rows you want to hide, then right click on one of the selected rows and click Hide:

Data for selected rows will be hidden in all data views and results tables (except for the image pane). 

• To view hidden rows - Select View in the main menu and click Show Hidden. Hidden rows will 
become visible again in all panes, and hidden rows will be marked with an X in the experiment pane:

• To unhide rows - Select the hidden row(s). Right click on one of the selected rows and click Unhide. 

Setting Run Data Display Filters

The filter lets you auto-hide specific capillaries in the run file data, or only show data for peaks that Compass 
for Simple Western identified automatically using the user-defined peak name analysis parameters. 

NOTE: When more than one run file is open, filter settings will be applied to all files.

• To filter data to show specific capillaries only - Select View in the main menu and click Filter. 
Uncheck the boxes for the capillaries you do not want shown, then click OK. 
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Only data for the checked capillaries will display in data views and results tables, unchecked capillaries 
will be hidden. 

• To filter data to show named peaks only - Select View in the main menu and click Filter. Select 
Show named peaks only then click OK. Only data for peaks that Compass for Simple Western identi-
fied automatically using the user-defined peak name analysis parameters will display in data views 
and results tables, all other peak data will be hidden.
Compass for Simple Western User Guide



Run Data Notifications and Warnings page 365
Run Data Notifications and Warnings
If Compass for Simple Western detects a potential data issue, a notification or warning will display next to 
the row in the experiment pane. A list of warnings, notifications and corrective actions are as follows: 

 • Manual correction of sample data notification - Indicates the user modified sample 
data manually, such as adding or removing a sample peak. Rolling the mouse over the 
icon displays the type of data modification made.

 • Standards warning - Indicates that one of the standards may not be identified prop-
erly. This can be resolved by manually identifying the standards. Please refer to “Step 2 – 
Checking Fluorescent Sizing Standards” on page 367 for details. Rolling the mouse over 
the icon displays warning details.

 • Manual correction of standards data notification - Indicates the user modified the 
standards data manually. Rolling the mouse over the icon displays the type of data 
modification made.

 • Registrations warning - Indicates that a capillary registration was not identified prop-
erly. This can be resolved by manually identifying the registration peak. Please refer to 
“Step 3 – Checking Capillary Registrations” on page 371 for details. Rolling the mouse 
over the icon displays warning details.
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Checking Your Results
Compass for Simple Western detects immunodetected proteins, fluorescent standards and capillary registra-
tions and reports results automatically with no user-interaction. However, we recommend you review their 
data as outlined in this section as good general practice to ensure accurate results. If a data warning is pre-
sented in the experiment pane, the following steps will also help you identify and correct any issues.

Step 1 – Review the Fluorescent Sizing Standards Movie

All capillaries should have three fluorescent sizing standards. To verify the standards separated in the capil-
lary correctly: 

1. When the run has completed, click the Run Summary screen tab. 

2. Click the Separation tab and play the movie (this will be the fluorescent standards separation). 

 • Manual correction of registrations notification - Indicates the user modified the 
capillary registration data manually. Rolling the mouse over the icon displays the type of 
data modification made.

 • Peak fit warning - Indicates that a peak cannot be fit properly. This is typically caused 
either by a very small peak in the electropherogram or a peak that is very close to the 
end of the pI range. This can be resolved by removing the peak. Please refer to “Step 4 – 
Checking Samples” on page 372 or “Step 4 – Checking Samples” on page 372 for details. 
Rolling the mouse over the icon displays warning details.
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3. For each capillary, verify that the standards visibly separated. Each fluorescent point in the capillary rep-
resents one of the three sizing standards. 

Step 2 – Checking Fluorescent Sizing Standards

To verify the standards are identified correctly: 

1. Click the Analysis screen tab. 

2. Click Show Standards in the View bar. Verification that the standards have been correctly identified can 
be done in either the graph or lane panes.
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Graph Pane: 

a. Click Single View in the View bar. 

b. Click on the first row in the experiment pane, then click the Graph tab. Check that the electrophero-
gram has the appropriate number of fluorescent pI standard peaks for the pI Standard Ladder you 
are using. They will also be identified with a green S in the peaks table. The pI standards at the low 
and high end of the pI range in the electropherogram are at higher concentrations as they are also 
used for capillary registration. In the following example, the pI standards shown are those for pI Stan-
dard Ladder 3 (P/N 040-646).

If standards are not identified correctly, they can be manually corrected as follows:

• If an incorrect peak is identified as a standard - Right click the peak in the electropherogram 
or peaks table and select Not a Standard. Compass for Simple Western should correctly reas-
sign the remaining peaks as standards, and update the peaks table.
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• To set an unidentified peak as a standard - Right click the peak in the electropherogram or 
peaks table and select Force Standard. Compass for Simple Western will assign the peak as a 
standard, and correctly reassign the remaining standard peaks. A lock icon indicating the stan-
dard was set manually will display next to the peak in the peaks table. 

NOTE: To remove standards peak assignments that were made manually, right click on the peak in the 
electropherogram or peaks table and click Clear. 

c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards 
are identified correctly.

Lane Pane: 

a. Click Multiple View in the View bar. 

b. Click on the first row in the experiment pane, then click the Lane tab. Standards will be bands and 
identified with a green outline. Check that each lane has the appropriate number of fluorescent pI 
standard bands for the pI Standard Ladder you are using. They will also be identified with a green S 
in the peaks table. The pI standard bands at the low and high end of the pI range in each lane will 
display greater intensity as they are at higher concentrations and are also used as registration stan-
dards. In the following example, the pI standards shown are those for pI Standard Ladder 3 (P/N 040-
646). To view band labels, roll the mouse over the individual bands. 
Compass for Simple Western User Guide



page 370 Chapter 10: Charge Assay Data Analysis
If standards are not identified correctly, they can be manually corrected as follows:

• If an incorrect band is identified as a standard - Right click the band in the lane or peaks 
table and select Not a Standard. Compass for Simple Western should correctly reassign the 
remaining bands as standards.

• To set an unidentified band as a standard - Right click the band in the lane or peaks table 
and select Force Standard. Compass for Simple Western will assign the band as a standard, 
and correctly reassign the remaining standard bands.

c. Repeat the previous steps for the remaining rows in the experiment pane to make sure all standards 
are identified correctly.
Compass for Simple Western User Guide



Checking Your Results page 371
Step 3 – Checking Capillary Registrations

All capillaries should have a single capillary registration peak. To verify the registrations are identified cor-
rectly: 

1. Click the Analysis screen tab. 

2. Click Show Registrations and Single View in the View bar. 

3. Click the Graph tab.

4. Click on the first row in the experiment pane. The registration peak will be the first and largest peak in 
the electropherogram. Check that the two registration peaks are identified and labeled Reg 1 and Reg 2 
in the electropherogram. They will also be identified with a purple R in the peaks table.

5. If the registration peak is not identified correctly, right click the correct registration peak in the electro-
pherogram or peaks table and select Registration Force. Compass for Simple Western will assign the 
new peak as the capillary registration. A lock icon indicating the registration was set manually will dis-
play next to the peak in the peaks table.
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NOTE: To remove registration peak assignments that were made manually, right click on the peak in the 
electropherogram or peaks table and click Registration Clear. 

6. Repeat the previous steps for the remaining rows in the experiment pane to make sure all registrations 
are identified correctly.

Step 4 – Checking Samples 

All immunodetected sample proteins in the graph and lane panes will be labeled automatically with the cal-
culated protein pI. 

NOTE: The reported pI for immunodetected sample proteins in Compass for Simple Western may vary 
slightly from predicted pIs based on sample, buffer and assay conditions.

To verify that sample proteins are identified correctly:

1. Click the Analysis screen tab. 

2. Click Show Samples in the View bar. Verification that sample proteins have been correctly identified 
can be done in either the graph or lane panes, but manual corrections must be done in the graph pane.

Graph Pane: 

a. Click Single View in the View bar. 

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the 
Graph tab.
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If sample peaks are not identified correctly, they can be manually corrected as follows:

• If an incorrect peak is identified as a sample peak - Right click the peak in the electrophero-
gram or peaks table and select Remove peak. Compass for Simple Western will no longer 
identify it as a sample peak in the electropherogram and the peak data will be removed in the 
results tables. 

• To set an unidentified peak as a sample peak - Right click the peak in the electropherogram 
or peaks table and select Add Peak. Compass for Simple Western will calculate and display the 
results for the peak in the results tables and identify the peak in the electropherogram.

NOTE: To remove sample peak assignments that were made manually and go back to the original view of 
the data, right click in the electropherogram and click Clear All. 

c. Repeat the previous steps for the remaining sample rows in the experiment pane to make sure all 
sample proteins are identified correctly.

Lane Pane: 
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a. Click either Single View or Multiple View in the View bar. 

b. Click on the row in the experiment pane that contains the sample you wish to check, then click the 
Lane tab. To view sample protein band labels, roll the cursor over the individual bands. If sample 
bands are not identified correctly, they must be corrected in the graph pane as described in the pre-
vious section. 

Step 5 – Assigning Peak Names (Optional)

Compass for Simple Western can identify and automatically name sample proteins associated with specific 
primary antibodies in the run data using user-specified peak name settings. For more information on how to 
do this see “Peak Names Settings” on page 441.
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Group Statistics
The Grouping View is used to analyze replicates by calculating the mean, standard deviation, %CV and SEM 
for named proteins (see “Peak Names Settings” on page 441 for detailed information on entering named 
proteins). Statistics for each protein are also plotted for easy comparison between samples, antibodies, and 
proteins. 

Using Groups

1. A group is automatically created for capillaries with the same sample and primary antibody name, so to 
use this feature, this information must first be entered into the Assay template. To do this: 

a. Click the Assay tab and go to the Template pane.

b. Enter sample names and primary antibody names as described in “Step 6 - Add Assay Plate Annota-
tions (Optional)” on page 122. Be sure to enter the same sample and/or primary antibody names for 
the groups of samples you want to calculate statistics for. 

In this example there are two sample types, High phospho HeLa and Low phospho HeLa which 
were run with two different antibodies, ERK 1/2 Primary 1 and ERK 1/2 Primary 2. 

Each of the two samples were run with the two antibodies in every cycle, and the ERK1/2 antibody 
generates 6 named peaks. 

2. To set a grouping option, go to Edit >Preferences and select the Grouping page. Then check the 
option you want to use. These options allow you to group capillaries in multiple ways: 
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• Group across runs - Groups capillaries from multiple runs. This option creates fewer groups and 
generates statistics across multiple runs. 

• Group across cycles - Groups capillaries run in different cycles. You can use this for Wes runs too.
• No option selected - When only one run is open, groups will only contain capillaries from the 

same cycle. When more than one run is open, groups are created for each run.
3. Click Apply and then select OK.

4. Group your results and view the associated statistics by selecting View and clicking on Grouping.
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Viewing Statistics

Peak and Capillary Groups

The Peak Groups pane reports statistics for each named protein in every group. Each group shows the statis-
tics for named proteins which includes average area, standard deviation, %CV and SEM. The number in 
parenthesis after the sample name indicates the number of capillaries in the group.

Clicking the arrow next to a group lists the individual capillaries in the group and reported data for each cap-
illary:
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The Capillary Groups pane pivots the Peak Groups results to show statistics for named protein peaks in 
individual columns.
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Group Plots

The mean values for named peaks in each group are plotted in bar graphs with error bars showing the stan-
dard deviation. The plots compare different antibodies for the same sample and different samples for the 
same antibody to allow a choice of presentation.

Hiding or Removing Capillaries in Group Analysis

Hidden capillaries are not included in groups. However, hiding capillaries provides an easy way to reject indi-
vidual capillaries from the statistical analysis. See “Hiding Capillary Data” on page 362 for details on how to 
do this.

Larger groups of capillaries can also be excluded from analysis. To do this, select View and click Filter.
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Uncheck the box next to the cycles or capillaries you wish to remove and click OK. This data will now be 
removed from the grouped view statistics.
Compass for Simple Western User Guide



Copying Data Views and Results Tables page 381
Copying Data Views and Results Tables
You can copy and paste data and results tables into other documents, or save a data view as a graphic file. 

Copying Data Views

1. Click in the graph or lane pane.

2. Select Edit in the main menu and click Copy, or right click and select Copy. 

3. If you selected copy from the graph pane the following window will display, click Copy. If you selected 
copy from the lane pane skip to the next step.

4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select 
Paste. A graphic of the copied data view will be pasted into the document.

Copying Results Tables

1. Click in the peaks or capillaries pane.

2. Select one or multiple rows.

3. Select Edit in the main menu and click Copy, or right click and select Copy. 

4. Open a document (Microsoft® Word®, Excel®, PowerPoint®, etc.). Right click in the document and select 
Paste. Data for the rows selected will be pasted into the document.

Saving the Graph View as an Image File

1. Click in the graph pane.

2. Select Edit in the main menu and click Copy, or right click and select Copy. 

3. Select an image option (EMF, PNG or PDF) in the pop-up window, then click Save.
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4. Select a directory to save the file to and enter a file name, then click OK. 

Exporting Run Files 
Results tables and raw plot data can be exported for use in other applications. 

Exporting Results Tables 

To export the information in the peaks and capillaries tables:

1. Click File in the main menu and click Export Tables.

2. Select a directory to save the files to and click OK. Data will be exported in .txt format.

NOTE: To exclude export of standards data or export results table data in .csv format, see “Setting Data 
Export Options” on page 465.

Exporting Raw Sample Electropherogram Data 

To export raw sample plot data: 

1. Click File in the main menu and click Export Spectra.
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• To export data in .txt format - Select Text Format. Plots will be exported in one file for all capil-
laries.

• To export data in .cdf format - Select Andi Format. Plots will be exported in one file per capil-
lary.

2. Select a directory to save the files to and click OK. Data will be exported in the selected format.

Running Reports
Compass for Simple Western v3.0 and higher can create and export run reports in .pdf format.

1. Open your run file, then select File > Run Report. The Run Report window displays. 

2. Select or deselect the information you want included in your report. 

3. Change the file name for the report if you don’t want to use the default run file name. The report file is 
saved in the same location as the run file by default.
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4. Click OK. When the report is done, the directory containing the report will display so you can open the 
report. 

A full report includes the following: 

• Run information

• Protocol details

• Plate layout
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• Analysis settings

 

• Lane views (for all cycles on Peggy Sue and Sally Sue):
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• Sample plots for each capillary of each cycle:

You can also include the fluorescent standards graphs for each capillary, registration graphs (Peggy Sue and 
Sally Sue only) and the standard peaks position and registration peak offsets in pixels in the report.
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Changing Sample Protein Identification
Compass for Simple Western allows you to customize what sample proteins are reported in the results tables 
by making manual adjustments in the electropherogram or peaks table.

Adding or Removing Sample Data 

1. Click Show Samples in the View bar. 

2. Click Single View in the View bar. 

3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the 
Graph tab.

• To remove a peak from the data - Right click the peak in the electropherogram or peaks table 
and select Remove peak. Compass for Simple Western will no longer identify it as a sample 
peak in the electropherogram and the peak data will be removed in the results tables. 

• To add an unidentified peak to the data - Right click the peak in the electropherogram or 
peaks table and select Add Peak. Compass for Simple Western will calculate and display the 
results for the peak in the results tables and identify the peak in the electropherogram.
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NOTES:  
To remove sample peak assignments that were made manually and go back to the original view of the 
data, right click in the electropherogram and click Clear All.  
 
Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.

Hiding Sample Data

You can hide the results for a sample protein in the results tables without completely removing it from the 
reported results. To to this:

1. Click Show Samples in the View bar. 

2. Click Single View in the View bar. 

3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the 
Graph tab.

4. Right click the peak in the electropherogram or peaks table and select Hide peak. Compass for Simple 
Western will hide the peak data in the results tables.
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5. To view hidden peak data, click View in the main menu and click Show Hidden. Hidden peak data will 
display in the results table and be marked with an X. 

6. To unhide a peak, right click on the peak in the electropherogram or peaks table and select Unhide 
Peak. 

Changing Peak Names for Sample Data

If Compass for Simple Western did not automatically name a sample protein associated with a specific pri-
mary antibody, this can be adjusted manually. To do this: 

1. Click Show Samples in the View bar. 

2. Click Single View in the View bar. 

3. Click on the row in the experiment pane that contains the sample you wish to correct, then click the 
Graph tab.
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4. Right click the peak in the electropherogram or peaks table and click Name, then click a name in the list. 
Compass for Simple Western will change the peak name in the electropherogram and results tables, and 
adjust peak names for other sample proteins accordingly. 

NOTES:  
For details on how to specify peak name settings, see “Peak Names Settings” on page 441. 
 
Virtual blot data in the lane pane will also update to reflect changes made in the graph pane.
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Displaying Sample Data for Named Peaks Only

You can adjust the sample data to display results only for user-specified named peaks. To do this: 

1. Click Show Samples in the View bar. 

2. Click View in the main menu and click Filter. 

3. Check the Show Named Peaks only box and click OK.
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Compass for Simple Western will hide peak data in the electropherogram and results tables for all 
unnamed peaks, and instead only display data for named peaks in the electropherogram and results 
tables.
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Changing the Virtual Blot View
Options in the lane pane let you change the contrast or invert the virtual blot, remove baseline noise, 
change lane labels or overlay standards data on sample lanes. 

The lane pane toolbar has the following options:

Adjusting the Contrast

1. Click the Contrast Adjustment button. The contrast tool will display:

2. Click the bar and drag it up or down to adjust the contrast.

3. When finished, click X to close the tool.

Contrast Adjustment

Invert

Lane Options

Remove Baseline

Overlay Standards Data
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Inverting the Virtual Blot

1. Click the Invert button. The virtual blot image will invert: 

2. Click the Invert button again to return to the default view.

Selecting Lane Labels

The labels shown above the lanes in the virtual blot can be customized. To do this: 

1. Click the Lane Options button. The label box will display:
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2. Check one or multiple label boxes, and uncheck those you don’t want to display. To remove labels com-
pletely, uncheck all boxes. The following label options are available:

• Sample - Sample name. If sample names were entered in the assay template (Assay screen), those 
names will display here. Otherwise, Sample (default name) will display. 

• Primary - Primary antibody name. If primary antibody names were entered in the assay template 
(Assay screen), those names will display here. Otherwise, Primary (default name) will display. 

• Secondary Ab - Secondary antibody name. If a secondary antibody name was entered in the assay 
template (Assay screen), those names will display here. Otherwise, Secondary (default name) will 
display. 

• Capillary - Cycle and capillary number. For example, C1:3 indicates cycle 1, capillary 3 

NOTE: Peggy Sue runs up to eight cycles (12 capillaries at a time), so the cycle number displayed will 
always be C1-C8 depending on the number of cycles programmed. 

• Attributes - Attribute text. If attribute information was entered for any of the rows or wells in the 
assay template (Assay screen), up to four can be selected and displayed as lane labels.

Viewing the Uncorrected Sample Baseline

1. Click the Remove Baseline button (active for sample data only). This will remove the automatic base-
line correction. 
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2. Click the Remove Baseline button again to return to the default, baseline corrected view.

Overlaying Standards Data on Sample Lanes

Data for the standards can be overlaid on the sample data in the virtual blot so you can view the raw, 
unaligned (uncorrected) lane data. To do this: 

1. Click the Overlay Standards Data button (active for sample data only). An overlay of the raw sample 
and standards data will display: 
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2. Click the Overlay Standards Data button again to return to the default, auto-aligned view.
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Moving Lanes in the Virtual Blot View

Lanes in the virtual blot view can be moved to make it easier to compare specific lanes of data. To do this: 

1. Click a lane in the virtual blot. Hold the mouse button down and drag the lane to a new position. 

2. Release the mouse button. The lane will now be repositioned in the virtual blot view. 
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Changing the Electropherogram View
Options in the graph pane let you zoom and scale electropherograms, overlay or stack plots and change the 
peak and plot information displayed. 

The graph pane toolbar has the following options:

Autoscaling the Electropherogram

Click the Autoscale button to scale the y-axis to the largest peak in the electropherogram.

Auto Scale

Graph Options

Stack the Plots

Overlay the Plots
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Click the Autoscale button again to return to default scaling.

Stacking Multiple Electropherograms

Electropherogram data for multiple capillaries can be stacked vertically in the graph pane for comparison. To 
do this:

1. Click Single View.

2. Select multiple rows in the experiment pane.
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3. Click the Stack the Plots button. The individual electropherograms for each row selected will stack in 
the graph pane. 

You can customize the colors used for the stacked plot display. For more information see “Selecting Custom 
Plot Colors for Graph Overlay” on page 466.
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Overlaying Multiple Electropherograms

The electropherogram data for multiple capillaries can also be overlaid on top of each other for comparison 
in the graph pane. To do this:

1. Click Single View.

2. Select multiple rows in the experiment pane.

3. Click the Overlay the Plots button. The individual electropherograms for each row selected will overlay 
in the graph pane. 

You can customize the colors used for the overlay plot display. For more information see “Selecting Custom 
Plot Colors for Graph Overlay” on page 466.
Compass for Simple Western User Guide



page 404 Chapter 10: Charge Assay Data Analysis
Zooming

To zoom in on a specific area of the electropherogram, hold the mouse button down and draw a box around 
the area with the mouse: 
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To return to default scaling, right click in the electropherogram and click Zoom Out. 

Customizing the Data Display

You can customize electropherogram peak labels, plot labels and display options. To do this, select the 
Graph Options button. 
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Peak Labels

You can customize the labels used to identify peaks in the electropherogram with these options: 

Matching Peak Names - Checking this box will draw vertical lines through each named peak. Using this 
option with Stack the Plots or Overlay the Plots features is useful for visual comparison of named peaks 
across multiple capillaries.
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• Peak Names - Checking this box will display peak name labels on all named peaks in the electro-
pherogram. 

NOTE: If more than one peak label option is selected, peak name labels will always be used for named 
peaks.
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• Peak Values - Checking this box will display the pI labels on all peaks in the electropherogram. 

NOTES:  
When viewing standards and registration data, this option is called Peak Positions. Labels displayed are 
peak positions rather than pI.  
 
If more than one peak label option is selected, peak name labels will always be used for named peaks. 
 
The reported pI for immunodetected sample proteins in Compass for Simple Western may vary slightly 
from predicted pIs based on sample, buffer and assay conditions.
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Baseline and Grid Options

You can view the calculated baseline fit, peak integration and show grid lines with these options.

• Fitted peaks - Checking this box will display how the peaks were fit by the software. 

NOTE: This option is only available for sample data. 
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• Baseline Fit - Checking this box will display the calculated baseline for the peaks. Baseline points will 
also display for regions of the electropherogram considered to be at baseline. 

NOTE: Compass for Simple Western v3.0 improves how the raw baseline is calculated. With this version of 
the software you may notice that the raw baseline for the shortest exposures is shifted (typically lower 
than previously observed when looking at data obtained with a prior software version). Peak areas for all 
exposures will stay the same between versions and won’t be affected by the shift of the raw baseline. But, 
area to baseline ratio will change from what was previously calculated with earlier versions of the soft-
ware.
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NOTE: This option is only available for sample data. 

• Grid Lines - Checking this box will display grid lines in the graph area. 
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Plot Labels

You can customize the plot labels displayed on the electropherogram with these options. 

Plot labels are shown on the right side of the graph pane. 

• Sample - Checking this box will display the sample name. If sample names were entered in the assay 
template (Assay screen), those names will display here. Otherwise, Sample (default name) will display.

• Primary - Checking this box will display the primary antibody name. If primary antibody names were 
entered in the assay template (Assay screen), those names will display here. Otherwise, Primary (default 
name) will display. 

• Capillary - Checking this box will display the cycle and capillary number. For example, C1:3 indicates 
cycle 1, capillary 3. 

• Attributes - Checking this box will display attribute text. If attribute information was entered for sam-
ples or primary antibodies in the assay template (Assay screen), they can be selected as plot labels.

• Exposure - Checking this box will display the exposure time(s) used for the data.

The following example shows an electropherogram with all plot labels selected: 
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Selecting Data Viewing Options 

The graph view menu provides multiple options for changing what type of electropherogram data is dis-
played. To access the view menu, click the down arrow next to the graph pane toolbar:

A check mark next to the menu option indicates it is currently selected. Multiple options can be selected at a 
time.

NOTE: Unless otherwise noted, graph view menu options are available for sample data only. 
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• Sample - Clicking this option will display raw, uncorrected sample data. 

• Sample Baseline Corrected - Clicking this option will display sample data with the baseline sub-
tracted (zeroed). This is the default view. 
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• Baseline Fit - Clicking this option will display the calculated baseline for the raw sample data. In the 
example that follows, both Baseline fit and Sample are selected.

NOTE: This option is selected automatically when Baseline Fit is selected in graph options. 

• Baseline Points - Clicking this option will display regions of the electropherogram considered to be 
at baseline. In the example that follows, both Baseline Points and Sample are selected.
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NOTE: This option is selected automatically when Baseline Fit is selected in graph options.
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• Fit - Clicking this option will display the bounding envelope of the fitted peaks as calculated by the 
software for the raw sample data. In the example that follows, both Fit and Sample are selected.
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• Fit Baseline Corrected - Clicking this option will display the fitted peaks as calculated by the soft-
ware for the sample baseline corrected data. In the example that follows, both Fit Baseline Corrected 
and Sample are selected, the fit plot is on the bottom.

NOTE: When viewing standards or registration data, this option is called Standards Fluorescence or Regis-
tration Fluorescence, respectively. 
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• Standards - Checking this box aligns the pI of the raw standards data to the sample data and over-
lays both electropherograms in the graph pane. 

Adding and Removing Baseline Points

Points in the baseline can be added or removed as needed. To do this:

1. Click the Graph Options button in the graph pane toolbar and check Baseline Fit. This will display 
baseline points for the raw sample data. 

2. Use the mouse to draw a box around the area you want to correct. This will zoom in on the area. 
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3. Right click a baseline point and click Add Baseline Point or Remove Baseline Point.

NOTE: To clear the manual addition or removal of baseline points and go back to the original view of the 
data, right click in the electropherogram and click Clear All.

Selecting the X-Axis pI Range

The pI range used for the x-axis can be changed. To do this, Select View in the main menu and click View 
Region. The following pop-up window will display:

• To change the x-axis pI range displayed for the run data - Enter new values in the Lower or Upper 
range in pI and click OK. Electropherogram and virtual blot data will update to display only the data 
in the entered range. 
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• To see the full x-axis pI range included in the run data - Check Full Range. Electropherogram and 
virtual blot data will update to display the full range of available data. 

NOTE: You can change the default x-axis range that Compass for Simple Western uses. For more informa-
tion, see “Peak Fit Analysis Settings” on page 434.

Closing Run Files
If more than one run file is open, you can close just one file or all the open files at the same time. 

• To close one of multiple open run files - In the experiment pane, click on one of the sample rows in 
the file. Next click File from the main menu and click Close. 

• To close all open run files - Select File from the main menu and click Close All. 
Compass for Simple Western User Guide



page 422 Chapter 10: Charge Assay Data Analysis
Analysis Settings Overview
Compass for Simple Western has a variety of analysis features and settings that you can modify as needed to 
enhance run data. 

To access these settings, select Edit in the main menu and click Analysis. If more than one run file is open, 
select the run file you want to view analysis settings for from the list:

The following screen will display: 
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To move between analysis pages in this window, click on an option in the list on the left. The following anal-
ysis settings can be user-customized in Compass for Simple Western:

• Advanced - Lets you customize analysis settings for samples, standards and image data.

• Images - Lets you view the chemiluminescent exposures taken during the run and view data for dif-
ferent exposures in the Analysis screen.

• Peak Fit - Lets you customize peak fit settings for sample data.

• Peak Names - Lets you enter custom naming settings for sample proteins associated with specific 
primary antibodies or attributes and have Compass for Simple Western automatically label the peaks 
in the run data. 

• Standards - Lets you customize the pI and positions Compass for Simple Western uses to identify flu-
orescent standards and registration peaks.
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Advanced Analysis Settings
The advanced analysis settings page lets you view and change analysis settings for samples, standards and 
image data. To access these settings, select Edit in the main menu and click Analysis, then click Advanced 
in the options list. 

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 
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• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 460. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 460. 

• Click Restore Original to restore Compass for Simple Western default settings.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Standards Settings

• Peak Width - The approximate width (at full width half max) used to filter out fluorescence artifacts 
which improves recognition of standards. The default value is 15.

• Allowable Drift - The distance in pixels that standards are expected to move compared to their 
entered positions in the standards analysis page. This setting assists in recognition of standards. The 
default value is 100. 

Sample Settings

• Peak Fit Starting Width Ratio - Focuses the peak fit towards the peak center and aids the overall 
peak fitting. The default value is 0.5.

Image Settings

• Median Filter Threshold Ratio - Pixel ratio used to filter out camera artifacts. The default value is 0.5.

• Median Filter Threshold Limit - Pixel threshold value used to filter out camera artifacts. The default 
value is 100.
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Advanced Analysis Settings Groups

Advanced analysis settings are saved as a group, and multiple settings groups can be created. Specific group 
settings can then be applied to individual capillaries, sample names or attributes in the run data.

NOTES:  
We recommend using the Compass for Simple Western default values for advanced analysis settings. 
These settings are included in the default Advanced group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 460.

Analysis groups are displayed in the analysis settings box:

The Advanced group shown contains the Compass for Simple Western default analysis settings. You can 
make changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box. 

Creating a New Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list. 

2. Click Add under the analysis settings box. A new group will be created:

3. Click on the new group and enter a new name.
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4. Modify standards, sample or image parameters as needed. 

5. To use the new group as the default analysis settings for the run file data, click the arrow in the drop 
down list next to Default, then click the new group from the list. Analysis settings in the new group will 
then be applied to the run data. 

6. Click OK to save changes. 

Changing the Default Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list. 

2. Click the arrow in the drop down list next to Default, then click a new default group from the list.
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3. Click OK to save changes. Analysis settings in the group selected will be applied to the run data. 

Modifying an Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list. 

2. Click on the group in the analysis settings box you want to modify. 

3. Modify standards, sample or image parameters as needed. 

4. Click OK to save changes. The new analysis settings will be applied to the run data.

Deleting an Analysis Group

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list. 

2. Click on the group in the analysis settings box you want to delete and click Remove. 

3. Click OK to save changes. 

Applying Analysis Groups to Specific Run Data

1. Select Edit in the main menu and click Analysis, then click Advanced in the options list. 

2. Click on the group in the analysis settings box you want to apply to specific run data.
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3. Application of analysis groups to specific run data is done in the override box. Click Add under the over-
ride box. A default override data set will be created from sample information found in the run file. 

4. Click the cell in the Apply To column, then click the down arrow. 

5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• Sample names - All sample names entered in the assay template (Assay screen) will display in 
the drop down list, otherwise the default name of Sample will be shown. Select a sample name 
to apply group settings to all capillaries that use this sample name in the run file. 

• Attributes - All sample attributes entered in the assay template (Assay screen) will display in the 
drop down list. Select an attribute to apply group settings to all capillaries that use this attribute 
in the run file.
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• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the analysis group used for a data set, click the cell in the Settings column and 
click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data. 

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click OK to save changes.

Images Analysis Settings
The Images settings in the Analysis window lets you see what Detection Profile was selected, what expo-
sures were taken during the run, and view data for different exposures in the Analysis screen. To access these 
settings, select Edit in the main menu and click Analysis, then click Images in the options list. 
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NOTES:  
If you’re using Compass for Simple Western v3.1 or higher, High Dynamic Range is the default setting. 
 
If the run was performed with HDR unchecked, the data can still be analyzed with the improved HDR 
algorithm by selecting High Dynamic range from the drop down menu. For Wes runs, the increase in 
dynamic range will not be as noticeable since the substrate refresh was not performed.

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 460. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 460. 

• Click Apply to see effects of changes before saving.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.
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Exposure Settings

The exposure used for the sample data displayed in the Analysis screen is shown in the All box shown below: 

Even when the exposures for HDR are set and can’t be edited from the assay protocol, here you can choose 
to view each one separately including High Dynamic Range (HDR multi-image).

NOTE: Peggy Sue runs up to eight cycles (12 capillaries per cycle). The individual exposure setting selected 
for a specific cycle is applied for all 12 capillaries in that cycle unless selected for All cycles. 

• High Dynamic Range - The HDR method uses information from multiple exposures to achieve good 
signal-to-noise for low protein concentration while simultaneously maintaining signal monotonicity 
at high protein concentration (i.e. avoiding “burnout”).

• Exposure # - Sample data displayed in the Analysis screen is for this specific exposure only.  
 
To see the number of exposures and exposure times used for the run data, click the arrow in the drop 
down list next to All. 
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NOTE: The number of exposures taken and exposure times shown were specified in the assay protocol 
(Assay screen) prior to executing the run and cannot be modified. 

Changing the Sample Data Exposure Displayed

The exposure used for the sample data displayed in the Analysis screen can be changed. To do this:

1. Select Edit in the main menu and click Analysis, then click Images in the options list.

2. Click the arrow in the drop down list next to All and select an exposure setting:
Compass for Simple Western User Guide



page 434 Chapter 10: Charge Assay Data Analysis
3. Click OK to save changes and exit. Sample data for the exposure selected will display in the Analysis 
screen.

Peak Fit Analysis Settings
The peak fit analysis settings page lets you view and change peak fit settings for sample data. To access 
these settings, select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 460. 
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• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 460. 

• Click Restore Original to restore Compass for Simple Western default settings.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Range Settings

• Minimum - The pI value below which peaks will not be identified. This value will also be used as the 
default lower pI range for the data displayed in the electropherogram and virtual blot. The default 
value is 5.

• Maximum: The pI value above which peaks will not be identified. This value will also be used as the 
default upper pI range for the data displayed in the electropherogram and virtual blot. The default 
value is 7.

Baseline Settings

• Threshold - The variance, or roughness, in a baseline data segment below which a point will be 
called part of the baseline. The default value is 1.0.

• Window - How long baseline data segments are expected to be in pixels. Shorter segments will allow 
the baseline to follow plateau sections of the signal. The default value is 15.

• Stiffness - The amount the baseline is allowed to vary from a straight line. Settings between 0.1 and 
1.0 make the baseline fit closer to a straight line. Settings from 1.0 to 10.0 will make the baseline fit fol-
low the data more closely. The default value is 1.0.

Peak Find Settings

• Threshold - The minimum signal to noise ratio required for a peak to be identified. A setting of 1.0 will 
detect many peaks, a setting of 30.0 will detect fewer peaks. The default value is 20.0. 

• Width - The approximate peak width (at full width half max) in pixels used to detect peaks. The mini-
mum value for this setting is 3.0. Larger widths help to eliminate the detection of shoulder peaks and 
noise peaks. The default value is 7.0.

Peak Fit Analysis Settings Groups

Peak fit settings are saved as a group, and multiple settings groups can be created. Specific group settings 
can then be applied to individual capillaries, sample names or attributes in the run data.
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NOTES:  
We recommend using the Compass for Simple Western default values for peak fit analysis settings. These 
settings are included in the default Peak Fit group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 460.

Peak fit groups are displayed in the analysis settings box:

The Peak Fit group shown contains the Compass for Simple Western default analysis settings. You can make 
changes to this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box. 

Creating a New Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click Add under the analysis settings box. A new group will be created:

3. Click on the new group and enter a new name.
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4. Modify range, baseline or peak find parameters as needed. 

5. To use the new group as the default peak fit settings for the run file data, click the arrow in the drop 
down list next to Default, then click the new group from the list. Peak fit settings in the new group will 
then be applied to the run data. 

6. Click OK to save changes. 

Changing the Default Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click the arrow in the drop down list next to Default, then click a new default group from the list.
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3. Click OK to save changes. Peak fit settings in the group selected will be applied to the run data. 

Modifying a Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to modify. 

3. Modify range, baseline or peak find parameters as needed. 

4. Click OK to save changes. The new peak fit settings will be applied to the run data.

Deleting a Peak Fit Group

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to delete and click Remove. 

3. Click OK to save changes. 

Applying Peak Fit Groups to Specific Run Data

1. Select Edit in the main menu and click Analysis, then click Peak Fit in the options list. 

2. Click on the group in the analysis settings box you want to apply to specific run data.
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3. Application of peak fit groups to specific run data is done in the override box. Click Add under the over-
ride box. A default override data set will be created from sample information found in the run file. 

4. Click the cell in the Apply To column, then click the down arrow. 

5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• Sample names - All sample names entered in the assay template (Assay screen) will display in 
the drop down list, otherwise the default name of Sample will be shown. Select a sample name 
to apply group settings to all capillaries that use this sample name in the run file. 

• Attributes - All sample attributes entered in the assay template (Assay screen) will display in the 
drop down list. Select an attribute to apply group settings to all capillaries that use this attribute 
in the run file.
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• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the peak fit group used for a data set, click the cell in the Settings column and 
click the down arrow. Select a group from the drop down list.

7. Repeat the previous steps to apply other groups to specific run data. 

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click OK to save changes.
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Peak Names Settings
The peak names analysis settings page lets you enter custom naming settings for sample proteins. Compass 
for Simple Western can automatically label sample peaks in the run data associated with specific blocking 
reagent names, primary antibody names or attributes. To access these settings, select Edit in the main menu 
and click Analysis, then click Peak Names in the options list. 

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 460. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 460. 

• Click Restore Original to restore Compass for Simple Western default settings.

• Click OK to save changes and exit.
Compass for Simple Western User Guide



page 442 Chapter 10: Charge Assay Data Analysis
• Click Cancel to exit without saving changes.

Peak Names Analysis Settings Groups

Peak name settings are saved as a group, and multiple settings groups can be created. Specific group set-
tings can then be applied to individual capillaries, blocking reagent names or primary antibody names and 
attributes in the run data.

NOTE: Analysis settings are run-file specific. However, settings can be imported or exported for use with 
other run files. For more information see “Importing and Exporting Analysis Settings” on page 460.

Peak name groups are displayed in the analysis settings box:

The Peak Names group shown is a Compass for Simple Western template group. You can make changes to 
this group and create new groups.

To view settings for a group, click on the group name in the analysis settings box. 

Creating a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the Peak Names 1 template group in the analysis settings box. 

3. Enter a new name for the group.
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4. Click in the first cell in the Name column in the analysis settings peak table. 

5. Enter a sample protein name associated with the primary antibody used in the run.

6. Click in the first cell in the pI column. 

7. Enter the pI for the sample protein.
Compass for Simple Western User Guide



page 444 Chapter 10: Charge Assay Data Analysis
8. Click in the first cell in the Color column, then click the button.

The color selection box will display:

The color selected will be used to identify the sample protein peak in the peaks and capillaries table in 
the Analysis screen. 

9. Click a color or define a custom color and click OK. The color selection will update in the table: 

10. Click in the first cell in the Range (%) column. 
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11. Enter a range window for the pI entered. Compass for Simple Western will automatically name peaks 
found within this percent of the pI. For example, if the pI entered is 5.5 and a 0.1 pI range is used, all 
peaks between pI 5.4 and 5.6 will be identified with this peak name. 

NOTE: The reported pI for immunodetected sample proteins in Compass for Simple Western may vary 
slightly from predicted pIs based on sample, buffer and assay conditions.

12. Select the checkbox in the first cell of the Show column. This will turn peak naming on for the sample 
protein. 

To turn peak naming off for a particular sample protein, deselect the checkbox in the Show column.

13. To add another sample protein, click Add under the analysis settings peak table:
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14. Repeat the previous steps to enter information for other sample proteins. In the following example, 
three sample proteins were entered:

To remove a sample protein, select its row and click Remove.

15. Click OK to save changes. 

Adding Peak Names Groups

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click Add under the analysis settings box. A new group will be created:

3. Click on the new group and enter a new name.
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4. Enter information in the analysis settings peak table as described in “Creating a Peak Names Group” on 
page 442. 

5. Click OK to save changes. 

Modifying a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the group in the analysis settings box you want to modify. 

3. Change the information in the analysis settings peak table as described in “Creating a Peak Names 
Group” on page 442. 

4. Click OK to save changes.

Deleting a Peak Names Group

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the group in the analysis settings box you want to delete and click Remove. 
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3. Click OK to save changes. 

Applying Peak Names Groups to Run Data

1. Select Edit in the main menu and click Analysis, then click Peak Names in the options list. 

2. Click on the group in the analysis settings box you want to apply to specific run data.

3. Application of peak names groups to specific run data is done in the override box. Click Add under the 
override box. A default override data set will be created. 

4. Click the cell in the Apply To column, then click the down arrow. 
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5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• All - When this option is selected, peak names group settings will be applied to all capillaries in 
the run file.

• Primary antibody names - All primary antibody names entered in the assay template (Assay 
screen) will display in the drop down list, otherwise the default name of Primary will be shown. 
Select a name to apply group settings to all capillaries that use the primary antibody name in the 
run file. 

• Attributes - All primary antibody attributes entered in the assay template (Assay screen) will dis-
play in the drop down list. Select an attribute to apply group settings to all capillaries that use this 
attribute in the run file.

• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the peak names group used for a data set, click the cell in the Settings column 
and click the down arrow. Select a group from the drop down list.
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7. Repeat the previous steps to apply other groups to specific run data. 

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click OK to save changes. Named peaks will be identified with a peak name label in the electrophero-
gram and virtual blot, and will be color coded in the peaks and capillaries tables: 
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Standards Settings
The standards analysis settings page lets you view and change the pI and position for fluorescent standards 
and set the registration peaks. To access these settings, select Edit in the main menu and click Analysis, 
then click Standards in the options list. 

NOTE: Settings can be modified in an assay prior to starting a run, or in a run file once the run has finished 
executing. Analysis changes made to an executing run will not be saved to the final run file. 

• Click Import to import an analysis settings file. This will be explained in more detail in “Importing 
Analysis Settings” on page 460. 

• Click Export to export the current analysis settings file. This will be explained in more detail in 
“Exporting Analysis Settings” on page 460. 

• Click Restore Original to restore Compass for Simple Western default settings.

• Click OK to save changes and exit.
Compass for Simple Western User Guide



page 452 Chapter 10: Charge Assay Data Analysis
• Click Cancel to exit without saving changes.

Standards Analysis Settings Groups

Standards settings are saved as a group, and multiple settings groups can be created. Specific group settings 
can then be applied to individual capillaries, sample names or attributes in the run data.

NOTES:  
We recommend using the Compass for Simple Western default values for standards analysis settings. 
These settings are included in the default Standards group.  
 
Analysis settings are run-file specific. However, settings can be imported or exported for use with other run 
files. For more information see “Importing and Exporting Analysis Settings” on page 460.

Standards groups are displayed in the analysis settings box:

The Std. Ladder groups shown contains the Compass for Simple Western default analysis settings for pI Stan-
dard Ladders used with each of the premixes (separation gradients) for charge assays on Peggy Sue. You can 
select and use one of these default groups, make changes to groups or create new groups.

To view settings for a group, click on the group name in the analysis settings box. 
Compass for Simple Western User Guide



Standards Settings page 453
Creating a New Standards Group

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click Add under the analysis settings box. A new group will be created:

3. Click on the new group and enter a new name.

4. Click in the first cell in the pI column in the Fluorescent Peaks table. 

5. Enter the pI for the fluorescent standard.
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6. Click in the first cell in the Position column. 

7. Enter the position of the fluorescent standard peak.
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NOTE: Standards peak positions are relative to each other. Only the difference in their position is used to 
help identify the standard peaks. When entering standard peak information for the first time, review the 
standards data in the Analysis screen to find the correct peak position.

8. Repeat the steps above for the remaining standards in the table. 

• To add another standard - Click Add under the peak table, then modify the information in the 
new row. 

• To remove a standard - Select its row and click Remove.
9. Select which standard should be used for capillary registration by clicking the checkbox in the Registra-

tion column. The first and last standards are typically used for the registration. 

NOTE: In order for Compass for Simple Western to perform data analysis, at least one peak must be 
selected for registration.

10. Select which standards should be used for pI determination of sample proteins by clicking the check-
box in the Fit column. The standards not used for registration are typically also used for fit. 
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11. To use the new group as the default analysis settings for the run file data, click the arrow in the drop 
down list next to Default, then click the new group from the list. Analysis settings in the new group will 
then be applied to the run data. 

12. Click OK to save changes. 

Changing the Default Standards Group

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click the arrow in the drop down list next to Default, then click a new default group from the list.
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3. Click OK to save changes. Analysis settings in the group selected will be applied to the run data. 

Modifying a Standards Group

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click on the group in the analysis settings box you want to modify. 

3. Modify fluorescent standards information as described in “Creating a New Standards Group” on 
page 453. 

4. Click OK to save changes. The new analysis settings will be applied to the run data.

Deleting an Analysis Group

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click on the group in the analysis settings box you want to delete and click Remove. 
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3. Click OK to save changes. 

Applying Analysis Groups to Specific Run Data

1. Select Edit in the main menu and click Analysis, then click Standards in the options list. 

2. Click on the group in the analysis settings box you want to apply to specific run data.

3. Application of analysis groups to specific run data is done in the override box. Click Add under the over-
ride box. A default override data set will be created from sample information found in the run file. 

4. Click the cell in the Apply To column, then click the down arrow. 
Compass for Simple Western User Guide



Standards Settings page 459
5. Select an option from the drop down list. This will apply the settings group selected to specific run data 
as follows:

• Sample names - All sample names entered in the assay template (Assay screen) will display in 
the drop down list, otherwise the default name of Sample will be shown. Select a name to apply 
group settings to all capillaries that use this sample name in the run file. 

• Attributes - All sample attributes entered in the assay template (Assay screen) will display in the 
drop down list. Select an attribute to apply group settings to all capillaries that use this attribute 
in the run file.

• Cycle 1-8 - When this option is selected, group settings will be applied to all capillaries in the 
cycle. 

• Custom settings - Lets you choose specific capillaries to apply the group settings to. When this 
option is selected, the following pop-up box appears to let you enter a specific capillary number 
or range of capillaries:

6. If you need to change the analysis group used for a data set, click the cell in the Settings column and 
click the down arrow. Select a group from the drop down list.
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7. Repeat the previous steps to apply other groups to specific run data. 

8. To remove a data set, click on its cell in the Apply To column, then click Remove.

9. Click OK to save changes.

Importing and Exporting Analysis Settings
The analysis settings in a run file can be exported as a separate file. This allows the same analysis settings to 
be imported into other assays or run files at a later time, rather than having to re-enter settings manually. 

Importing Analysis Settings

NOTE: Importing an analysis settings file populates the settings in all Analysis pages. 

1. Open the run file or assay you want to import analysis settings to.

2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).

3. Click Import on any page.

4. Select a settings file (*.settings) and click OK. The imported settings will display in all analysis pages. 

Exporting Analysis Settings

NOTE: Exporting an analysis settings file exports the settings in all Analysis pages. 

1. Open the run file or assay you want to export analysis settings from.

2. Select Edit in the main menu and click Default Analysis (Assay screen) or Analysis (Analysis screen).
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3. Click Export on any page. The following window displays:

4. The default directory is Compass/Assays. Change the directory if needed.

5. Enter a file name and click Save. The settings will be saved as a *.settings file.
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Chapter 11:  
Setting Your Preferences

Chapter Overview
• Custom Preference Options

• Setting Data Export Options

• Selecting Custom Plot Colors for Graph Overlay

• Setting Up Jess, Wes, Sally Sue and Peggy Sue to Send Tweets
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Custom Preference Options 
You can set and save custom preferences for Access Control, data export, plot colors in the graph and Twitter 
communication. To access these settings, select Edit in the main menu and click Preferences. 

NOTE: In Compass for Simple Western version 5.0 and higher, you can no longer change or save Custom 
Preferences outside of the first instance of the software that’s been opened. When running multiple 
instances of the software on the same computer, the following message displays if you try to change Cus-
tom Preferences in any instance except the first instance opened.

To move between preferences pages in this window, click on any option in the list on the left. The following 
items can be user-customized in Compass for Simple Western:

• Analysis Export - Lets you customize data export options.
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• Graph - Lets you customize graph color displays.

• Twitter - Lets you configure Jess, Wes, Sally Sue or Peggy Sue to Tweet run status.

Setting Data Export Options
Select Edit in the main menu and click Preferences, then click Analysis Export in the options list. 

• Export Standards - Selecting this option includes data for the standards in each sample when run 
data is exported. When this option is deselected, only sample data will be exported. This option is 
selected by default. 

• Export using a comma as the column delimiter - Selecting this option exports run data in .csv for-
mat. When this option is deselected, the data is exported in .txt format.

• Empower - This option exports uncalibrated run data in a format that is compatible for further analy-
sis in Empower and other analysis programs that use standard formats.

• Chromeleon - This option exports uncalibrated run data in a format that is compatible for further 
analysis in Chromeleon and other analysis programs that use standard formats.

• Click Apply to apply changes to any open run files in Compass for Simple Western.

• Click Restore Defaults to restore Compass for Simple Western default settings.
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• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Selecting Custom Plot Colors for Graph Overlay
Select Edit in the main menu and click Preferences, then click Graph in the options list. 

• Apply colors to stacked plots - Selecting this option applies the color scheme to individual electro-
pherograms when the Stack the Plots option is selected in the Analysis screen graph pane.

NOTE: If Apply colors to stack plots is not checked, the colors shown in the preferences screen will be 
applied only to overlaid electropherograms when the Overlay the Plot option is selected in the graph 
pane.

• When this option is deselected, plots will use Compass for Simple Western default colors.

• Click Apply to apply changes to any open run files in Compass for Simple Western.

• Click Restore Defaults to restore Compass for Simple Western default settings.
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• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

Changing Plot Colors

1. Select Edit in the main menu and click Preferences, then click Graph in the preferences list.

2. Click the color button next to a plot number. The color selection box displays: 

3. Select a color or define a custom color and click OK. The color button will update to the new color 
selected. 

4. Repeat the steps above for any other plot colors. 

5. Check Apply Colors to Stacked Plots if you want the new color scheme to also be used for the Stack 
the Plots option in the graph pane. 

6. Click Apply to apply changes to plots currently displayed in the graph pane. 

7. Click OK to save changes and exit. When the Overlay the Plots option is selected in the graph pane, the 
new color scheme will be used. 
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Setting Up Jess, Wes, Sally Sue and Peggy Sue to Send Tweets
Select Edit in the main menu and click Preferences, then click Twitter in the options list.

• Click Apply to apply changes.

• Click Restore Defaults to restore Compass for Simple Western default settings.

• Click OK to save changes and exit.

• Click Cancel to exit without saving changes.

To have Jess, Wes, Sally Sue or Peggy Sue tweet a Twitter account:

NOTES:  
To set Jess, Wes, Sally Sue or Peggy Sue up to tweet, the computer you are using must have an internet 
connection. 
 
To tweet, Jess, Wes, Sally Sue or Peggy Sue must be connected to the internet through a network connec-
tion or via the local lab computer.  
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We recommend setting up a separate Twitter account for Jess, Wes, Sally Sue or Peggy Sue. This lets multi-
ple people in the lab follow run progress. It also lets you send tweets directly from Jess, Wes, Sally Sue or 
Peggy Sue to all users, for example to notify others when the instrument is available or when an error has 
been reset, etc. 

1. Click Set Account. A set account window will display in Compass for Simple Western and the following 
browser window will open:

2. Enter a user name or email and password, then click Authorize app. A new page will display in the 
browser with a PIN number. 

3. Enter the PIN number in the set account window in Compass for Simple Western and click OK:
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4. The user name will now appear in the Twitter User Name box. Select one or all of the tweet options in 
the Tweet When box, then click Apply. 

5. To confirm the Twitter account is receiving messages, click Tweet Message. Enter a test message and 
click OK.
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6. If the test Tweet was successful, Compass for Simple Western will display the following message:

7. Click OK to save changes and exit. Jess, Wes, Sally Sue or Peggy Sue will automatically tweet as the 
selected options occur, as shown below:
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Changing the Twitter Account

To change the Twitter account Jess, Wes, Sally Sue or Peggy Sue uses:

1. Select Edit in the main menu and click Preferences, and click Twitter in the preferences list.

2. Click Clear. 

3. Set up the new account as described in “Setting Up Jess, Wes, Sally Sue and Peggy Sue to Send Tweets” 
on page 468.
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Sending Manual Tweets from Jess, Wes, Sally Sue and Peggy Sue

You can send tweets directly from Jess, Wes, Sally Sue or Peggy Sue. For example, you may want to notify 
other users that the instrument is available, being serviced or when an error has been cleared. To do this:

1. Select Edit in the main menu and click Preferences and click Twitter in the preferences list. 

2. Click Tweet Message. 

3. Enter a test message and click OK. The tweet will be received by any users following the Twitter account 
Jess, Wes, Sally Sue or Peggy Sue uses.
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Chapter 12:  
Compass Access Control and  
21 CFR Part 11 Compliance

Chapter Overview
• Overview

• Enabling Access Control

• Logging In to Compass for Simple Western

• Saving Changes

• Signing Files

• Instrument Command Log

• Run File History

• Troubleshooting Problems and Suggested Solutions

• Authorization Server
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Overview 
The Compass for Simple Western Access Control feature can be used to help satisfy the 21CFR Part 11 data 
security requirements when using Simple Western instruments. When Access Control is enabled and the 
Authorization Server has been installed (see "Authorization Server" on page 485):

• Users are required to log in to Compass for Simple Western when the software is launched

• A history of all actions is maintained 

• Data files are signed and encrypted to prevent unauthorized changes (e.g., all files are controlled)

• Each instrument maintains a history of user commands

• Each assay and data file includes a history of signed changes to the file

Compass for Simple Western can be run with or without Access Control enabled. When Access Control is 
disabled, no user log in is required and files are not encrypted or signed. The instrument history and file his-
tory are still maintained but the entries are not signed.

Enabling Access Control
Access Control is enabled in Preferences. Select Edit in the main menu, click Preferences, then select 
Access Control. 
Compass for Simple Western User Guide



Logging In to Compass for Simple Western page 477
To enable Access Control:

1. Check the Enable box.

2. Enter the IP address of the Authorization server. Use format X.X.X.X or LocalHost if installing the server on 
the local machine. 

3. Enter the time (in minutes) of inactivity that the software should Auto Lock after. 

NOTE: The Auto Lock Inactivity (min) setting will not be enabled until after the user has closed the software 
and logged into the Authorization Server. 

4. Close Compass for Simple Western. The next time the software is launched, a user log in will be required.

NOTE: Access Control can only be disabled by logging into Compass for Simple Western and deselecting 
the Enable box in the Access Control page of Preferences.

Logging In to Compass for Simple Western
With Access Control enabled, all users must log in to Compass for Simple Western whenever the software is 
launched.

Enter your user name and password previously setup by your Compass for Simple Western Administrator. 

NOTES:  
Your account will be blocked after a certain number of login failures. If this happens, contact your admin-
istrator to unblock the account.  
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Administrators can have full Compass login permissions. By default the admin/admin user has full Com-
pass login permissions, but it’s possible to remove login permissions from any administrator.

A successful log in will display the Compass for Simple Western main window with the user information in 
the lower status bar. The full user name is displayed with the unique user ID in parenthesis:

Locking and Unlocking the Application

You can click the Lock button to lock Compass for Simple Western and prevent access by other users. To 
unlock the application, users must re-enter their password.
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Resolving Log In Issues

Log in failures may occur when:

• The server is temporarily unavailable

• Compass is using the wrong IP address 

When this happens, the following message displays: 
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Click Disable to restart Compass for Simple Western with Access Control disabled. Verify or correct the 
server IP address then close and restart Compass to log in with Access Control enabled.

Saving Changes
When Save is selected from the File menu, a dialog box will display to allow you to enter a comment before 
saving the signed file:

The comment is added to the signature entry in the file History:

Signing Files
Select e-Signature from the File menu to add an electronic signature to a file.
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The signed entry will be added to the file History with the meaning of the signature entered in the com-
ment, such as Approved or Verified.

Instrument Command Log
The Instrument Command Log can be viewed at any time by selecting the Instrument menu and clicking 
Properties, and then clicking the Logs button:
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In the Logs dialog box, select Command Logs:

The Command Log lists all the commands sent to the instrument that were signed by the user who sent the 
command. If you want to copy the Command Log at any time, right click in the table and select Copy, then 
paste into another document.
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Run File History
Select the Run Summary screen tab and then the History tab to see the file History. To copy the file History, 
right click in the table and select Copy, then paste into another document.
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Troubleshooting Problems and Suggested Solutions
If any of the following error messages are encountered, follow the recommended steps below to resolve the 
issue.

• Unknown user name or password. 

• Check if the Caps Lock is on, user name and password are case sensitive. 
• Ask a Compass for Simple Western administrator to confirm your user name. If your password is 

unknown then the administrator can reset your password (see "Resetting User Passwords" on 
page 493 for more information).

• Server not available. From the Edit menu, click Preferences and then Access Control to confirm 
the server address is set to the correct Authorization server address. Compass must be able to reach 
the server on the network. 

• Controlled file cannot be opened without log in. To open a controlled Run file, enable Access 
Control by clicking Edit, then Preferences and Access Control. Select Enable, close Compass, then 
re-launch Compass with a valid log in. 

• Uncontrolled file cannot be opened when logged in. To open an uncontrolled Run file, disable 
Access Control by clicking Edit, then Preferences and Access Control. Deselect Enable, close Com-
pass then re-launch the software.
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NOTE: Uncontrolled Assay files can be opened when Compass for Simple Western Access Control is 
enabled (controlled mode).

• Command disabled. Certain commands are only available when a user with the correct permissions 
is logged in. To change user permissions, use a web browser to log in to the Authorization server web 
interface at the address shown on the Access Control page in Preferences, such as: 10.1.3.231:8000.

• Compass for Simple Western does not prompt for log in. Compass for Simple Western will only 
prompt for a log in on launch when Access Control is enabled in Preferences. Enable Access Control 
by clicking Edit, then Preferences and Access Control. Select Enable, close Compass then re-
launch the software. You should now be prompted for a log in.

Authorization Server
The Authorization Server controls the log in access to Compass for Simple Western. In the simplest configu-
ration, the server is run on the same computer as Compass for Simple Western and only that copy of Com-
pass is controlled. A single server can also be used to control access to multiple copies of Compass for 
Simple Western running on different computers, so long as they have network access to the server. Multiple 
copies of the server may be run on the same network, and each server will have its own user database.

To enable Compass for Simple Western to use a particular Authorization Server, click Edit, then Preferences 
and Access Control and enter the server IP address using format X.X.X.X. 

NOTE: If the server is installed on the same computer as Compass for Simple Western (e.g., the local 
machine), enter LocalHost instead of the IP address. Contact your local IT Administrator to assist with 
installing the Authorization Server in your preferred format.

Server Administration

The Authorization Server is configured through a web interface at the IP address of the server on port 8000. 
To access the Server home page, open any browser and type the IP address on port 8000 in a X.X.X.X:8000 or 
http://X.X.X.X:8000 format. Use LocalHost instead of the IP address if the Server is installed on the local 
machine. 

The default server administrator is: 

• User: admin

• Password: admin 

After installing the Authorization Server, the administrator user name and password can be changed.
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Adding Non-admin Users

Add a user to the server to allow that user to log in to Compass for Simple Western. To do this:

1. Select Users from the Site Administration home page:
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2. From the Users page, select Add User:

3. Fill in the fields to create a new user:
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After adding a new user more information can be added:

NOTE: You must enter the user’s first and last name.
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NOTE: Users are blocked after the number of login failures defined in the Password policy setting.

Permissions

All users can log in to Compass for Simple Western, but the commands available within Compass are con-
trolled by Permission settings. Commands a user does not have permission to use will be disabled. After user 
permissions have been changed on the server the user must close and re-open Compass to use the new 
permissions. 

Users can belong to groups that have multiple permissions such as Manager or Scientist: 
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Use the Groups page to change the permissions in a group or create new groups:

To change permissions for a group click Change, then select a group: 

Move individual group permissions in or out of the Available Permissions and Chosen Permissions boxes by 
selecting a permission in either box. Click the left or right arrow button to move the permission into the 
other box.
Compass for Simple Western User Guide



Authorization Server page 493
Adding Admin Users

To create a user with administrator permissions:

1. Follow the steps described in "Adding Non-admin Users" on page 486 to create the admin user.

2. Under permissions, select Staff status and Superuser status: 

3. Assign the admin user to a group.

NOTE: Selecting Superuser status enables server permissions only. Admin users must be also be assigned 
to a group to in order to have Compass for Simple Western permissions. 
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Resetting User Passwords

You need to be an Administrator to reset a user password. To reset a user password:

1. Select Users from the Site Administration home page, then select the user to change. The following 
screen displays:

2. Raw passwords are not stored, they must be changed manually. Click the text link to access the pass-
word change form: 
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3. Enter the new password, then click Change password. 

Audit Trail

Admin users with Staff Status can view, print and download the Audit Trail. Select View Audit Trail from the 
Site Administration home page to access it.
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Password Policy Settings

These settings let administrators set password policies. Select Password policy settings from the Site 
Administration home page to make changes.
Compass for Simple Western User Guide



Authorization Server page 497
Lightweight Directory Access Protocol (LDAP) Settings

LDAP settings allow you to connect the Compass Authorization Server to your own network's domain con-
troller, so users can log on with their existing network password. With LDAP, passwords are not maintained 
by the Compass Authorization Server, they are administered by the network admin.

First select LDAP settings from the Site Administration page and set your LDAP settings.

Next, add users as described in "Adding Non-admin Users" on page 486 and select the LDAP User checkbox.

Passwords aren't required for LDAP users.

To synchronize the Compass Authorization Sever with the LDAP user information on your server, select the 
Sync Information box. 
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Encryption Details

Compass for Simple Western uses the SHA1 hash algorithm to generate a 160 bit hash code that is unique 
for all files. All files saved by Compass are encrypted with a digital key. This key along with the hash codes 
guarantees the file history is correct and no other edits were made. All changes saved to a file have the elec-
tronic signature of the user who saved the file. The e-Signature command allows a user to sign off on a 
state such as approved or verified.

There is no individual ownership of files, all users who log into Compass can open any file.
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